Practical accounting data processing

Study guide 1 for

AIN2601

College of Accounting Sciences
School of Accountancy
Department of Management Accounting

University of South Africa
## CONTENTS

1. INTRODUCTION ........................................................................................................................................... 3
2. GENERAL OBJECTIVES OF THIS MODULE ......................................................................................... 3
3. PREREQUISITES ........................................................................................................................................... 3
4. COMPUTER ACCESS PREREQUISITES .............................................................................................. 4
5. STRUCTURE OF THIS MODULE ........................................................................................................... 4
6. STUDY MATERIAL AND RESOURCES .................................................................................................. 6
7. ASSIGNMENTS .......................................................................................................................................... 7
8. CRITICAL SUCCESS FACTORS ............................................................................................................ 7
9. VERY IMPORTANT NOTE ....................................................................................................................... 8
10. USING THE STUDY GUIDE ................................................................................................................ 8
11. STUDY PROGRAMME GUIDELINE ....................................................................................................... 8
12. TEACHING STRATEGY .......................................................................................................................... 9
13. MEANING OF WORDS .......................................................................................................................... 9
14. CONCLUSION .......................................................................................................................................... 10
1 INTRODUCTION

Dear Student

A sincere welcome to this module, AIN2601. Jim Rohn said the following:

“Learning is the beginning of wealth. Learning is the beginning of health. Learning is the beginning of spirituality. Searching and learning is where the miracle process all begins.”

We trust that you will find studying the material for this module interesting and stimulating, and that you gain new knowledge, insights and practical skills that will benefit your career and future studies.

We recognise the increasing impact of computer technology on the day-to-day business activities of accountants. The two modules (AIN1501 & AIN2601) combine theoretical knowledge and practical understanding of information systems in a business environment, especially the accounting environment.

Information technology is constantly changing, and it is your responsibility as a student to ensure – after the successful completion of this module – that you keep abreast of the latest developments in the relevant fields.

Knowledge is only meaningful if it is relevant and up to date. As Jack Nicholson once said:

“The minute that you’re not learning I believe you’re dead.”

Before tackling your studies, you need to note the following important information:

2 GENERAL OBJECTIVES OF THIS MODULE

This module is primarily intended for students who are interested in qualifying as registered chartered accountants (SAICA) or management accountants (CIMA). This module will enable students to develop the necessary competencies prescribed by these professional bodies.

This module provides you with knowledge about the fundamental data and transaction processing principles needed to understand operating and accounting information systems (AISs).

The module will also equip you – in your capacity as user, designer and evaluator – with the skills to apply your theoretical knowledge of accounting information systems in a practical business context.

3 PREREQUISITES

It is assumed that students have the following knowledge and understanding:

- They have reading and comprehension skills to enable them to read questions and case studies, comprehend the content thereof, and follow a logical thought process. Further, students must be capable of applying basic principles they have been exposed to in the tutorial matter to questions or elementary case studies and formulate an opinion or recommendation, or draw a conclusion from this application.
- Students have knowledge of basic accounting concepts, principles and procedures as indicated by successful completion of the prerequisite module stipulated in the admission requirements.
- Knowledge of data processing and accounting information systems is essential, as indicated by successful completion of the prerequisite modules, as stated in the admission requirements.
• The ability to use peripheral computer devices such as a mouse, keyboard and printer is necessary.
• You should be able to demonstrate basic practical computer skills such as the installation of software, use of the internet and file management.

4 COMPUTER ACCESS PREREQUISITES

You must have access to a computer. The required practical skills can only be acquired by practically doing the work on a computer and not by simply reading the manuals.

Students who register for this module must

• have access to the internet for at least 20 hours
• have access to a computer for at least 90 hours
• be allowed to install Pastel Partner educational software on the above-mentioned computer; and the computer must also adhere to the Pastel Partner hardware requirements for the operating system loaded on the computer
• have access to either a virtual or a physical printer (Cutepdf – free virtual printer software is recommended and available at www.cutepdf.com)
• have access to Microsoft Excel 2007, Microsoft Excel 2010 or Microsoft Excel 2013 or Open Office Calc (Microsoft Excel Starter is not acceptable)
• have access to either WinZip or 7-Zip (7-Zip – free data compression software is recommended and available at www.7-zip.org)

5 STRUCTURE OF THIS MODULE

The module is divided into two study guides (MO001 and MO002) with four distinctive parts, each containing one or more topics. Topics are the main study areas in the parts, and each topic is further subdivided into study units. You will find the learning outcomes, which you are required to achieve for each topic in this study guide, stated at the beginning of each topic.

The parts of the module are set out below.

Part 1: Data management and utilisation

Explain the various concepts relating to the management and utilisation of data. (Topic 1)

Part 1 builds on the foundation laid in AIN1501 (Accounting information systems) regarding the computerised information system process. It introduces you to the database environment, including different database models, database management systems and relational database terminology. This part concludes with a brief discussion of the application of databases in the accounting, auditing and general business environment.

Assessment criteria:

• Database terminology, applications and structures are defined.
• Database management systems are explained based on an understanding of the operating environment.
• The importance of database management systems for accountants and auditors is described.

Part 2: Spreadsheets

Develop and create spreadsheets to solve problems in a business and accounting context. (Topic 2)
This part equips you with skills to develop and create spreadsheets in order to solve problems in a business and accounting context using appropriate formats, formulas and functions. You will also gain an understanding of the risks and controls associated with spreadsheets.

**Assessment criteria:**
- User-friendly spreadsheets are created to assist financial users in their daily operations and routines.
- Spreadsheet formulas and functions are identified and applied to solve business and accounting problems.
- Spreadsheet security risks and controls are described.

**Part 3: Transaction processing**

Explain and apply financial reporting structures and accounting software applications to accounting transaction processing cycles. (Topics 3–6)

Topic 3 in part 3 explains accounting transaction-processing cycles in an information system environment. Topic 4 introduces you to the chart of accounts and staffing level requirements needed for financial reporting. Topic 5 firstly focuses on the evaluation and selection of appropriate accounting information system, and secondly, on accounting information system security risks and controls. In the last topic (topic 6) in part 3, Pastel Partner accounting software is utilised to process transactions and retrieve financial information.

**Assessment criteria:**
- Accounting transaction processing cycles are explained based on an understanding of the information system environment.
- A financial reporting structure is developed and evaluated which includes a chart of accounts and staffing level requirements.
- Various accounting software applications are evaluated to select the most appropriate application for the task.
- Pastel Partner accounting software is utilised to process and retrieve financial information.
- Accounting software security risks and controls are described.

**Part 4: Management reporting systems**

Explain management reporting systems. (Topic 7)

Topic 7 elaborates on the importance of access to accurate and timely information and briefly explains the role of management information systems and business intelligence software in the organisation’s financial reporting and decision-making process. This topic concludes with an introduction to Extensible Business Reporting Language (XBRL) as a way to enhance reporting.

**Assessment criteria:**
- Management information systems are described.
- The role of management reporting systems in the organisation’s financial strategy is explained.
- New sources of technology that enhance reporting are identified.
- The importance of access to accurate and timely information is explained.
6 STUDY MATERIAL AND RESOURCES

Prescribed study material

The prescribed study material for this module is as follows:

- AIN2601 - Study guide 1 (MO001) and study guide 2 (MO002). All references made to study guides in this document will refer to these documents.
- Masterskill: Pastel Partner manual and software
- Tutorial letters issued during the semester. Apart from Tutorial Letter 101, you will also receive other tutorial letters during the semester. These tutorial letters will not necessarily be available at the time of registration. Tutorial letters will be despatched to you as soon as they are available or needed (for instance, for feedback on assignments).

**NB:** You can view your learning units online and download the study guides and tutorial letters for the modules for which you are registered on the university’s online campus, myUnisa, at [http://my.unisa.ac.za](http://my.unisa.ac.za). myUnisa resources
Please make use of myUnisa (https://my.unisa.ac.za) as it contains further resources to help you master this module. The following resources are available on myUnisa:

- learning units in online format
- two MO documents – AIN2601
- tutorial letters issued during the semester
- previous examination papers
- a discussion forum where problem areas are discussed
- announcements
- other resources
- frequently asked questions

**Supplementary literature/additional reading**

You can use the bibliography at the end of the second study guide (MO002) for additional resources if you wish to read more about specific topics.

7 **ASSIGNMENTS**

The assignments, with the necessary instructions, are contained in Tutorial Letter 101. Please note that your assignment questions should be submitted for marking before or on the due dates.

It is in your own interest to answer and submit as many assignments as possible because

- they form an integral and vital part of your studies
- they will help you to prepare for the examination
- as indicated in Tutorial Letter 101, assignments are taken into account when calculating your year mark; the higher your year mark, the better chance you have of doing well in this module

8 **CRITICAL SUCCESS FACTORS**

Our aim in designing these two study guides was to afford you the best possible opportunity to master the knowledge, skills and values required by the discipline and the demands of accounting practice.

To ensure that you are successful in your studies, we would advise you to do the following:

- Start as soon as possible. We have found that students who start early have time to reflect on their studies and formulate their own informed opinions.
- Use your time sensibly.
- Work systematically through the contents of the study guides, Pastel Partner manual and other tutorial letters
- Set realistic goals.
- Believe in yourself.

We designed this module using the South African Qualifications Authority (SAQA) guidelines with regard to the notional hours (time you will need to work through the course material successfully). The average student will need at least 120 hours to read, practice and study all study material, do your assignments and prepare for and write the examination. We prepared a guideline time allocation table for you on the next page.
Research has shown that students who complete their assignments diligently, are more likely to pass the examinations than those who do the minimum.

You will not pass this module successfully if you only try to memorise detail. We suggest that you allow yourself enough time to read through the study material, use different techniques to summarise the contents, spend time reflecting on the issues and principles involved and practise the required practical parts of this module on a computer.

9 VERY IMPORTANT NOTE

You should not dispose of your study guide and other study material such as tutorial letters once you have passed this module. You may need to refer back to it in your next studies, as the principles covered in this module will not be repeated in future modules! In modules following this one, it will be assumed that you have achieved all the learning outcomes specified in the study guides.

10 USING THE STUDY GUIDE

When commencing your studies, we recommend that you prepare a schedule that allocates time to each study unit, leaving sufficient time for revision closer to the examination. The study programme provided below serves as guideline for your study programme for the semester.

When studying a new topic, we recommend that you

- read the learning outcomes and introductory paragraph of the topic in the study guide to familiarise yourself with the aim(s) of the topic
- study the topic in detail using the study guide as the primary reference to your study material
- prepare summaries of key concepts, definitions and important information in your study material
- complete the practical computer activities on a computer
- evaluate yourself continuously by working through the self-assessment activities provided in the study guide, Pastel Partner manual and tutorial letters.

11 STUDY PROGRAMME GUIDELINE

<table>
<thead>
<tr>
<th>Part</th>
<th>Topic no.</th>
<th>Topic</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Data management and utilisation</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Spreadsheets</td>
<td>25</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Accounting cycles</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Financial reporting infrastructure</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Accounting information system applications</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Pastel Partner accounting information system</td>
<td>40</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
<td>Management reporting systems</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>Assignments</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>Examination</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Total number of hours</td>
<td>120</td>
</tr>
</tbody>
</table>
12 TEACHING STRATEGY

The focus of our teaching role is to facilitate your learning experiences towards achieving the specific learning outcomes. Furthermore, these learning experiences have been designed to enable you to master the learning content at a predetermined competence level.

13 MEANING OF WORDS

Throughout this module we communicate learning outcomes and self-assessment criteria phrased in terms of what you should be able to do. This process involves the use of action words, which are typically verbs or phrases containing verbs, describing what the student is expected to do in the learning activity. Our objective is to ensure that the words we use to indicate a requirement clearly state what you have to do, and you should also ensure that you clearly understand the requirements conveyed by the range of words we will use in the study material for this module.

We list below (in alphabetical order) examples of some of the action words you will encounter in this module, together with their meanings for the purposes of this module.

<table>
<thead>
<tr>
<th>Action word</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply</td>
<td>Demonstrate knowledge and understanding by using information in a practical sense; use where relevant or appropriate. Use in a practical way.</td>
</tr>
<tr>
<td>Calculate</td>
<td>Ascertained by mathematical procedure/exact reckoning.</td>
</tr>
<tr>
<td>Compare</td>
<td>Examine in order to observe resemblances, relationships and differences.</td>
</tr>
<tr>
<td>Complete</td>
<td>Finish/add what is required.</td>
</tr>
<tr>
<td>Define</td>
<td>State precisely the meaning/scope/total character; make clear (especially the outline); give a concise description of the distinguishing features.</td>
</tr>
<tr>
<td>Describe</td>
<td>Give clearly the distinguishing details or essential characteristics.</td>
</tr>
<tr>
<td>Determine</td>
<td>Decide; come to a conclusion/make a decision by means of reasoning.</td>
</tr>
<tr>
<td>Discuss</td>
<td>Examine/consider the opposing arguments (for or against a view).</td>
</tr>
<tr>
<td>Draft</td>
<td>Prepare a preliminary version.</td>
</tr>
<tr>
<td>Evaluate</td>
<td>Make judgements on the basis of given criteria.</td>
</tr>
<tr>
<td>Examine</td>
<td>Investigate carefully/in detail.</td>
</tr>
<tr>
<td>Explain</td>
<td>Set out the meaning; clarify the meaning, provide supporting evidence; argue the truth.</td>
</tr>
<tr>
<td>Identify</td>
<td>Establish by consideration, select, recognise.</td>
</tr>
<tr>
<td>List</td>
<td>Record/document/itemise names or things belonging to a class.</td>
</tr>
<tr>
<td>Mention/ name/state</td>
<td>Specify by name; cite names, characteristics, items, elements or facts.</td>
</tr>
<tr>
<td>Motivate</td>
<td>Cite facts/reasons as support for a viewpoint or argument and draw a conclusion.</td>
</tr>
<tr>
<td>Organise</td>
<td>Arrange in an orderly structure/sequence; place into classes/groups according to certain criteria.</td>
</tr>
<tr>
<td>Prepare</td>
<td>Make ready/complete; make something ready on the basis-based on of previous study.</td>
</tr>
<tr>
<td>Record</td>
<td>Put in writing; set down for reference and retention.</td>
</tr>
<tr>
<td>Summarise</td>
<td>Give a condensed version; state the key aspects.</td>
</tr>
</tbody>
</table>
14 CONCLUSION

We trust that the above information will help you to approach your AIN2601 studies methodically and with greater understanding.

AIN2601 is not simply one of those modules you pass, tick off as part of your degree requirements and continue – these are skills you can use for life. Knowing Pastel and Excel well will give you a competitive advantage in the marketplace.

Enjoy your studies and remember the words of Vince Lombardi:

“The price of success is hard work, dedication to the job at hand, and the determination that whether we win or lose, we have applied the best of ourselves to the task at hand.”

We trust that you will enjoy the AIN2601 journey with us. We wish you every success with your studies.

Kind regards

Your AIN2601 lecturers
# CONTENTS

## OVERVIEW

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>132</td>
</tr>
</tbody>
</table>

## STUDY GUIDE 1

### PART 1: DATA MANAGEMENT AND UTILISATION

#### Topic 1 – Data management and utilization

<table>
<thead>
<tr>
<th>Study unit 1: Data and the computerised information system process</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
<td>15</td>
</tr>
<tr>
<td>2 Data in an organization</td>
<td>16</td>
</tr>
<tr>
<td>3 Input of data</td>
<td>16</td>
</tr>
<tr>
<td>4 Processing data</td>
<td>18</td>
</tr>
<tr>
<td>5 Output/information</td>
<td>22</td>
</tr>
<tr>
<td>6 Typical processing systems</td>
<td>23</td>
</tr>
<tr>
<td>7 Storage of data and information</td>
<td>25</td>
</tr>
<tr>
<td>8 Summary</td>
<td>26</td>
</tr>
</tbody>
</table>

#### Study unit 2: The database environment

<table>
<thead>
<tr>
<th>Study unit 2: The database environment</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
<td>27</td>
</tr>
<tr>
<td>2 The database environment</td>
<td>28</td>
</tr>
<tr>
<td>3 Advantages and disadvantages of using a database environment</td>
<td>28</td>
</tr>
<tr>
<td>4 Database users</td>
<td>29</td>
</tr>
<tr>
<td>5 Database management systems (DBMS)</td>
<td>30</td>
</tr>
<tr>
<td>6 Physical database</td>
<td>33</td>
</tr>
<tr>
<td>7 Factors to consider when choosing a DBMS and database</td>
<td>42</td>
</tr>
<tr>
<td>8 Summary</td>
<td>43</td>
</tr>
</tbody>
</table>

#### Study unit 3: Utilising databases

<table>
<thead>
<tr>
<th>Study unit 3: Utilising databases</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
<td>45</td>
</tr>
<tr>
<td>2 Databases in accounting and auditing</td>
<td>45</td>
</tr>
<tr>
<td>3 Data warehouse</td>
<td>46</td>
</tr>
<tr>
<td>4 Data mart</td>
<td>46</td>
</tr>
<tr>
<td>5 Data mining</td>
<td>47</td>
</tr>
<tr>
<td>6 Online analytical processing (OLAP)</td>
<td>47</td>
</tr>
<tr>
<td>7 Similarities and differences between OLAP and data mining</td>
<td>47</td>
</tr>
<tr>
<td>8 Summary</td>
<td>47</td>
</tr>
</tbody>
</table>
## PART 2: SPREADSHEETS

### Topic 2 – Spreadsheets

<table>
<thead>
<tr>
<th>Study unit 4: Creating user-friendly spreadsheets</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
</tr>
<tr>
<td>2 Basic principles to revise before working on Microsoft Office Excel</td>
</tr>
<tr>
<td>3 How to solve a problem in Microsoft Office Excel</td>
</tr>
<tr>
<td>4 Using Microsoft Office Excel: regional settings</td>
</tr>
<tr>
<td>5 Background</td>
</tr>
<tr>
<td>6 Workbook basics</td>
</tr>
<tr>
<td>7 Operating the workbook</td>
</tr>
<tr>
<td>8 Workbook and cell formatting</td>
</tr>
<tr>
<td>9 Printing and page layout</td>
</tr>
<tr>
<td>10 Summary</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Study unit 5: Spreadsheet formulas and functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
</tr>
<tr>
<td>2 Working with formulas</td>
</tr>
<tr>
<td>3 Functions</td>
</tr>
<tr>
<td>4 Commonly used functions</td>
</tr>
<tr>
<td>5 Working with data</td>
</tr>
<tr>
<td>6 Working with charts</td>
</tr>
<tr>
<td>7 Working with pivot tables</td>
</tr>
<tr>
<td>8 Spreadsheets: the bigger picture</td>
</tr>
<tr>
<td>9 Summary</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Study unit 6: Spreadsheet security, risks and controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
</tr>
<tr>
<td>2 Spreadsheet risks</td>
</tr>
<tr>
<td>3 Spreadsheet controls</td>
</tr>
<tr>
<td>4 Microsoft Office Excel security controls</td>
</tr>
<tr>
<td>5 Summary</td>
</tr>
</tbody>
</table>

---

The following topics will be discussed in Study guide 2 (MO002)

## PART 3: TRANSACTION PROCESSING

### Topic 3: Accounting cycles

### Topic 4: Financial reporting infrastructure

### Topic 5: Accounting information system applications

### Topic 6: Pastel Partner accounting information system

## PART 4: MANAGEMENT REPORTING SYSTEMS

### Topic 7: Management reporting systems

---

<table>
<thead>
<tr>
<th>BIBLIOGRAPHY</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>KEY TERM LIST</th>
</tr>
</thead>
</table>
Data management and utilisation

**PURPOSE**

The aim of this part is to firstly, build on the foundation laid in the AIN1501 module regarding the computerised information system process. Secondly, the database environment, including different database models, database management systems and relational database terminology will be explained. This part concludes with a brief discussion of the utilisation of databases in accounting and auditing.
LEARNING OUTCOMES

After studying this topic, you should be able to

- distinguish between the different methods of data input, data processing and information output
- name and describe each of the elements of the database environment
- list the functions of a database management system
- define and describe each of the components of a database management system
- differentiate between various database models
- define relational database terminology and identify each item on a simple database representation
- list the advantages and disadvantages of using a database environment for data storage and processing
- identify factors to consider when choosing an appropriate database management system and database
- name and briefly explain some basic database applications
1 Introduction
For an organisation to be competitive, data must be collected, processed into useful information, stored and used in decision making. Many organisations have realised that timely access to appropriate, accurate data and information is the key to success or failure. A lack of access and/or timely access reduces the organisation’s ability to make timely and effective decisions. In this study unit, we will first gain an understanding of the role of data in an organisation. We will then look at the types of data input, processing and output and typical processing systems. We will also learn about some of the methods used to process data into information.
2 Data in an organisation

Activity 1.1

Review the computerised information system (CIS) process as explained to you during your AIN1501 studies.

![Diagram of the computerised information system process]

Refer to figure 1.1 throughout the following discussion:

Data is generated during different activities (a) in the organisation. For example, each time a customer completes an order form, the organisation produces an inventory item, a potential employee completes a job application form, data is generated. Organisations continuously collect and enter (b) the abovementioned data into the CIS, process (c) and store (d) data and information about their customers, suppliers, inventory, competitors, employees, finances, business operations, to name only a few.

Bear in mind that organisations (and individuals) usually make better informed decisions (f) if they have access to more data and valuable information.

Activity 1.2

As you can remember from your AIN1501 studies, the characteristics of valuable information are accessible, accurate, complete, economical, flexible, relevant, reliable, secure, simple, timely and verifiable. Refer back to your AIN1501 studies or to study unit 19 and ensure you understand these important characteristics of information.

Input of data (also called data entry) (b), processing of data (c), output (e) and storage of data and information (d) will now be discussed in more detail.

3 Input of data

Data captured on manual documents (hard copy) as well as data entered in the CIS and not yet processed is called **raw data**.

Raw data has little or no value for the organisation in the decision-making process. Raw data becomes valuable when processed (c) into information (e) and an organisation then uses this information for decision making (f). For example, having a list of all the sales in a specific branch (raw data) is not useful in itself, but when this raw data is processed into information, for example, total sales for a month compared to other months and branches in the organisation, this information now has become useful and valuable.
Because **information** is obtained by processing **raw data**, it is essential that the raw data captured in the CIS should be **accurate, complete, reliable and verifiable**.

The quality of information is directly linked to the quality of raw data entered – in other words, inaccurate data will lead to inaccurate information and incomplete data will lead to incomplete information, which in turn will result in ineffective decisions. The principle of “garbage-in-garbage-out” is especially true in a CIS. Many organisations have embarked on expensive data cleaning (correcting and completing data) projects because they understand the impact of inadequate data on information and decision making.

---

**NOTE**

Note the difference between the terms “**information**” and “**data**”. Make sure you use the correct term.

**Information = processed data**

---

Many medium and small organisations still use paper source documents (eg invoices, application forms, etc) to collect data. Most large organisations, however, have moved to electronic source documents by capturing data directly through computer data entry screens or by using barcode scanners. In topic 6 (Pastel) you will practise using computer data entry screens to capture invoices and other source documents.

A **source document** is the first documented record of an activity that took place.

Data can be entered (input) into a CIS either through **batch input** or through **online input**. For both these input types, the data captured will be stored in the CIS **transaction file**. Transaction files are explained in study unit 2.

### 3.1 Input types

**(a) Batch input**

Data is first captured on paper (hard copy) or electronic (soft copy) source documents. The electronic source documents referred to are documents created outside of the organisation’s CISs. For example, the organisation receives an electronic file from one of its trading partners containing a batch of electronic source documents.

**Batch input** involves similar source documents being grouped together (batch) and then entered in the CIS periodically, say, daily, weekly or monthly.

The organisation’s processes will determine the frequency of capturing the data – for example, employee data may only be captured once a month before the payroll run, supplier invoices may be captured twice a week and goods received notes may be captured daily.

Batch input is used where a huge number of similar source documents must be captured and up-to-date data and information are only required on the same frequency as the frequency of data capturing. An example of batch input is Unisa main campus receiving completed MCQ mark sheets from Unisa regional offices and through the post. These completed mark sheets are batch together and captured daily into Unisa’s CIS.
Batch input will require additional batch controls and procedures to be implemented in the organisation's control environment. You will learn more about these controls and procedures in auditing.

The advantage of using batch input is that economies of scale (increased productivity and lower hardware costs) can be achieved because the data is captured at one point and data capturing is not dispersed throughout the organisation. The main disadvantage of using batch input is that the CIS is not always up to date with the latest data and information.

(b) **Online input**

*Online input* involves data being *immediately* captured into the CIS at the point where the activity occurs.

Many supermarkets use barcode scanners and terminals for *online inputting* when customers buy inventory items by scanning (capturing) the inventory item at the point of sale (pay point).

Because data is captured directly and immediately, any corrections to the data must also be made immediately in order for the data capturing process to be completed. Taking the above example of a supermarket pay point, you may have experienced the barcode of an item not being recognised by the CIS (error), and the person at the till having to enter the correct barcode (correction) in order to complete the transaction.

Another example of online input is students capturing their assignment MCQ answers themselves into the myUnisa CIS.

The main advantage of using online input is that the data in the CIS is always up to date. (Please note that although the raw data may be up to date the information in the CIS may not be up to date as the data may not be processed yet. Refer to section 4.2) A disadvantage, however, is that online inputting is more costly because hardware is required to capture the data at each point where the activity to be captured takes place.

4  **Processing data**

4.1  **Processing methods**

For *raw data* to become information, it must be processed (c) (ie *data processing*). The different methods that can be use to process data into information include the following:

(a)  **Classifying data**

Data is arranged into different groups (categories) using some of the data's specific characteristics, for example, classifying the data according to cash or credit sales or according to the source document (ie orders, tax invoices, etc).

(b)  **Performing calculations**

Arithmetical or logical calculations can be performed on data. *Arithmetical* calculations include addition (+), subtraction (–), multiplication (x) or division (/), for example, calculating the cost per unit (R cost divided by number of units); the VAT amount on a tax invoice (VAT% multiplied by the excluding VAT amount); net profit/loss (expenses subtracted from income); the total amount on an invoice (adding the amounts of the individual items).

Logical calculations include comparing the data to other data or calculations – for example, is the data the same (=), not the same (<>), greater than (>), smaller than (<), greater than or equal to (>=) or smaller than or equal to (<=)? The logical calculation will have a true or false answer, and based on this answer, further processing will take place. The IF function is one of various Microsoft Excel functions that can be used for logical calculations. See study unit 5 in which the IF function is explained in detail.
(c) **Sorting data**

Data is organised (sorted) in an orderly sequence based on specific criteria, for example, purchase orders in numerical sequence or the names of customers in alphabetical order. In study unit 5 we will learn how to sort data using Microsoft Excel.

(d) **Summarising data**

This process condenses the data by extracting only specific data based on criteria provided by the user – for example, adding all the transactions for a specific supplier for a particular month. A pivot table is an example of a Microsoft Excel function that can be used to summarise data. In study unit 5 we will learn how to create a pivot table using Microsoft Excel.

(e) **Transforming data**

Data is processed by transforming the format or medium of the original data into another format or medium – for example, accounting data is transformed into graphical data (graph) or audio files can be transformed into written text (used by individuals with hearing disabilities to communicate telephonically) or vice versa. (Wessels, Mc Gee, Prinsloo, Mc Gee and Van der Poll 2010:34)

In Microsoft Excel study unit 5 we will learn to transform data using graphs.

### Activity 1.3

*Note: This activity refers to databases that we will only learn about in study unit 2. Return to this activity after you have completed study unit 2.*

Campus Computers is a business that sells computers and software to students. The business has developed its own software to record its business transactions in a database.

The business has three overseas suppliers and two local suppliers from which it purchases inventory. Inventory must be ordered when the quantity on hand reaches the minimum reorder level.

Data was processed into information in the database of Campus Computers, as can be seen in the extract of the database files below.

**Required:**
Identify examples of each of the processing methods listed below:

(a) Classifying  
(b) Sorting  
(c) Calculating  
(d) Summarising
The following is an extract from the files of Campus Computers' database:

**Supplier master file**

<table>
<thead>
<tr>
<th>Supplier no.</th>
<th>Supplier name</th>
<th>Telephone</th>
<th>Currency</th>
<th>Balance (a)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCW003</td>
<td>PC World</td>
<td>+27 09 847-9387</td>
<td>ZAR</td>
<td>9251.18</td>
</tr>
<tr>
<td>DIL001</td>
<td>Dille Computers</td>
<td>+00 1 907-8334</td>
<td>USD</td>
<td>54397.90</td>
</tr>
<tr>
<td>FOR001</td>
<td>Forever PC</td>
<td>+00 33 923-1426</td>
<td>EURO</td>
<td>94706.81</td>
</tr>
<tr>
<td>SAP001</td>
<td>SAPC</td>
<td>+27 09 959-1234</td>
<td>ZAR</td>
<td>229866.02</td>
</tr>
<tr>
<td>GIG002</td>
<td>GIGAB Computers</td>
<td>+00 1 213-1177</td>
<td>USD</td>
<td>1528599.85</td>
</tr>
</tbody>
</table>

**Inventory master file**

<table>
<thead>
<tr>
<th>Inventory no.(b)</th>
<th>Item description</th>
<th>Inventory category (c)</th>
<th>Quantity on hand (d)</th>
<th>Minimum reorder level</th>
<th>Last cost price</th>
<th>Order Yes/ No (e)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HD/250</td>
<td>360 Gig hard drive</td>
<td>Parts</td>
<td>22</td>
<td>7</td>
<td>729.50</td>
<td>No</td>
</tr>
<tr>
<td>LAP142</td>
<td>Laptop – SAPC</td>
<td>Computer</td>
<td>12</td>
<td>5</td>
<td>10000.00</td>
<td>No</td>
</tr>
<tr>
<td>LAP175</td>
<td>Laptop – GIGAB I</td>
<td>Computer</td>
<td>35</td>
<td>20</td>
<td>14000.00</td>
<td>No</td>
</tr>
<tr>
<td>MON190</td>
<td>Monitor – 19 inch</td>
<td>Parts</td>
<td>7</td>
<td>12</td>
<td>3400.00</td>
<td>Yes</td>
</tr>
<tr>
<td>MOU050</td>
<td>Mouse – cordless</td>
<td>Accessories</td>
<td>9</td>
<td>15</td>
<td>45.35</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Purchase transaction file**

<table>
<thead>
<tr>
<th>Invoice no. (f)</th>
<th>Line no.</th>
<th>Supplier no.</th>
<th>Purchase date</th>
<th>Inventory no.</th>
<th>Quan</th>
<th>Price per unit</th>
<th>VAT (g)</th>
<th>Total (h)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PN10029</td>
<td>1</td>
<td>SAP001</td>
<td>14-Jun-16</td>
<td>LAP142</td>
<td>5</td>
<td>10000.00</td>
<td>7000.00</td>
<td>57000.00</td>
</tr>
<tr>
<td>PN10030</td>
<td>1</td>
<td>FOR001</td>
<td>15-Jun-16</td>
<td>MOU050</td>
<td>9</td>
<td>45.35</td>
<td>57.14</td>
<td>465.29</td>
</tr>
<tr>
<td>PN10030</td>
<td>2</td>
<td>FOR001</td>
<td>15-Jun-16</td>
<td>HD/250</td>
<td>1</td>
<td>729.50</td>
<td>102.13</td>
<td>831.63</td>
</tr>
<tr>
<td>PN10030</td>
<td>3</td>
<td>FOR001</td>
<td>15-Jun-16</td>
<td>MON190</td>
<td>3</td>
<td>3400.00</td>
<td>1428.00</td>
<td>11628.00</td>
</tr>
<tr>
<td>PN10031</td>
<td>1</td>
<td>GIG002</td>
<td>16-Jun-16</td>
<td>LAP175</td>
<td>4</td>
<td>15500.00</td>
<td>8680.00</td>
<td>70680.00</td>
</tr>
</tbody>
</table>

**Supplier history file**

<table>
<thead>
<tr>
<th>Supplier no.</th>
<th>Month (i)</th>
<th>Transaction type (j)</th>
<th>Amount excl VAT (k)</th>
<th>VAT (l)</th>
<th>Amount incl VAT (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOR001</td>
<td>April-15</td>
<td>Purchase</td>
<td>58456.50</td>
<td>8183.91</td>
<td>66640.41</td>
</tr>
<tr>
<td>FOR001</td>
<td>May-15</td>
<td>Purchase</td>
<td>114580.00</td>
<td>16041.20</td>
<td>130621.20</td>
</tr>
<tr>
<td>FOR001</td>
<td>May-15</td>
<td>Payment</td>
<td>-101298.00</td>
<td>-14181.72</td>
<td>-115479.72</td>
</tr>
<tr>
<td>FOR001</td>
<td>June-15</td>
<td>Purchase</td>
<td>11337.65</td>
<td>1587.27</td>
<td>12924.92</td>
</tr>
<tr>
<td>Balance for the quarter (n)</td>
<td></td>
<td></td>
<td>83076.15</td>
<td>25812.38</td>
<td>94706.81</td>
</tr>
</tbody>
</table>
(a) Classifying

- Inventory is classified according to three categories: Parts, Computers and Accessories in the Inventory category fields (c).
- Transactions for supplier FOR001 are categorised into two categories: Purchases and Payments in the Transaction type fields (j).

(b) Sorting

- The suppliers are sorted in ascending order, based on the Balance fields (a).
- The inventory items are sorted in ascending order, based on the Inventory number fields (b).
- Purchase transactions are sorted in ascending order, based on the Invoice number fields (f).
- Transactions for supplier FOR001 are sorted, based on the Month fields (i).

(c) Calculating

- The Supplier balance fields (a) have been updated with the total of the purchase transactions for that supplier.
- The Quantity on hand fields (d) have been updated with the quantity purchased in the purchase transactions for that inventory item.
- The Order Yes/No fields (e) have been updated with the logical test – the quantity on hand is less than the minimum reorder level.
- The VAT field (g) has been calculated for each purchase transaction.
- The Total field (h) has been calculated for each purchase transaction based on the quantity, price per unit and VAT amount.
- The Amount including VAT fields (m) for supplier FOR001 have been calculated for each month, based on the Amount excluding VAT and VAT fields.
- For supplier FOR001, the totals per quarter (n) for the fields Amount excluding VAT (k), VAT (l) and Amount including VAT (m) have been calculated.

(d) Summarising

- The Amount excluding VAT (k), VAT (l) and Amount including VAT (m) transactions relating to supplier FOR001 were summarised for the quarter April 2015 to June 2015 in the supplier history file.
4.2 Processing types

Data can be processed into information by means of two processing types, either batch processing or real-time processing.

(a) Batch processing

Batch processing occurs when the transaction files (containing the captured data) are updated to the master files periodically, that is, daily, weekly or monthly.

The main drawback of this method of processing is that the master files are only up to date once the updating of the transaction files has occurred. When using this method of processing, users who utilise information and data must be aware of which transaction files were updated and which files were not, and therefore how up to date the information they are looking at is. An example of batch processing is the marking (processing) of all the captured AIN2601 assignment 1 multiple choice questions’ (MCQs) answers on a specific date. Students would therefore need to be aware that year marks will only be updated after the assignment marks were processed. Transaction files and master files are explained in study unit 2.

(b) Real-time processing

The immediate update of the transaction files to the master files as the transaction occurs is called real-time processing.

An example of real-time processing is buying a movie ticket at a movie theatre. The movie you want to see and number of tickets (data) entered (either by yourself at the ticket machine or by the sales person) is immediately updated to the master files (seating plan) so that the same seat cannot be sold twice to two different persons.

Real-time processing ensures that the master files are always up to date, and this is also the greatest advantage of processing. Transaction files and master files are explained in study unit 2.

5 Output/information

Processed data becomes information, and this information can be retrieved by users through batch output or interactive output.

5.1 Batch output

Batch output occurs when all requests for information (ie reports, queries, etc) are batched together and periodically extracted from the CIS.

Since requests are batched before being extracted, users have to wait to receive their required outputs. Batch output is often used for routine reports that must be extracted at the same time each day, week or month (eg sales reports for the day, week or month). These batched reports are pre-specified and include the same parameters each time.

A bank generating monthly bank statements for clients is an example of batch output as the bank will extract the required information once a month on a specific date from their CIS ie all clients' bank statements are extracted in one batch.

The benefit of using batch output is that reports are consistent between periods. For example, the sales reports will include the same branches in the different geographical areas each time the specific report is extracted. Another benefit of output is that the extraction of reports can be over down times (over weekends, evenings, etc.), thereby optimising computer resources.
5.2 Interactive output

Interactive output occurs when users are directly connected to the CIS and can request certain information and receive it immediately.

Using internet banking and viewing your transactions for a month or a period specified by you is an example of interactive output.

The main benefit of using this method of output is that users can immediately receive information for decision making. One of the drawbacks of interactive output is that the computer resources are not optimally used and as a result, the performance of the CIS may be negatively affected. For example, at month-end, numerous users extract reports from the CIS while day-to-day transaction processing still continues. This increase in use of the CIS can make the users experience a “very slow” CIS response time (i.e. the computer is “slow”).

6 Typical processing systems

In section 3 to 5 we learnt about batch and online input, batch and real-time processing and batch and interactive output. Different combinations of these inputs, processing and output types are used in an organisation’s CIS. Some of these typical combinations are as follows:

- **Batch input, batch processing and batch output**

  The processing of claims at a medical aid is an example of such a system. Members submit claims, which are batched together and then entered in the CIS. All the entered batches are updated at the end of each day. Routine claim reports, indicating the claims of the previous week, are extracted and distributed every Monday morning. See figure 1.2 for a visual representation.

![Figure 1.2: Batch input, batch processing and batch output](image)

- **Batch input, batch processing and interactive output**

  For example, twice a week, the gym partner of a medical aid provides the medical aid with batch of electronic source documents in one file. This file contains the number of times each member of the medical aid visited the gym. The batch source documents contained in the electronic file are imported when received. The transaction files containing the gym data are updated every Saturday. The members can view their information on the medical aid’s secure website as soon as the transaction file has been updated.
Online input, batch processing and interactive output

For example, each branch of the organisation enters its request for inventory online as needed. The transaction file containing the different branches’ requests is updated to the master file every two days. The branch manager can extract order information directly from the operational system.

Online input, real-time processing and interactive output

An example of such a system is the processing of a transaction at a bank’s automatic teller machine (ATM). The customer enters the transaction at the ATM. The transaction is immediately updated to the master file and the customer receives a receipt with the transaction details and his or her new updated balance. See figure 1.3 for a visual representation.

![Diagram of online input, real-time processing and interactive output]

FIGURE 1.3: Online input, real-time processing and interactive output

Please note that an organisation’s CIS is not limited to one type of processing system. Many organisations will use all the types of input, processing and output. The type used will be determined by the activity performed ie an organisation can use both batch input and online input. Take for example the capturing of a Unisa MCQ assignment answers. The answers submitted by students through the myUnisa interface is online input and the capturing of the physical answer sheets will be captured using batch input at the Unisa main campus.

Can you think of an example where a CIS uses both real-time processing and batch processing? Pastel Partner (per the standard set up) will use batch processing for invoices but uses real-time processing for good receive notes (GRN). You will learn more about Pastel Partner in topic 6. Refer back to this study unit after you have completed topic 6.

Banks use both batch output (printing of monthly bank statements) and interactive output (request of a mini statement at an ATM).

Activity 1.4

Think about what processing systems you have encountered in everyday life? For example what type of processing system (input, processing and output) is your favourite clothing store, supermarket or restaurant using? Explain these to one of your friends or fellow students.
7 Storage of data and information

Data is saved (stored) for use in processing, and information is stored (saved) to be used by users. Data and information must be stored in the CIS in such a way that it can be easily accessed when needed.

7.1 Flat file environment

Historically, computer systems’ data and information were stored in a flat file environment, where files are not related to one another and the users of data and information each keep their own data and information.

This is similar to an environment in which users each have their own Microsoft Excel spreadsheet and do not share the data and information on their individual spreadsheets. As computer systems evolved and the need arose for users to share data and information, databases became the preferred method of storing data and information. The database environment will be discussed in detail in study unit 2. Simplistically, the flat file and database environment can be visualised as in figure 1.4 (flat file) and figure 1.5 (database).

FIGURE 1.4: Flat file environment
In this study unit, we looked at typical processing systems based on the types of data input, processing and output. We also gained an understanding of how data is processed into information by sorting, classifying, calculating, summarising and transforming it. In the next study unit, we will examine in detail the database environment used to store data and information.

**Self-assessment activity**

After working through this study unit, you should be able to answer the following questions:

(a) Prepare a figure to depict the computerised information system (CIS) process.
(b) Organisations make better decisions if they have access to less data and valuable information. Is this statement true or false?
(c) Define the term “raw data”.
(d) List the four (4) characteristics raw data should have before it is captured in the CIS.
(e) Explain why it is important for the raw data to have the characteristics mentioned in d.?
(f) Briefly explain batch input and online input.
(g) Name the advantages and disadvantages of using batch input and online input respectively.
(h) List the methods and give an example for each method that can be used to process data into information.
(i) Briefly explain batch processing and real-time processing.
(j) Name an advantage of using real-time processing.
(k) Briefly explain batch output and interactive output.
(l) Describe the advantages and disadvantages of using batch output and interactive output respectively.
(m) List four (4) typical processing systems that are found in CIS.
(n) Why are data and information stored?
(o) Explain the concept of a flat file environment.
The database environment

1 Introduction

In the previous study unit, we learnt that the database environment provided the solution to the need of users to be able to share and view the same data and information in an organisation. Databases became the preferred method of storing data and information because of their numerous advantages. In this study unit, we will gain an understanding of the database environment, the advantages and disadvantages of using a database environment and an understanding of the database environment's components. We will also explain database models, distributed and databases and the terminology used in a relational database. In conclusion, we will look at the factors to consider when choosing appropriate database management software and a database.
2 The database environment

In a database environment, data and information can be effectively stored and retrieved.

The database environment consists of three components, namely the users of the database, database management systems (DBMS) and the physical database, which includes both the hardware it runs on and the data in the physical database (see figure 2.1).

The database environment and its related components are explained in detail in sections 4 to 6.

3 Advantages and disadvantages of using a database environment

Using a database environment to store, process and retrieve data and information has advantages and disadvantages. We will briefly look at some of these.

3.1 Advantages

- **Reduce data redundancy.** This is because all data is stored in only one place.
- **Reduced costs for data entry and data storage.** Data is only entered once, which creates a data capturing cost saving. The effect of reduced data redundancy is that less storage space is needed on storage devices, creating a data storage cost saving.
- **Data integrity is maintained and improved.** This is because changes and updates to data occur in one place.
- **Improved data and information security.** Since access to the database and therefore access to the data and information in the database is centrally controlled and managed, this increases security for the organisation’s data and information.
Application software independence. Data is stored separately from the application software. Changes to the database will therefore not always require an automatic rewriting or updating of the application software, or vice versa.

Standardisation of data structures, data access, system software and file formats.

This makes it easier to maintain data files. The standardisation creates a consistent structure on which all application software are based, which makes it easier to update existing or develop new application software.

Improved data access. Data can be made available to different users at the same time as users share the data in the database. Database management software also makes it easy for users to access and retrieve data.

3.2 Disadvantages

Start-up and operating costs. It can be expensive to acquire the hardware and software needed to set up a database environment. Furthermore, an organisation will need to hire additional employees, such as a database administrator, to manage the database environment.

Database systems are complex to design and use.

Because databases are complex, it is very time-consuming to design a proper database.

Database or database management software failure will affect all application software linked to that specific database. This can make recovery from such a failure more difficult. A failure can shut down a whole organisation or department(s) in the organisation, making the organisation unable to run its daily operations and provide adequate customer service.

4 Database users

There are various database users in the database environment, including the following:

4.1 End-users

End-users capture data in the database and extract information from the database using database management system software.

Owing to their computer skill level, most end-users will interact with the database management system (DBMS) through application software. DBMS is explained in section 5.

4.2 Application programmers

Application programmers are responsible for creating, maintaining, updating and managing the application and DBMS software which the end-users use to interact with the physical database.

4.3 Database administrator

The database administrator is responsible for managing and controlling the organisation's databases
The database administrator’s role includes functions such as the following:

- Implement and maintain database management standards and conventions.
- Ensure applications software complies to database management standards and conventions by establishing programming standards.
- Define the database structures.
- Design and create databases in line with database management standards and conventions.
- Implement, maintain and evaluate database access policies and security controls.
- Monitor data and database security and access.

4.4 Data administrator

The data administrator, also called a database analyst, is responsible for managing and controlling the data in the organisation’s databases.

One of the data administrator’s responsibilities is to manage the integrity of the data in the database by setting and enforcing the data standards and data definitions to be used in all the organisation's databases. In many organisations, the functions of the data administrator and database administrator are combined – hence these functions are performed by the same person.

5 Database management systems (DBMS)

A DBMS is an integrated set of software that provides a user-friendly interface to the users for all data interactions between the user and the physical database – in other words, it enables the users to operate and interact with the database.

Some examples of commonly used DBMSs are Microsoft Access, SQL Server, Oracle, Sybase, MySQL (open source software).

5.1 DBMS functions

DBMS enables users to

- design, create and maintain the database structure and the database
- control the organisation, storage and retrieval of data in the database
- capture, maintain (delete, insert and amend) and manipulate the data in the database
- share data between multiple users simultaneously
- execute queries and generate outputs
- control the movement of the data between authorised users and the database
- control and monitor access to the database
- analyse and monitor database performance
5.2 Three-level database architecture

ANSI-SPARC (American National Standards Institute [ANSI] – Standards Planning and Requirements Committee [SPARC]) suggested a three-level database architecture, namely an external level, level and level (Boczko 2007:314). This three-level database architecture is now commonly used in modern DBMS frameworks and is based on the different views of data in a DBMS.

(a) External level

The external level, also called the user view, is the individual end-user’s view of the data and the database.

Because users’ information needs differ, the views they require of the database will also differ – hence there may be an infinite number of external views. For example, the creditor’s clerk input screen and reports (user view) will look different from the input screen and reports (user view) of the cashbook clerk. When working on Pastel Partner (topic 6), we will see in practice how the user views differ, depending on the type of transaction processed (ie creditors, cashbooks, etc).

(b) Conceptual level

The conceptual level is a complete view of the entire database, that is, a view of all the data from which the user views can be derived.

The database administrator will generally use this view. In comparison with the user view, which may have infinite variations, there is only one conceptual view.

(c) Internal level

The internal level, also called the physical view, is the low-level view of how the data is physically stored on a storage device such as a magnetic hard drive disk.

There is only one physical view. The binary code (1s and 0s, eg 01100011) in the database is one facet of the physical view.

The database administrator updates and maintains all three levels.

![Three-level database architecture](image)

FIGURE 2.2: Three-level database architecture
5.3 DBMS key components

The key components of the DBMS are the data dictionary and database languages.

(a) Data dictionary

A data dictionary is a centralised file containing detailed information about the database and the data contained in the database.

The data dictionary is a very important tool for all database users as it ensures all users have the same understanding of the data fields and database files. A data dictionary will therefore assist in the accurate processing of data and make information and/or data easier to analyse.

Amongst others the information a data dictionary contains include:

- What data is stored in the database
- For each data field in the database information such as:
  - the name and description of the data field
  - other names the data field may have
  - a range of acceptable values
  - the data type (type of data stored, ie numeric, alphabetic, alphanumeric, date, etc)
  - the field length (the number of characters that can be entered into the data field)
  - the software and records it is used in
  - the source of the data field
  - outputs in which it is used
- The names and descriptions of the database files.
- For each database file a list of attributes, primary keys and foreign-keys included
- The authorised user groups for the database files and/or data fields

An extract of some of the information contained in a data dictionary is provided below.

<table>
<thead>
<tr>
<th>Table name</th>
<th>Field name</th>
<th>Description</th>
<th>Field length</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier master</td>
<td>Credit limit</td>
<td>Supplier credit limit</td>
<td>7</td>
<td>Numeric</td>
</tr>
<tr>
<td>Supplier master</td>
<td>Balance</td>
<td>Balance outstanding, Amount includes VAT</td>
<td>15</td>
<td>Numeric</td>
</tr>
<tr>
<td>Inventory master</td>
<td>Inventory category</td>
<td>The category the inventory item belongs too</td>
<td>20</td>
<td>Alphabetic</td>
</tr>
<tr>
<td>Inventory master</td>
<td>Inventory code</td>
<td>Inventory item unique code</td>
<td>6</td>
<td>Alphabetic</td>
</tr>
</tbody>
</table>

As you have noticed this section about the data dictionary refers to terminology you may not be familiar with. These terminology are explained in section 6.3 of this study unit. Therefore refer back to this section about the data dictionary after you have worked through section 6.3.

(b) Database languages

The database users (end-users, application programmers and database administrator) use different database languages to interact with the database.

These languages included a data definition language, data control language, data manipulation language and a data query language. These database languages are
usually specific to the database model in use. (We will learn about these different
types of database model in section 6.) SQL (structured query language) is one for
the most commonly used database languages for a relational database model and
combines the data definition language, data control language, data manipulation
language and data query language.

- **Data definition language (DDL)**

  As the name implies, data definition language is used to define a database and
  includes commands to (1) create, modify and delete the database and database
  objects, (2) define and describe the data structure of the database according to the
  database model used, and (3) create the data dictionary.

  Database objects include database tables, views, rules, indexes and so forth. DDL is
  usually only available for use by the database administrator and requires detailed
  knowledge of the conceptual level of the DBMS.

- **Data control language (DCL)**

  DCL controls the security and user access to the database objects and data in
  the database.

  DCL is usually only available for use by the database administrator.

- **Data manipulation language (DML)**

  DML is used in the routine operation of the database to insert, delete, modify and
  maintain the data stored in the database.

  Data manipulation language can be used by all the database users, but the level of
  use will be determined by their skill level and access granted. Most end-users,
  however, access the DML through application software. DML and DDL should not be
  confused. DML is used for the data stored in the database while DDL is used on the
  database objects and structure.

- **Data query language**

  Data query language is used to retrieve data from the database.

  All database users can use data query language. However, owing to their
  programming skill level, most end-users access the data query language through
  application software.

6 Physical database

A database can be defined as an organised collection of related data that is managed and
stored electronically and can provide data to different application software in the
organisation.
Through the use of a DBMS, different application software and users in an organisation can access the same data and a variety of other data in the database.

### 6.1 Database models

Databases can be classified according to the theoretical data structure, referred to as a **data model**, on which it is based.

The data model used will determine the manner in which the data is stored, organised and the operations that can be performed on the database. A number of database models can be used. However, we will only briefly discuss some of the main model types, namely hierarchical, network, relational, object-oriented and multidimensional.

**(a) Hierarchical model**

The **hierarchical model** was used in early databases and, as the name indicates, the data is structured in a hierarchical (upside down tree-like) structure.

The relationship between the data records is based on a one-to-many relationship, also known as a parent/child relationship (a child can have only one parent, but a parent can have many children). This type of data structure is inflexible. Microsoft Windows Explorer is structured hierarchically, and unless we duplicate a file, a file can only be saved in one directory. See figure 2.3 for a visual representation.

![Hierarchical model](image)

**FIGURE 2.3: Hierarchical model**

**(b) Network model**

The **network model** supports many-to-many relationships, that is, data may be accessed by following several paths.

In many-to-many relationships, a child can have multiple parents and there can be relationships between children. Nowadays, the use of this model is mostly obsolete.
In a relational model, data is stored in two-dimensional rows and columns (ie tables).

A table is also known as a relation, and each database has several tables. Every table has its own primary key and the database uses this to link (relate) the table to the other tables in the database (primary key is explained in section 6.3). A table is similar to a spreadsheet with rows and columns. (Spreadsheets are discussed in topic 2). MySQL, Microsoft SQL Server and Oracle are examples of relational model databases.

A disadvantage of using this model type is that it is slower than the network and hierarchical models because it uses more processing power to query data.

Relational databases provide many advantages such as the following:

- Data can be accessed, inserted and/or deleted without changing the database structure.
- The database structure can be easily customised for most types of data storage.
- Data does not need to be duplicated.
- Most users easily understand the structure.
- It is easy to search for and extract data from the database.

Owing to its many advantages, the relational model is the most commonly used database model for business and financial databases. Relational database terminology will be discussed in section 6.3.

In an object-oriented model, the data and the operations to be performed on the data are both stored in the database. This database model can furthermore store and process a wider range of data types than only text and numerical data – it also stores and processes images, audio and video data.

This model is used for more specialised databases such as multimedia web-based applications, molecular biology databases and defence industries. Object-oriented database models are not as widely used as relational databases because they are expensive to implement, and many organisations do not need to process other data types other than numerical and text data.

A multidimensional model is similar to a relational model, but whereas a relational model stores data in a two-dimensional table, a multidimensional model stores data in a three- or more dimensional table, creating a cube-like data structure.
Data can be viewed in a spreadsheet-like format, which make it easier to understand where data with many interrelationships are stored and processed. Owing to the spreadsheet-like format, this data structure is easy to maintain. This model type is mainly used for data warehouses and makes online analytical processing (OLAP) and business intelligence software (BIS) possible. BIS will be discussed further in study unit 19.

6.2 Centralised and distributed databases

The physical location of an organisation’s databases will depend on its specific business needs and requirements. We can classify a database according to its physical storage location as either a centralised or a distributed database.

(a) Centralised database

When using a centralised database, the database is physically stored in one central location (i.e., it is on one server).

All users interact with this single database in the single location through the computer network. The benefit of using this type of database is that the database is always up to date with the latest information if online input and real-time processing are used.

(b) Distributed database

When using a distributed database, there are several interlinked databases stored in several computers in the same (e.g., headquarters) or different locations (e.g., branches).

When a distributed database is properly managed, users will not know that each person may be interacting with a database in a different location because they will all have the same view of the database. Distributed databases are either a partitioned or a replicated database.

A partitioned database is split into smaller portions (partitions) and the part applicable to the user is made available on the location closest to the user. Partitioned databases are generally used when minimal data sharing is necessary between users at the different locations. For example, an organisation with branches may use a partitioned database when its customers always only interact with that specific branch and there is thus no need for the branches to view each other’s customer databases.

In a replicated database, the whole original database is copied to the different locations, that is, the database is replicated at each location. For example, a pharmacy with countrywide branches at which customers can obtain new and repeat prescriptions at any of the branches may use a replicated database for customers. This will enable the customer to obtain a repeat prescription at any of the pharmacy’s branches without the branch needing to see the original prescription.

The different replicated databases in one network update by means of duplication or synchronisation. In duplication, the master (original) database is copied to the other locations, normally at a specific frequency and time, and will overwrite the database at the distributed locations. The database at the different locations can only be updated by
updating the master database. **Synchronisation** is more complex and time consuming and involves a two-way updating of the master database and the distributed databases (ie the master database can update the distributed database and the distributed database can update the master database). This synchronisation process normally also happens at a pre-set frequency and time. Data conflicts (ie the same data must be updated by both databases and the software needs to determine which database has the latest or correct data) are usually resolved through predetermined rules, but in some instances can also be resolved manually, that is, the user determines which is the latest version of the data.

**Activity 2.1**

One of the big four audit firms uses replicated databases for its electronic client audit files. A master database of the client audit files is created and then replicated on each audit team member’s computer. Each team member works on his or her own “replicated database” and synchronises to the master copy at a frequency determined by the audit team leader.

(a) Ask your auditor friends or family members or the auditors at your organisation if they use databases for their client audit files.
(b) Determine whether they use a centralised or a distributed database.
(c) Is the distributed database updated through duplication or synchronisation?

---

### 6.3 Relational database terminology

Because a relational database is the most commonly used database model for business and financial databases, we will look at the database terminology applicable to relational databases.

A relational database comprises several database files, each of which consists of several data records. A data record consists of several data fields, each of which contains a data value. See figure 2.4 for a schematic representation, but bear in mind that each database contains many more data files, data records and data fields than those depicted in the figure. A data record can also be updated to multiple database files.

![Database Diagram](https://via.placeholder.com/150)

**FIGURE 2.4: Simplistic database overview**
Refer to figure 2.5 in the following discussion. Each of the files shown is only an extract – the real transaction and master files contain many more data fields and data values.

FIGURE 2.5: Database terminology

(a) Data value

A data value is a character (a single number, letter or special character) or a group of related characters used to populate the data field.

The data value entered will vary from data field to data field. For example, a data value can be a number, say, 5, or a name, say, Thabo.
(b) **Data field**

A *data field* contains a data value and is the smallest unit of data that can be accessed in a database.

A data field is similar to a *cell* in a spreadsheet. The data value contained in a data field will differ from data record to data record.

Data fields can be *compulsory* (data must be entered into this field), optional (the field may be left blank if no data is entered) or calculated (the data value is not entered but automatically derived from a formula based on other data fields).

In figure 2.5, in the purchase transaction file, the data value, 4, is entered in the quantity data field for record PN10031. The Balance data fields in the supplier master file are an example of a calculated data field.

(c) **Attribute**

An *attribute*, commonly known as a column, represents one unique characteristic of a single database file.

However, an attribute can appear in more than one database file. Each attribute will have a *specific field length* (number of characters that can be entered in the field) and a *specific data type* (*numbers, characters, dates, etc*). The field length and the specific data type particular to that attribute are described in the data dictionary.

In figure 2.5, in the purchase transaction file, the attribute labelled “VAT” will include the VAT amount for each record. The “Credit limit” attribute in the supplier master file will indicate the credit limit of each supplier and the “Inventory category” attribute’s data type will be alphabetic characters only.

(d) **Field name**

All attributes have a unique name known as a *field name*, which labels the data stored in the attribute.

Field names are unique and no column (attribute) can therefore have the same name in a single database file ie an attribute with the *field name* “supplier code” will only appear once in the “supplier master file”. A *field name* can however appear in more than one database file ie an attribute with the *field name* “supplier code” can appear in both the “supplier master file” and the “purchase transaction file”.

In figure 2.5, in the purchase transaction file, “*Price per unit*” is a field name. “*Minimum order qty*” is a field name in the inventory master file.

(e) **Data record**

A *data record* is a set of logically related data fields about a single member or item.
A data record is also referred to as a “tuple” and is similar to a row in a spreadsheet. All data records of a particular database file will have the same structure – that is, it will consist of the same type of data fields that is ordered in the same order. For example, every student record in a student master file will contain a student number, first name, surname, telephone number and identification number. In figure 2.5, the data record for supplier, Forever PC, in the supplier master files contains data fields for “supplier code”, “supplier name”, “telephone”, “credit limit” and “balance”. All these data fields together are referred to as a data record.

Figure 2.5, Forever PC’s data record in the supplier master file is as follows:

<table>
<thead>
<tr>
<th>Supplier Code</th>
<th>Name</th>
<th>Telephone</th>
<th>Credit Limit</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOR001</td>
<td>Forever PC</td>
<td>+00 33 923-1426</td>
<td>95000</td>
<td>94706.81</td>
</tr>
</tbody>
</table>

(f) Primary data field

Each file has a unique data field (known as the primary data field) that can be used to uniquely identify each data record in a database file. A primary data field is also known as a primary key.

In figure 2.5, the “supplier code” (e) data field is the primary data field in the “supplier master file” and the “inventory number” data field (f) is the primary data field in the “inventory master file”.

The combination of the invoice no. (a) and the line no. (b) fields in the purchase transaction file together make a unique data field – that is, PN10029 (invoice no.) and 1 (line no.) creates a primary key namely PN100291.

(g) Foreign key

When a primary data field of a database file is entered into another database file to create a relation between the two database files, the primary data field in the other database file is known as a foreign key.

A foreign key does not uniquely identify a record and may have duplicates in a database file. The use of foreign keys prevents the duplication of data.

In figure 2.5, the “purchase transaction file” links (relates) to the “supplier master file” through the use of the “supplier code”. The “supplier code” (e) data field is the primary data field in the “supplier master file” as it uniquely identifies the supplier record but in the “purchase transaction file” the “supplier code” (c) is the foreign key as it links the two files through a primary data field. Note that there is more than one entry for supplier code “FOR001” in the purchase transaction file.

The “purchase transaction file” links (relates) to the “inventory master” file through the use of the “inventory number”. The “inventory number” field (f) is the primary data field in the “inventory master file”, but in the “purchase transaction file”, the “inventory number” (d) is known as the foreign key. The master files have been sorted in a different order, but individual data records can still be found using the unique primary keys and foreign keys.
(h) Database files

A database file, also known as a database table, is an organised collection of related data records.

Each database file contains related records – that is, the records in the database file have a common theme. There are different types of database files, namely master files, transaction files, reference files and history files.

- Master file

A master file contains data records of a relative permanent nature (ie they do not change regularly) about the organisation’s resources and subjects (ie customers, suppliers, inventory, employees, etc).

Some of the data in the master file is updated periodically by the transaction files. The master file is the most important file in the database and is the authoritative source of data. In figure 2.5, the supplier master file contains data records about all the organisation’s suppliers and the data fields in the records are relatively permanent (ie the name of the supplier and telephone number do not regularly change).

- Transaction file

A transaction file contains data records relating to the daily individual activities of the organisation (eg the organisation’s sales). A transaction file changes regularly as additional transactions are processed.

These transaction data records (ie the transaction file) are used to update or change the master file. In figure 2.5, the purchase transaction file contains data records about the organisation’s purchase transactions for June 2016, which may be used to update the balance field in the supplier’s master file.

- Reference file

A reference file is a semi-permanent file containing data records referenced to by the transaction file in order to complete a transaction.

Examples of a reference file in an accounting transaction processing systems are tax tables needed to calculate pay-as-you-earn (PAYE) or price lists referenced in order to calculate the sales price per item.

- History file

A history file contains data records about transactions completed in the past.

The data records in the history files are derived from the transaction file and are used in future queries and references. For example, the prior year purchase transactions are moved from the purchase transaction file to the purchase history file at the end of the financial year, during the year-end process.
Activity 2.2

Microsoft Access and OpenOffice Base are examples of database software. Visit the internet for the following:

(a) For Microsoft Access training programmes:
   - Type the following URL: [https://support.office.com/en-us/](https://support.office.com/en-us/)
   - Select the “Support” menu and click on “Office Training Centre”.
   - Select the “Access”.
   - Select Training “Access 2013”
   - Complete the different training options.

(b) For additional insight into database terminology and the design of a database with regard to databases:
   - Type the following URL: [https://www.microsoft.com/en-us/digitalliteracy](https://www.microsoft.com/en-us/digitalliteracy)
   - Select “Standard”
   - Select the version applicable to the operating system and Microsoft office version you are using
   - Select “Productivity programs”
   - Select the type of training program you want to follow.
   - Lesson 6 is an introduction to databases programs.

7 Factors to consider when choosing a DBMS and database

Organisations should consider a number of factors when deciding on an appropriate DBMS and database. Each factor should not be considered in isolation because factors will influence one another and some factors, such as costs, may also be a constraint for all other factors. The following are some of the factors an organisation should consider:

- The database model type used should support the requirements of the organisation – that is, a financial system might only require a relational database, but an organisation that requires online analytical processing (OLAP) needs to use a multidimensional model.
- The acquired DBMS and database should closely match the requirements of the organisation.
- The DBMS and database should be able to evolve to meet future organisational needs.
- The performance (ie reaction time) of the DBMS and database. How fast can records be updated or queried in the database?
- The cost of the DBMS and database should be considered. Can the organisation afford the DBMS and database?
- Different DBMS and databases will require different levels of specialised staff skills. Are there specialised skills available in the organisation or can the organisation acquire the skills required?
- The hardware needed to run the DBMS and database should be considered. The organisation may need to acquire hardware if it is not already available. This will have further cost implications.
- Can the DBMS and database be integrated with the rest of the organisation’s information systems?
- The database size (amount of data the database can manage) must be adequate for the organisation’s future data requirements and the database should easily be expandable.
The number of concurrent users (the number of users who can assess the database at the same time) the DBMS and database can handle should be taken into account.

- The DBMS and database vendor should be a reputable organisation and financially stable because this vendor will need to provide future support for the solution.

---

**Reflect**

Pastel uses a relational database to store a huge amount of accounting data.

Make a note that you must return to topic 1 once you have mastered Pastel (topic 6) and consider the following:

- In which files are the various types of information that are captured during each Pastel lesson stored?
- What are the field names in each file?
- Which files are master files and which transaction files? What about reference files?
- How are the various files interlinked?
- How are the various files updated with the processing of each type of transaction?

---

**Summary**

In this study unit, we learnt about the database environment, the advantages and disadvantages of using a database environment and the components of this environment. We also gained an understanding of different database models, centralised and distributed databases and the terminology used in a relational database. We dealt with the factors to consider when choosing appropriate database management software and a database. In the next study unit, we will investigate the utilisation of databases in an organisation.

---

After working through this study unit, you should be able to answer the following questions:

(a) Name the components of the database environment.
(b) List the advantages and disadvantages of using a database environment.
(c) Name and define four database environment users.
(d) List the responsibilities of the database administrator.
(e) Define database management system (DBMS).
(f) List the functions of a DBMS.
(g) Name and describe the three levels in three-level database architecture.
(h) State the two key components of the DBMS

(i) Name and describe the different database languages.

(j) Briefly explain the concept “data dictionary”. Your answer should include the data elements and the information contained in them.

(k) Define a database and data model.

(l) List and describe five database model types.

(m) Briefly discuss the advantages and a disadvantage of using a relational database model type.

(n) Identify the uses of an object-oriented database.

(o) Identify the uses of a multidimensional database.

(p) Define the terms “centralised database” and “distributed database”.

(q) Name and describe the two types of distributed databases.

(r) List and describe the two methods in which a distributed database may be updated.

(s) Define the following terms: data value, data field, field name, data record, primary data field and foreign key.

(t) When provided with a representation of a database, would you be able to identify data values, data fields, field names, data records, primary data fields and foreign keys?

(u) Define a database file and list the types of database files.

(v) For each type of database file, define the file and explain its role.

(w) List the factors to consider when choosing a DBMS and a database.

---

**Further reading**

If you are interested in further reading, the following authors discuss the database environment, components of this environment, database models and relational database terminology extensively:

- Boczko, T. 2007
- Dull, RB, Gelinas, UJ & Wheeler, PR. 2010
- Hall, JA. 2011
- Romney, MB & Steinbart, PJ. 2009
- Stair, R, Reynolds, G & Chesney, T. 2008
1 Introduction

As the efficient data and information storage and retrieval needs of organisations increased over the years, the use of databases to manage data and information has also increased. Databases are widely used in business nowadays and their utilisation can differ between organisations. In the previous study unit, we learnt about the database environment, its components and the terminology used in a relational database. In this study unit, we will briefly discuss the utilisation of databases in accounting and auditing. We will also look at the use of databases in data warehouses, data marts and data mining and online analytical processing.

2 Databases in accounting and auditing

Finance departments as well as accounting and auditing firms use accounting software to record financial transactions. Most financial software uses databases to store and retrieve financial data. For example, Pastel Partner software, which you will learn more about in topic 6, uses a relational database to store data. We will learn more about different available accounting information systems (AISs) in study unit 14.

As technology develops, the use of electronic audit files in audits has increased. These audit software applications use databases to store and retrieve data. Examples of audit software that uses databases to store data are CaseWare (http://www.cqs.co.za/caseware/) and CCH TeamMate (https://www.teammatesolutions.com).

Many auditors also use Microsoft Access or IDEA data analysis software to interrogate their clients’ operational and financial data. These interrogations may find anomalies, exceptions and trends in datasets obtained from clients, which then helps them to perform sound quality risk-based audits.
3 Data warehouse
Many organisations have multiple databases such as a database for financial information, operational information, marketing and so forth. Because these databases are not linked, it becomes difficult and extremely cumbersome to analyse data when it is needed from more than one database. Some organisations also have massive databases. Running queries on these huge databases requires a great deal of processing, which may affect operations owing to the slowness of response times. Data warehouses have been created to overcome these problems.

A data warehouse is a database populated with current and historical data extracted from the organisation's various databases. It may also contain data from external sources and/or databases.

Depending on the purpose of the data warehouse, it sometimes only contains summary information or only certain specific related data extracted from the various databases. The data warehouse is updated periodically, usually according to a predetermined frequency, from the various source databases. These updates can also happen as the source database is updated; the data warehouse is then referred to as a real-time data warehouse. Bear in mind that data cannot be modified in the data warehouse. It can only be updated by the source databases, which means that any updates to data must be done in the source database. One could therefore say that a data warehouse is “read-only”.

As you can imagine, data warehouses are massive because they contain data from various databases. Running queries on the data warehouse can be painstakingly slow because of the size of the data warehouse.

The database model types normally used for data warehouses are relational or multidimensional.

A data warehouse is interrogated using reporting and query tools that analyse the data mainly for decision making and strategic planning. A data warehouse is the backbone for data mining and business intelligence software (BIS). Business intelligence software is discussed in study unit 19.

The security and integrity of the data warehouse are crucial because the data is used for strategic and operational decisions. The data warehouse should therefore be protected against industrial espionage and incorrect information.

4 Data mart
Owing to the size of data warehouses and the resulting slow updating and querying of the data warehouse, a need arose to be able to interrogate “smaller” data warehouses. This requirement gave rise to data marts.

A data mart is a smaller data warehouse extracted from the main data warehouse and contains specific related data extracted for a specific organisational user group such as the finance department or the marketing department.

The use of data marts makes running queries much quicker than running queries on the full data warehouse.
Data mining

Data mining software is used to analyse data sets in order to uncover previously unknown trends, patterns and relationships between data.

These analyses can be used in decision making (including strategic decisions), forecasts, predicative modelling, fraud detection, risk management and so on. The data sets used in data mining are usually a data warehouse or a data mart, but data mining may also be performed on source databases. For example, an insurance company using data mining on its motorcar claims could uncover the fact that red cars with drivers younger than 25 years are more likely to be involved in an accident. The company could use this information to correctly price insurance premiums for red motorcar drivers 25 years and younger.

Examples of data mining software include RapidMiner, SAS Enterprise Miner, IBM SPSS Modeller and Orange.

Online analytical processing (OLAP)

Online analytical processing (OLAP) software enables users to interactively and rapidly analyse large data sets from various viewpoints (ie OLAP can handle multidimensional queries).

Take the following question: How many pairs of red shoes were sold per month to persons aged 20 to 30 years? The multiple dimensions used in the query were product type (shoes), product colour (red), time period (month) and age (20–30 years). Because these data sets are usually multidimensional, they are stored in a multidimensional database, although some OLAP software is also compatible with relational databases. OLAP is used in business intelligence, budgeting, forecasting, management reporting and so on. IBM Cognos Business Intelligence and Oracle Database OLAP Option are examples of OLAP software.

Similarities and differences between OLAP and data mining

OLAP and data mining are similar, but technically different. Both are business intelligence tools that complement each other, and they are used in conjunction with each other. OLAP and data mining, however, operate differently on data. OLAP is mainly used to summarise data, say, per month and per region, the number of smart phones sold to persons aged 20 to 30 years. Data mining is used to break down data in order to uncover trends, patterns and relationships. Data mining will be used to answer a question such as: What factors resulted in the increase in smart phone sales in Gauteng during September? OLAP and data mining are therefore used to answer different questions. Data mining will answer questions such as the following: Why have sales increased in Mpumalanga? or A person with what characteristics would be more likely to buy our product? OLAP is used to answer the following kind of questions: What is the value of motor accident claims for women driving green motorcars in KwaZulu-Natal by month? or What are the average sales of electric drills by month and by region?

Summary

In this study unit, we briefly examined how databases are used in accounting and auditing. We also discussed data warehouses, data marts, data mining and OLAP.
The next topic deals with how to develop and create spreadsheets to solve problems in a business and accounting context using appropriate formats, formulas and functions. We will also gain an understanding of the risks and controls associated with spreadsheets.

**Self-assessment activity**

After working through this study unit, you should be able to answer the following questions:

(a) Identify examples of the uses of databases in an accounting and auditing environment respectively.
(b) Define a data warehouse.
(c) Users can modify the data in the data warehouse. Is this statement true or false?
(d) Name a disadvantage of using a data warehouse.
(e) Identify the type of database model usually used for data warehouses.
(f) Identify the type of tools used to interrogate a data warehouse.
(g) Briefly describe a data mart.
(h) Explain why we prefer to use a data mart instead of a data warehouse?
(i) Briefly describe data mining.
(j) Identify the uses for data mining analyses.
(k) List examples of data mining software.
(l) Define OLAP.
(m) Identify a use of OLAP.
(n) Identify the type of database model usually used for OLAP.
(o) List examples of OLAP software.
(p) Briefly explain the similarities and differences between OLAP and data mining.

**Further reading**

If you are interested in further reading, the following authors discuss the use of databases in data warehouses, data marts and data mining and online analytical processing extensively:

- Dull, RB, Gelinas, UJ & Wheeler, PR. 2010
- Hall, JA. 2011
- Rommey, MB & Steinbart, PJ. 2009
- Stair, R, Reynolds, G & Chesney, T. 2008
- Wessels, P, Grobbelaar, E, Mc Gee, A & Prinsloo, C
The purpose of part 2 is to help you develop and create spreadsheets to solve problems in a business and accounting context and to understand the risks and controls associated with spreadsheets.
LEARNING OUTCOMES

After studying this topic, you should be able to

- identify and explain basic spreadsheet principles and components
- explain the spreadsheet development process
- describe the characteristics of a user-friendly spreadsheet
- apply formatting to spreadsheets
- provide the structures of spreadsheet formulas and functions
- identify the applicable spreadsheet formula or function to use when solving business and accounting problems
- apply spreadsheet formulas and functions to solve business and accounting problems
- list the inherent risks of spreadsheet software
- describe the controls to minimise or address the risks of spreadsheet software
- apply security and privacy settings to Microsoft Office Excel documents
Please note that part 2 of the study guide is based on Microsoft Office Excel 2013, and you will need to refer to the previous year study guide loaded on myUnisa for notes on Microsoft Office Excel 2007 and 2010.

**Note:** Microsoft product screen shots are reprinted with the permission of Microsoft Corporation.
Creating user-friendly spreadsheets

1 Introduction

Application software is programs that run on computer systems, which users utilise to perform specific tasks. Business applications are applications or software that help businesses to increase their productivity and users to perform specific tasks (eg they allow users to create and edit documents or reports to perform simple or complex calculations needed by the business).

Application software may consist of a single program such as a media player or a collection (often referred to as a software suite) of related but independent programs and packages that have a common user interface or shared data format, such as Microsoft Office, which consists of a closely integrated word processor, spreadsheet, database and so on. The advantages of using a software suite include the fact that all the packages have a similar look and feel, making them easy to use, information can easily be transferred between all the packages and all the packages are installed in a single operation. An example of integration between the packages included in a software suite could be the creation of a spreadsheet with complex calculations, which can then be transferred to a word processor to form part of a detailed annual financial report.
Application software can be either **off-the-shelf software** or **in-house developments**.

In this study unit, we will examine the use of spreadsheets as a business application tool, more specifically Microsoft Office Excel (MS Excel). In creating user-friendly spreadsheets, we will be looking at the basic principles of mathematics, signs/operators and components of a spreadsheet. Workbook basics will be discussed as well as operating and formatting workbooks, finishing off with printing and page layout.

2 **Basic principles to revise before working on Microsoft Office Excel**

**NOTE**

For this module, you require certain pre-existing mathematical and accounting knowledge as well as the ability to apply that knowledge. Section 2 merely emphasises some basic mathematics, accounting and suchlike knowledge that you should already have.

2.1 **Microsoft Excel signs/operators**

In some instances, Microsoft Office Excel uses different signs/operators from those usually seen in Mathematics. Always use the applicable Microsoft Office Excel signs/operators and not the Mathematical signs/operators when writing a Microsoft Office Excel formula. The table below indicates the mathematical signs/operators with their associated Microsoft Office Excel signs/operators:

<table>
<thead>
<tr>
<th></th>
<th>Mathematics</th>
<th>Microsoft Office Excel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addition</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Subtraction</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Multiplication</td>
<td>x</td>
<td>*</td>
</tr>
<tr>
<td>Division</td>
<td>÷</td>
<td>/</td>
</tr>
<tr>
<td>Equal</td>
<td>=</td>
<td>=</td>
</tr>
<tr>
<td>Brackets/parentheses</td>
<td>( )</td>
<td>( )</td>
</tr>
<tr>
<td>Greater than</td>
<td>&gt;</td>
<td>&gt;</td>
</tr>
<tr>
<td>Exponents</td>
<td>a²</td>
<td>^</td>
</tr>
<tr>
<td>Less than</td>
<td>&lt;</td>
<td>&lt;</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>&gt;=</td>
<td>&gt;=</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>&lt;=</td>
<td>&lt;=</td>
</tr>
<tr>
<td>Not equal to</td>
<td>≠</td>
<td>&lt;</td>
</tr>
</tbody>
</table>

Exam and Assignment TIP!!

Please ensure that all your formulas start with an “equal” sign for all your assignment and examination answers, **failure to do so will result in students losing marks unnecessarily!!**

Example: =SUM(A1:A5)
### Order of operation

The order of operation is the sequence of computation that a formula follows to arrive at an answer. Microsoft Office Excel uses the same order of operation as mathematical rules and it will therefore perform computations in the following sequence:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Explanation and process</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>computations/calculations in parentheses/brackets, no matter where they are in the formula</td>
</tr>
<tr>
<td>Second</td>
<td>computations with exponents</td>
</tr>
<tr>
<td>Third</td>
<td>computations involving multiplication (*) and division (/) from left to right</td>
</tr>
<tr>
<td>Fourth</td>
<td>computations involving addition (+) and subtraction (−) from left to right</td>
</tr>
</tbody>
</table>

#### Examples

10 + 10 * 5 = ? What do you think the answer would be?

Microsoft Office Excel will first calculate 10 * 5 = 50 and then add the 10 to the answer, that is, 10 + 10 * 5 = 60

How do you write the formula if you want Microsoft Office Excel to first add the two 10s together and then multiply the answer by 5? What do you think? According to the order of operation, we know Microsoft Office Excel will first perform computations in brackets/parentheses. By inserting the 10 + 10 in parentheses, Microsoft Office Excel will calculate the amount and then multiply the answer by 5 because multiplication is third in the sequence and after parentheses. Your formula will thus change to (10 + 10) * 5 = 100

In which order would Microsoft Office Excel perform this formula?

150 + 150 / (2 + 12) * 12 / 4 = 182.14

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Formula</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st</td>
<td>(2 + 12) = 14</td>
<td>Computation/calculations in parentheses/brackets, no matter where they are in the formula.</td>
</tr>
<tr>
<td>2nd</td>
<td>150 / 14 = 10.714</td>
<td>Computation involving multiplication (*) and division (/) from left to right. The 14 relates to the answer calculated in the 1st sequence.</td>
</tr>
<tr>
<td>3rd</td>
<td>10.714 * 12 = 128.568</td>
<td>Computation involving multiplication (*) and division (/) from left to right. The 10.714 relates to the answer calculated in the 2nd sequence.</td>
</tr>
<tr>
<td>4th</td>
<td>128.568 / 4 = 32.142</td>
<td>Computation involving multiplication (*) and division (/) from left to right. The 128.568 relates to the answer calculated in the 3rd sequence.</td>
</tr>
<tr>
<td>5th</td>
<td>150 + 32.142 = 182.142</td>
<td>Computation involving addition (+) and subtraction (−) from left to right. The 32.142 relates to the answer calculated in the 4th sequence.</td>
</tr>
</tbody>
</table>
Calculation activity 4.1

Using the examples below, recalculate each formula and compare your answer with the answer provided. Keep trying, by using the order of operation in 2.2 until you find the same answer.

\[
100 + 100 / 2 = 150 \quad (100 + 100) / 2 = 100
\]

\[
25 * 4 / 2 + 10 = 60 \quad 25 * 4 / (2 + 10) = 8.333
\]

\[
150 + 150 / 2 + 12 * 12 / 4 = 261 \quad (150 + 150) / 2 + 12 * 12 / 4 = 186
\]

\[
(150 + 150) / (2 + 12) * 12 / 4 = 64.29
\]

2.3 Changing the sign of an amount

To change the sign of an amount from a positive to a negative, or from a negative to a positive, the amount can be multiplied by -1. For example; +50 * -1 = -50 and -100 * -1 = +100.

2.4 Percentages (%)

If a whole cake is equal to 100% and you and 4 friends need to share it equally, each one of you will receive 20% of the cake. How did we calculate this? 1 person/5 persons, that is, \(1/5 = 0.2\) or 20%.

A percentage is a fraction in which one (1) equals the whole or 100%. In Microsoft Office Excel and mathematics, \(1 = 100\% (100 / 100 = 1)\). Everything less than 1 (but more than 0), is a % thereof. Please use the applicable fraction when working with percentages in Microsoft Office Excel. For example:

<table>
<thead>
<tr>
<th>% in numerical format</th>
<th>How to write it in Microsoft Office Excel</th>
</tr>
</thead>
<tbody>
<tr>
<td>33.33%</td>
<td>0.3333</td>
</tr>
<tr>
<td>100%</td>
<td>1</td>
</tr>
<tr>
<td>14%</td>
<td>0.14</td>
</tr>
</tbody>
</table>

When you see a cell on a spreadsheet reflected as a percentage, always remember that the underlying value of the cell is still a fraction. The format of the cell (see section 8.1 in this study unit) was only changed to display the fraction as a percentage, but the underlying value did not change – that is, the underlying value of the fifty percent (50%) in the cell is 0.50. When you use a cell displaying a percentage format in any of your formulas/functions, **DO NOT multiply or divide the value by 100.**

2.5 Working with VAT percentage, gross profit percentage and mark-up

You are expected to be able to calculate amounts both inclusive and exclusive of VAT, as well as the VAT amount itself, by using the applicable VAT percentage. You should also be able to calculate sales amounts, cost of sales and gross profit, mark-up and gross profit percentage. You can use the following formula, or any other formula you are comfortable with, to help you with these calculations:

**Formula: VAT, GROSS PROFIT (GP) and MARK-UP PERCENTAGES**

Basic principles:

- Sales price **excluding VAT** + VAT = sales price **including VAT**
EXAMPLE 1: VAT

<table>
<thead>
<tr>
<th></th>
<th>R</th>
<th>%</th>
<th>Microsoft Office Excel underlying value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selling price (excluding VAT)</td>
<td>500</td>
<td>100</td>
<td>1.00</td>
</tr>
<tr>
<td>VAT</td>
<td>70</td>
<td>14</td>
<td>0.14</td>
</tr>
<tr>
<td>Selling price (including VAT)</td>
<td>570</td>
<td>114</td>
<td>1.14</td>
</tr>
</tbody>
</table>

Calculate the **selling price excluding VAT**, using the selling price including VAT and the VAT percentage.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 1.00 (you need to calculate the selling price excluding VAT).
- The amount you have in % = 1.14 (you have the selling price including VAT).
- The amount you have in R = R570 (you have the selling price including VAT in rand).
- \( \frac{1.00}{1.14} \times R570 = R500. \)

*(Using mathematical rules, this formula can be simplified to \( R570/1.14 = R500 \).)*

Calculate the **selling price including VAT** using the selling price excluding VAT and the VAT %.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 1.14 (you need to calculate the selling price including VAT).
- The amount you have in % = 1.00 (you have the selling price excluding VAT).
- The amount you have in R = R500 (you have the selling price excluding VAT in rand).
- \( \frac{1.14}{1.00} \times R500 = R570. \)

*(Using mathematical rules, this formula can be simplified to \( 1.14 \times R500 = R570 \).)*

Calculate the **VAT amount** using the selling price including VAT and the VAT %.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 0.14 (you need to calculate the VAT amount).
- The amount you have in % = 1.14 (you have the selling price including VAT).
- The amount you have in R = R570 (you have the selling price including VAT in rand).
- \( \frac{0.14}{1.14} \times R570 = R70. \)

Calculate the **selling price including VAT** using the VAT amount and the VAT %.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 1.14 (you need to calculate the selling price including VAT).
- The amount you have in % = 0.14 (you have the VAT%).
- The amount you have in R = R70 (you have the VAT amount in rand).
- \( \frac{1.14}{0.14} \times R70 = R570. \)
The business world uses the terms “mark-up” and “gross profit margin” interchangeably, although there are differences between the two.

**Mark-up**, like **gross profit**, is the difference between the selling price and cost price of an item.

**Mark-up** may be expressed either as a Rand amount or as a percentage. If an item has a cost price of R100 and it sells for R150, then the mark-up is R50 (i.e. R150 less R100) if it is expressed in rand.

The mark-up margin of the item would be 50% (selling price [R150] minus cost [R100] divided by cost price [R100] of the item) if it is expressed as a percentage.

**Gross profit margin**, however, is calculated as the difference between the selling price and cost price of an item, divided by the selling price of the item. Thus, as in the example above, the gross profit margin of the item would be 33% (selling price [R150] minus cost [R100], divided by selling price [R150] of the item), which is expressed as a percentage.

**Basic principles:**

- Gross profit or mark-up = sales – cost of sales
- Sales = cost of sales + gross profit or mark-up
- Mark-up margin (%) = mark-up/cost of sales
- Gross profit margin (%) = gross profit/sales

**EXAMPLE 2: Mark-up and mark-up margin**

The mark-up margin (percentage) in this example is 20%.

<table>
<thead>
<tr>
<th></th>
<th>R</th>
<th>%</th>
<th>Microsoft Office Excel underlying value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost of sales</td>
<td>1,580</td>
<td>100</td>
<td>1.00</td>
</tr>
<tr>
<td>Mark-up</td>
<td>316</td>
<td>20</td>
<td>0.20</td>
</tr>
<tr>
<td>Sales</td>
<td>1,896</td>
<td>120</td>
<td>1.20</td>
</tr>
</tbody>
</table>

**Calculations: MARK-UP AND MARK-UP MARGIN**

Calculate the **cost of sales amount**, using the sales amount of R1,896 and the mark-up margin.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 1.00 (you need to calculate the cost of sales).
- The amount you have in % = 1.20 (you have the sales).
- The amount you have in R = R1,896 (you have the sales amount in rand).
- 1.00/1.20 * R1,896 = R1,580.

(Using mathematical rules, this formula can be simplified to R1,896/1.20 = R1,580.)
Calculate the **sales amount**, using the cost of sales amount of R1,580 and mark-up margin.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 1.20 (you need to calculate the sales amount).
- The amount you have in % = 1.00 (you have the cost of sales).
- The amount you have in R = R1,580 (you have the cost of sales amount in rand).
- \( \frac{1.20}{1.00} \times R1,580 = R1,896. \)

*(Using mathematical rules, this formula can be simplified to \( R1,580 \times 1.20 = R1,896. \)*

Calculate the **mark-up amount**, using the sales amount of R1,896 and mark-up margin.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 0.20 (you need to calculate the mark-up amount).
- The amount you have in % = 1.20 (you have the sales).
- The amount you have in R = R1,896 (you have the sales amount in rand).
- \( \frac{0.20}{1.20} \times R1,896 = R316. \)

Calculate the **sales amount**, using the mark-up amount of R316 and mark-up margin.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 1.20 (you need to calculate the sales amount).
- The amount you have in % = 0.20 (you have the mark-up margin).
- The amount you have in R = 316 (you have the mark-up amount in rand).
- \( \frac{1.20}{0.20} \times 316 = R1,896. \)

**EXAMPLE 3: Gross profit and gross profit margin**

The gross profit % in this example is 20%.

<table>
<thead>
<tr>
<th>R</th>
<th>%</th>
<th>Microsoft Office Excel underlying value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost of sales</td>
<td>2,000</td>
<td>80</td>
</tr>
<tr>
<td>Gross profit</td>
<td>500</td>
<td>20</td>
</tr>
<tr>
<td>Sales</td>
<td>2,500</td>
<td>100</td>
</tr>
</tbody>
</table>
Calculations: GROSS PROFIT AND GROSS PROFIT MARGIN

Calculate the **cost of sales amount**, using the sales amount of R2,500 and the gross profit %.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 0.80 (you need to calculate the cost of sales).
- The amount you have in % = 1.00 (you have the sales).
- The amount you have in R = R2,500 (you have the sales amount in rand).
- \( \frac{0.80}{1.00} \times R2,500 = R2,000. \)

*(Using mathematical rules, this formula can be simplified to 0.80 * R2,500 = R2,000.)*

Calculate the **sales amount**, using the cost of sales amount of R2,000 and gross profit %.

The amount you need in rand = the amount you need in % / the amount you have in % * the amount you have in rand.

- The amount you need in % = 1.00 (you need to calculate the sales amount).
- The amount you have in % = 0.80 (you have the cost of sales).
- The amount you have in R = R2,000 (you have the cost of sales amount in rand).
- \( \frac{1.00}{0.80} \times R2,000 = R2,500. \)

*(Using mathematical rules, this formula can be simplified to R2,000/0.80 = R2,500.)*

3 How to solve a problem in Microsoft Office Excel

Here are a few simple guidelines to keep in mind, before you start with your spreadsheet:

- Understand the business problem you are dealing with. What is the problem? What should I calculate? What is it based on? Which amounts do I have? What assumptions should I make?
- How will you solve/fix the problem? Formulate your desired results.
- Plan your spreadsheet before you create it in Microsoft Office Excel.
- Now go to Microsoft Office Excel and prepare the spreadsheet in such a way that it will give you the required output/deliverable.
- Use neighbouring columns and rows when organising your information.
- Do not skip columns or rows just because you want to spread the information. Use the formatting functions instead.
- Use a single column at the left of the table for row headings.
- Use a single row at the top of the table for column headings.
- If your table requires a title, put it in the row above the column heading and in the same column as the row heading.
- Put all your assumptions/variables on the face of your spreadsheet. As far as possible, do not hard code any formulas, such as entering an amount or percentage in a formula. Instead, refer to a cell where the amount or percentage is displayed.
- Build in checks and balances where possible to ensure that the spreadsheet you created, functions correctly.
- Keep the spreadsheet logical.
4 Using Microsoft Office Excel: regional settings

PLEASE NOTE

For reporting purposes, one should adhere to ISO31-0 (International Organisation for Standardisation) used in South Africa, where the thousands separator is a space (" ") and the decimal separator is a comma (,).

For example: 8 355 214
1 234,81
R 235 789,19

However, when using Pastel Accounting and spreadsheets (Microsoft Office Excel or OpenOffice Calc) for AIN2601 purposes, you will need to ensure that your computer’s regional settings are set up as follows to ensure standardisation of spreadsheet formulas and functions:

- Click on the Microsoft Start icon at the bottom left-hand corner of the computer screen and then click on Control Panel.
- In the Control Panel Window locate “Region and Language” settings

- Select the Formats tab, make sure that the Current Format is English (South Africa) and then click on the Apply button (bottom right corner).
- On the **Formats** tab, click on “Additional settings” button

![Additional settings...]

- On the **Numbers** tab ensure that the options are selected as follow, then click **Apply**

![“Decimal symbol” should be a decimal point/full-stop]

![“Digit grouping symbol” should be a comma,]

![“List separator” should be a comma,]

![Apply]
• On the **Currency** tab options ensure that the options are selected as follow, then click **Apply**

![Currency tab options](image)

“**Decimal symbol**” should be a decimal point/full-stop/period .

“**Digit grouping symbol**” should be a comma ,

• After changing the **Decimal symbol**, **Digital grouping symbol** and **List separator** according to the instructions above, click on the **Apply** button for these settings to take effect.

In AIN2601, **numbers** and **currency** will be formatted as follows:

For example:  
8,355,214  
1,234.81  
R 235,789.19

**Note:** The reason for the above deviations from the accepted standard used in South Africa as mentioned above, is to

• ensure the standardisation of spreadsheet formulas and functions in this course
• increase the user friendliness of spreadsheets (eg the displayed amounts are easier to read)

See section 8 in this study unit for worksheet and cell formatting.
PLEASE NOTE

If information is used for most formal reporting purposes, the above-mentioned ISO standard should be used.

BEFORE CONTINUING, NOTE THE FOLLOWING!

You should perform all the activities included in this study unit to familiarise yourself with Microsoft Office Excel. By performing these activities, you will learn the basics of Microsoft Office Excel. You will need to know these basics when commencing the subsequent study units in this topic because this information will not be discussed in detail later on.

Note: These are not manual exercises. You actually need to do them on a computer!

5 Background

5.1 What is a spreadsheet

A spreadsheet is a grid of columns and rows that cross (intersect), much like a chessboard. Columns appear vertically and are identified by a letter (say, A, B, C, etc), while rows appear horizontally and are identified by a number (say, 1, 2, 3, etc).

Where a column and a row intersect, a cell is formed. Each cell has a unique cell reference (address) based on the specific column and row in which it can be found. A cell’s reference is always expressed as first the column reference and then the row reference. Cell B6, for example, refers to a cell found where column B and row 6 intersect. B6 is known as a cell reference. A cell reference can never change, but the data value entered in a cell can change.
5.2 Components and layout of a spreadsheet

When working in Microsoft Office Excel, you can have many files or workbooks. Each file can have many separate sheets called worksheets. These worksheets are identified as Sheet1, Sheet2, Sheet3 and so on. (Since the terms "workbook" and "file" mean the same thing, you can use either term when working with spreadsheets.)

The most recognisable difference between a word-processing document and a spreadsheet is that the spreadsheet uses rows and columns. Numerical data entered into a spreadsheet is easier to read, understand and manipulate when presented in rows and columns. Another major advantage of using a spreadsheet is that complicated calculations can be done with the use of formulas and functions, whereas this is not possible in a word processing document.

Below is a typical Microsoft Office Excel 2013 spreadsheet layout:
5.3 A selection of the spreadsheet components

A selection of the spreadsheet components will now be explained in more detail.

(a) Active cell
A cell becomes active when you select/click on that cell. The active cell is outlined in black (see A1 above), the headings for the column and the row in which the cell is located are also highlighted. In the example above, a cell in column A row 1 was selected. The headings in column A and row 1 are highlighted, and cell A1 is outlined. The cell reference of the active cell (A1 in this example), will also appear in the Name Box (see the upper-left corner of the worksheet). Note that anything you type or any function you insert will be entered or inserted into the active cell.

(b) Ribbon
The Ribbon contains tabs on which items are organized in groups of related tools.

- **Tabs.** In a default setup the eight tabs (File, Home, Insert, Page Layout, Formulas, Data, Review and View) each represent core tasks in Excel. The commands on the Home tab are those that Microsoft identified as the most commonly used when you do basic tasks in worksheets. The File tab will open a menu with commands used to open, save, print, share and close your workbooks/files. Options included in the File tab menu, will give you access to set options.
- **Ribbon Groups.** Each tab contains a set of ribbon groups with related controls. Example: “Font” and “Alignment” ribbon groups in the “Home” tab.
- **Commands.** Commands are specific icons within each of the ribbon groups, these icons are displayed in picture format to help you to easily recognise the command you want to use. Each icon performs a particular command when you click on it with the mouse. *(Hint: Hovering with your mouse pointer over an icon/command, will make the description of the icon appear.)*

The current commands on the Ribbon are the commonly used ones and user specific. Not all commands functions will displayed each time you work on Excel, but are displayed on the working screen depending on the functions being performed at a particular point in time. For example, if your worksheet does not
have a chart, the commands needed to work with charts, are not visible. However, once a chart has been created, the Chart Tools will then appear, with two tabs: Design and Layout.

Do not worry if all the commands are not visible all the time because they will appear as soon as you have taken the first step.

(c) Dialog Box Launcher

The Dialog Box Launcher is an arrow-like icon located at the lower-right corner of some of the Ribbon Groups, the icon signify the fact that within that particular ribbon group there are more options available for that group. When you click on the arrow with your mouse, it will open a dialog box or a task pane.

(d) Quick Access Toolbar

The commands on the Quick Access Toolbar are always visible. You can add commands you often use, to this toolbar by right-clicking on the command/icon you want to add and click on Add to Quick Access Toolbar. To remove a button from that toolbar, right-click the button on the toolbar, and click Remove from Quick Access Toolbar.

(e) Formula Bar

The formula bar is used to enter any applicable function to perform any particular calculation(s). Excel has a number of embedded calculation such as: PMT, FV, SUM etc. which can be accessed by clicking on the fx icon (located just before the formula bar)
6 Workbook basics

We will now take you through various activities to help you understand workbook basics.

6.1 Starting a workbook

You will be able to start working with Microsoft Office Excel by following these steps:

**Computer Activity 4.2**

- Click on the Windows start icon/button.
- Select *All Programs*.
- Select *Microsoft Office 2013*.
- Select *Excel 2013*.

OR

- Select the Excel 2013 shortcut icon from your computers’ desktop if it is visible.

The Microsoft Office Excel window with a full size workbook window will open. The workbook will be displayed in the same way as discussed under the layout of the workbook. The workbook will contain a file titled “Book 1”.

---

68
6.2 Saving a file

**Computer activity 4.3**

- Click on the **File** tab.
- This will open Save As menu options.
- Click on the **Save As** option.

- Select the preferred folder you which you wish to save your document, in most instances you will save your document in “My Documents” folder.
- Type the name of the file (“Test01”) into the **File name** field, which is beside **File name**. (You will be typing over/replacing the default file name Book1.xlsx.).
- On the “**Save as type**” drop-down list, select the “Excel Workbook” option.
- Click on **Save** button.

**PRACTICAL HINTS:**

- Create separate folders (in a logical place), for example, create a folder for all your AIN2601 files.
- Use descriptive file names.
- When creating a file, consider its compatibility with the Excel versions used by other users to whom you would like to send the file or with whom you would like to share the file.
6.3 Close a file and exit Microsoft Office Excel

(a) Closing an active Excel file while Microsoft Office Excel is still open.

Computer activity 4.4

- Click on the Excel Icon

- Then click on Close button to close the worksheet

Excel will then display the below warning message asking you to choose appropriate option between Save, Don’t Save and Cancel. Click on

- Save – Excel will save all the activities performed on the file you wish to save.
- Don’t Save – Excel will not save any activities performed after any preceding saved activities.
- Cancel – In case you changed your mind about saving the file, Excel allows you the cancel opportunity and subsequently continue working on the file.

Please take note that instead of “Book1.xlsx”, the actual name of your file will be displayed (which in this case is “Test01”).
(b) Closing the active Excel file as well as Microsoft Office Excel via Shortcut option

**Computer activity 4.5**

- Click on the close icon at the top-right corner of the file
- Select the appropriate option of action you wish to take: **Save**, **Don’t Save** or **Cancel**.

![“Close” shortcut]

**NOTE**

Always ensure that you click “**Save**” option to save the changes you have made (i.e. if you wish to keep the changes).

Before you start the next section, start Microsoft Office Excel and open the existing workbook file, “Test01”.

6.4 Naming/renaming worksheets

**Computer activity 4.6**

- On the Sheet tab bar, right-click on the sheet tab for **Sheet1**.
- Click on **Rename, Sheet1** will now be highlighted.
- Type the name “**test**” to rename Sheet1 to “test”.
- Press **Enter** on the keyboard.

![Shortcut option]

- Double click on **Sheet1**.
- Type the name “**test**”.
- Press **Enter**.
6.5 Inserting additional worksheets

**Computer activity 4.7**

- Click on the Home tab.
- In the Cells group, click on the arrow below Insert.
- On the drop-down menu click on Insert Sheet.

A new Worksheet, called Sheet1 or Sheet2 or Sheet3, will be added to your workbook.

**Shortcut options**

- Place your cursor on “Sheet1/2/3” and right click.
- Click on “Insert” option and select to add a new worksheet

OR

- Click on “New sheet” icon to add new worksheet

OR

- Click on (Shift+F11) on the keyboard
6.6 Inserting columns or rows

To insert a single column, click on any cell in the column immediately to the right of where you want the new column to be inserted, and click on the applicable command.

**Computer activity 4.8**

- On the sheet named “test”, enter “Old column B” in cell B1 and “Old column C” in cell C1.
- Click and highlight the whole of column C.
- Click on the Home tab.
- In the Cells group, click on the arrow below Insert.
- On the drop-down menu click on Insert Sheet Columns.

The spreadsheet will now appear as follows:
To insert a single row, click on any cell in the row immediately below where you want the new row to be inserted, and click on the applicable command.

**Computer activity 4.9**

- On sheet 2, enter “Old row 2” in cell A2 and “Old row 3” in cell A3.
- Click on any cell in row 3 (e.g. A3).
- Click on the Home tab.
- In the Cells group, click on the arrow below Insert.
- On the drop-down menu, click on Insert Sheet Rows.

The spreadsheet will now appear as follows:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Old row 2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Old row 3</td>
<td></td>
</tr>
</tbody>
</table>

---

**6.7 Deleting worksheets**

**Computer activity 4.10**

- Click on sheet 2/3/4 (the worksheet you want to delete).
- Click on the Home tab.
- In the Cells group, click on the arrow below Delete.
• Click on **Delete Sheet**. The selected sheet will then be deleted.

**Shortcut option**

• Click on the tab of the sheet you wish to delete.
• Right click and select **Delete** to delete the selected sheet.
6.8 Deleting columns or rows

To delete a single column, click on any cell in that column and click on the applicable command.

**Computer activity 4.11**

- On the sheet named “test”, click on any cell in column C.
- Click on the Home tab.
- In the Cells group, click on the arrow below Delete.
- On the drop-down menu, click on Delete Sheet Columns.
- The spreadsheet will now appear as follows:

```
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Old column B</td>
<td>Old column C</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

To delete a single row, click on any cell in that row and click on the applicable command.

**Computer activity 4.12**

- On sheet 2, click on any cell in row 3.
- Click on the Home tab.
- In the Cells group, click on the arrow below Delete.
- On the drop-down menu, click on Delete Sheet Rows.
- The spreadsheet will now appear as follows:

```
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Old row 2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Old row 3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
6.9 Moving around in a spreadsheet

Besides using the mouse to move around in a spreadsheet, the following keyboard keys can also be used:

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + HOME</td>
<td>Move the active cell to A1.</td>
</tr>
<tr>
<td>CTRL + END</td>
<td>Move the active cell to the last used cell (right bottom) in the worksheet.</td>
</tr>
<tr>
<td>END + →</td>
<td>Move to the last column.</td>
</tr>
<tr>
<td>END + ↓</td>
<td>Move to the last row.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Move one screen up.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Move one screen down.</td>
</tr>
<tr>
<td>F5</td>
<td>Allows you to specify the cell reference to go to</td>
</tr>
</tbody>
</table>

6.10 Selecting a worksheet range

To select a worksheet range, you need to anchor the cell pointer in the cell which will form the starting point of the range and then select the required range.

**Computer activity 4.13**

- Click in Cell A1
- Press and hold the mouse button (left button) in Cell A1.
- While holding down the mouse button, drag across the worksheet to Cell F6.
- Release the mouse button.
- The address of the range you have just highlighted is A1:F6.
7 Operating the workbook

7.1 Entering data

(a) **Entering numbers**

**Computer activity 4.14**

- Click in Cell A1.
- Enter the numbers "12345678".
- Press **Enter**.

(b) **Entering text**

If the first character you enter is a letter, Microsoft Office Excel automatically precedes the entry with a label-prefix character ('). If you wish to enter numbers as a label, you should start your entry with a label-prefix character ('). For example, if 007 is entered as a number, it will display as 7, but if it is entered with a label-prefix character ' and thereafter enter/type “007”, it will be displayed as 007.

**Computer activity 4.14 (contd):**

- Click in Cell A2.
- Enter the text “Spreadsheet”
- Click in Cell C2.
- Enter the value “50 000” as a label.
- Press **Enter**.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12345678</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Spreadsheet</td>
<td>50 000</td>
<td></td>
</tr>
</tbody>
</table>

7.2 Editing data

Data can be corrected in two stages:

(a) **Correcting errors while data is being entered**

**Computer activity 4.15**

- Click in Cell A5.
- Enter the text “**DECENBER**” (do not press Enter).

You realise you have misspelt the word **DECEMBER**.

- Click with the mouse pointer to the left of the character N.
- Press the **Delete** key.
- Type the character M.
- Confirm the entry by pressing **Enter** on the keyboard.
(b) Correcting errors after data has been entered

**Computer activity 4.16**

- Click in Cell A6.
- Enter the text “DECEMBER”.
- Confirm the entry by pressing Enter on the keyboard.

You realise that you have misspelt the word DECEMBER.

- Double click with the mouse pointer on the word or press F2.
- Click with the mouse pointer to the left of the character N.
- Press the Delete key.
- Type the character M.
- Confirm the entry by pressing Enter on the keyboard.

---

**7.3 Removing data**

**Computer activity 4.17**

- Click in Cell A1.
- Select range A1:J10 with the mouse.
- Press the Delete key on the keyboard.

---

**7.4 Copying data**

**Computer activity 4.18**

- Click in Cell A1.
- Type the text JANUARY.
- Click in cell A2.
- Type the text FEBRUARY.
- Select range A1:A2 with the mouse.
- Click on the Home tab
- In the Clipboard group, click on Copy.
• Click on C1, the destination cell to which the information will be copied to.
• Click on the Home tab.
• In the Clipboard group, click on Paste.

• The data is copied to the new destination and will appear as follows:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>JANUARY</td>
<td>JANUARY</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>FEBRUARY</td>
<td>FEBRUARY</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When you copy data, you will not remove the data from the cell, but merely make a copy. The copy will be pasted in another location and the original data will still be displayed on the original place. When the contents of the cell have been pasted, it overwrites the existing cell content where it was pasted.

**Shortcut options**

• **Copy:** Press CTRL + C simultaneously.
• **Paste:** Press CTRL + V simultaneously.

7.5 Moving/Cutting of text

**Computer activity 4.19**

• Select range A1:A2 with the mouse.
• Click on the Home tab.
• In the Clipboard group, click on Cut.

• As soon as “Cut” is clicked, the data to be cut will be highlighted by the green-dotted-box (see below).
Note: The range contents will be placed on the **CLIPBOARD**, which is a temporary storage area.

- Click on E1, the destination cell.
- Click on the **Home** tab.
- In the **Clipboard** group, click on **Paste**.
- The data is moved to the new destination and will look like this:

![Excel screenshot showing data moved from E1 to another cell]

**Note:** When you cut data, you will remove the data from the original cell and paste it in the selected (new) location. When the contents of the cell have been pasted, it overwrites the existing cell contents.

**Shortcut options**

- Cut: Press CTRL + X simultaneously.
- Paste: Press CTRL + V simultaneously.

---

### 8 Workbook and cell formatting

Every time a new file is created, the default setting is applicable. If you exit the program and return to it, the settings in the dialog will be the default settings.

#### 8.1 Cell formatting

The best way to understand the way these settings work is to enter data in a range and see what happens if the settings in the dialog box are changed. You can either use an icon on the **Home** tab in the **Fonts**, **Alignment** and **Number** groups, or click on the **Dialog Box Launcher** in one of these groups to open the **Format Cells** dialog box shown on the right.

Using your mouse to right click on a cell and selecting **Format Cells**, will also open this dialog box.

We will now cover the more frequently used formatting options.
Computer activity 4.20

- Open a New Workbook and name it “Formatting exercise”

*Do not change any of the columns’ widths before being instructed to do so.*

- In cell A1, enter “Microsoft Excel Formats”.
- In cell A2, enter “JANUARY”.
- In cell A3, enter “Format cells”.
- In cell B2, enter 100000.
- In cell B3, enter 50000.
- In cell B5, enter 0.02.
- In cell B6, enter 2.
- In cell C2, enter 80000.
- In cell C3, enter 6500.54.

We will now use the “Formatting exercise” file to perform computer activity 4.20 to cover the more frequently used formatting options.

(a) Number formatting

Computer activities 4.20 (continued)

Use number formatting to differentiate one kind of numeric data from another for example, currency (R), percentage (%) and so forth. There are different ways to access the different options needed.

- Using your “Formatting exercise” file.
- Select cell B2.
- Click the Home tab and locate the Number ribbon group option.
- Change the current B2 number style to the comma style by clicking the Comma Style icon.
- Still in the Number ribbon group, click on the drop-down arrow next to the Accounting Number Format icon, and then select R English (South Africa) option.
Number formatting – continued

- Select cell C2.
- Click on the Home tab on the Ribbon.
- In the Number group, click on the Dialog Box Launcher arrow. This will open the Format Cells dialog box.
- Select the Number tab.
- Under Category, select Number.
- Select three decimal places, tick the 1 000 separator and leave the negative numbers on the first option (-1,234.210).
- Select OK to change the format.
- Select cell C3.
- Right click on your mouse and select Format Cells.
- Select the Number tab.
- Under Category, select Number.
- Under Symbol, select: $ English (United States).
- Select one decimal place and leave the negative numbers on the first option (-$1,234.1).
- Select OK to change the format.
- Select cell B5.
- Click on the Home tab on the Ribbon.
- In the Number group, click on Percent Style icon.
- Select cell B6.
- Click on the Home tab on the Ribbon.
- In the Number group, click on the Dialog Box Launcher arrow. This will open the Format Cells dialog box.
- Select the Number tab.
- Under Category, select Percentage.
- Select two decimal places.
- Click on OK.

Did cell B5 or B6 reflect 2% after the Percent Style format was applied to it?

Take note that cell B5 value was entered as 0.02

It is VERY important to remember that the underlying value of any cell formatted as a (%), is a fraction - that is, in this instance, the underlying value of cell B5 is 0.02 and not 2, and the underlying value of cell B6 is 2, and not 200. See section 2.4 in this study unit.

(b) Alignment of data

Computer activities 4.20 (continued)

This will give you various options in Text alignment, Text control and Text direction.

Merge combines the selected cells into one cell.

- On your Formatting exercise file, select range A1:C1.
- Click on the Home tab on the Ribbon.
- In the Alignment group, click on the arrow next to Merge & Centre.
On the drop-down menu, select **Merge & Centre**.

![](image)

**Wrap text** makes all the contents in a cell visible, displaying it on multiple lines.

- Select range A2:A3.
- Click on the **Home** tab on the **Ribbon**.
- In the **Alignment** group, click on the **Wrap text** icon.

### (c) Changing fonts and attributes

Under the **Font** group, you will see some of the following default settings for the workbook (your default settings may differ from what is shown below):

- **Font name**: Arial
- **Font style**: Regular
- **Size**: 10
- **Colour**: Automatic
- **Underline**: None

Under this group, you can change any of the above-mentioned settings and add bold, italics and underlining to the text.

#### Computer activities 4.20 (continued)

- On your **Formatting exercise** file, select cell A1.
- Click on the **Home** tab on the **Ribbon**.
- In the **Font** group, click on the arrow next to the **Font** box.
- On the **Font** drop-down menu, select **Comic Sans MS**.
- In the **Font** group, click on the arrow next to the **Font size** box.
- On the drop-down menu, select **12**.
- In the **Font** group, click on the **Bold** icon.
- Select range A2:C6.
- In the **Font** group, click on the **Dialog Box Launcher** arrow. This will open the **Format Cells** dialog box.
- Select the **Font tab**.
- Under **Font**, select Arial.
- Under **Size**, select 11.
- Select **OK** to change the format.

![](image)

84
(d) Creating Borders

You can frame the data with borderlines and different edges

Computer activities 4.20 (continued)

- On your Formatting exercise file, select cell B3.
- Click on the Home tab.
- In the Font ribbon group, click on the arrow next to the Border icon.
- On the drop-down menu (shown above), select the Bottom Double Border icon.
- Select cell C3.
- Click on the Home tab on the Ribbon.
- In the Font group, click on the arrow next to the Border icon.
- On the drop-down menu, select the Top and Double Bottom Border icon
(e) **Changing Filing and Font colours.**

- Here you can set the background and/or font colour and pattern of the cells selected.
- These settings can be changed on: **Home tab/ Font ribbon group**

(Do not change any of these for this activity.)

(f) **Protection and security settings**

Here you can lock cells, so that they cannot be changed when a worksheet is protected.

(Do not change any of these for this activity.)

Protection and spreadsheet security will be dealt with in detail in study unit 6

**Feedback on activity 4.20**

- Your results for activity 4.20 should appear as follows:
8.2 Column width

The column width should be set to fit the largest set of characters in a cell. If you see the following in a cell ####### (hashes), it means the column width is too small to fully display all the contents of the cell. Example

There are two ways of correcting this problem:

- Using an icon/command
  - Click on the Home tab on the Ribbon.
  - In the Cells group, click on the arrow below the Format icon.
  - Click on the Column Width and increase the column width until the data appears.

- Using the mouse
  - Move the mouse pointer to the borderline between column “B” and column “C”.
  - The mouse pointer then changes to a cross-like icon with a two-headed vertical arrow.
  - Then double click on the borderline to increase the column width OR
  - Click and drag to the right to increase the width of the column (while still holding in the mouse button), or to the left to decrease the column width.

The data will now be displayed without hashes.

8.3 Row height

The row height should be set to fit the largest set of characters in a cell. If you cannot see all the text in a cell, it means the row height is too small. For example:

There are two ways to correct this problem:

- Using an icon/command
  - Click on the Home tab on the Ribbon.
  - In the Cells group, click on the arrow below the Format icon.
  - On the drop-down menu, select Row Height and increase the row height until the data appears.
Using the mouse

- Move the mouse pointer to the number “1” of the row header.
- Point to the bottom of the row border.
- The mouse pointer changes to a cross-like icon with a two-headed horizontal arrows.
- Click the mouse and drag down to increase the height of the row (while still holding in the mouse button) or drag upwards to decrease the row height OR
- Double click the mouse to fit the largest data cell.

The data will now be displayed in full.

9 Printing and page layout

9.1 Print area

This defines/selects the area of a worksheet you want to print. Always define the area you want to print before you continue with the rest of the page setup (see section 9.2 in this study unit).

Computer activity 4.21

- Select the area you want to print (as you would select a range).
- Click on the Page Layout tab on the Ribbon.
- In the Page Setup ribbon group, click on the arrow below the Print Area icon.
- On the drop-down menu, select Set Print Area.

9.2 Page setup

Setting the layout of a worksheet that needs to be printed, can be done by either using the

- Applicable tab and icon on the Ribbon, OR
- Page Setup dialog box by clicking on the Dialog Box Launcher arrow in the Page Setup group on the Page Layout tab.
- The Page Setup dialog box will appear as shown on the right.
(a) **Page**

- **Orientation**

Orientation is used to setup printing preference as either portrait or landscape format.

<table>
<thead>
<tr>
<th>Ribbon: Page Layout tab</th>
<th>Dialog Box Launcher: Page Setup dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Click on the Page Layout tab.</td>
<td>- Select the Page tab in the Page Setup dialog box.</td>
</tr>
<tr>
<td>- In the Page Setup group, click on the arrow below the Orientation icon.</td>
<td>- Click on either the Portrait or Landscape option button.</td>
</tr>
<tr>
<td>- On the drop-down menu, select either Portrait or Landscape depending on your printing needs.</td>
<td></td>
</tr>
</tbody>
</table>

- Leave the default selection as is.

- **Scaling**

Scaling is used to set the width or height of a printed worksheet to a maximum number of pages or to stretch or shrink the printed worksheet to a percentage of its actual size.

<table>
<thead>
<tr>
<th>Ribbon: Page Layout tab</th>
<th>Dialog Box Launcher: Page Setup dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Click on the Page Layout tab.</td>
<td>- Select the Page tab in the Page Setup dialog box.</td>
</tr>
<tr>
<td>- In the Scale to Fit group</td>
<td>- By selecting “Adjust to” you can stretch or shrink the printed worksheet to a percentage of its actual size.</td>
</tr>
<tr>
<td>- By clicking on the arrow next to Scale you can increase or decrease the size in relation to the normal size.</td>
<td>- By selecting “Fit to”, you can reduce the width and/or the height of the printed worksheet to fit a maximum number of pages wide and/or tall. For example, if you set both wide and tall to 1, your selected print area will print the print area set in section 9.1 in this study unit, to one page only.</td>
</tr>
<tr>
<td>- By clicking on the arrow next to Width you can define over how many pages wide you want to print the selected area.</td>
<td></td>
</tr>
<tr>
<td>- By clicking on the arrow next to Height, you can define over how many pages tall you want to print the selected area.</td>
<td></td>
</tr>
<tr>
<td>- Leave the default selection as is.</td>
<td></td>
</tr>
</tbody>
</table>
- **Paper size**

Select the size of paper you are printing to

<table>
<thead>
<tr>
<th>Ribbon:</th>
<th>Dialog Box Launcher:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Layout tab</td>
<td>Page Setup dialog box</td>
</tr>
<tr>
<td>- Click on the Page Layout tab</td>
<td>- Select the Page tab in the Page Setup dialog box.</td>
</tr>
<tr>
<td>- In the Page Setup group, click on the arrow below the Size icon</td>
<td>- Select the applicable paper size from the drop-down menu.</td>
</tr>
<tr>
<td>- On the drop-down menu, select the applicable paper size</td>
<td></td>
</tr>
</tbody>
</table>

- Select A4.

(b) **Margins**

Here you can change the margin size of the printed worksheet.

<table>
<thead>
<tr>
<th>Ribbon:</th>
<th>Dialog Box Launcher:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Layout tab</td>
<td>Page Setup dialog box</td>
</tr>
<tr>
<td>- Click on the Page Layout tab.</td>
<td>- Select the Margins tab in the Page Setup dialog box.</td>
</tr>
<tr>
<td>- In the Page Setup group, click on the arrow below the Margin icon.</td>
<td>- Increase or decrease the margins to the required size.</td>
</tr>
<tr>
<td>- On the drop-down menu, select the applicable margins, or select Custom Margins to open the Page Setup dialog box</td>
<td></td>
</tr>
</tbody>
</table>

- Select Normal margins.

(c) **Header/Footer**

Headers or footers can be included to provide useful information in your worksheet printouts such as page numbers, the date and time and the file name, or other predefined information.

<table>
<thead>
<tr>
<th>Ribbon:</th>
<th>Dialog Box Launcher:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert tab</td>
<td>Page Setup dialog box</td>
</tr>
<tr>
<td>- Click on the Insert tab.</td>
<td>- Select the Header/Footer tab in the Page Setup dialog box.</td>
</tr>
<tr>
<td>- In the Text group, click on the Header &amp; Footer icon.</td>
<td>- Include the applicable Header and or Footer.</td>
</tr>
<tr>
<td>- Click the left, centre, or right header or footer text box at the top or at the bottom of the worksheet page.</td>
<td></td>
</tr>
<tr>
<td>- Type the text you want.</td>
<td></td>
</tr>
<tr>
<td>- Clicking on any of the text boxes, will display the Design tab.</td>
<td></td>
</tr>
<tr>
<td>- On the Design tab, in the Header &amp; Footer Elements group, click the element that you want to include.</td>
<td></td>
</tr>
</tbody>
</table>
- Include your name as a Header.

- Include the page number as a Footer, by clicking on Footer icon on the Design tab, select the desired type of footer.

To exit the Header & Footer mode and return to Normal view. Click on the View tab, in the Workbook Views ribbon group click on the Normal icon.
(d) **Sheet gridlines and Row and Column Headings**

Gridlines, row headings (1, 2, 3, etc) and column headings (A, B, C, etc) are displayed by default in **Page Layout** view, but they are not printed automatically when printing a worksheet. To print the gridlines and/or row and column headings, do the following:

<table>
<thead>
<tr>
<th>Ribbon: Page Layout tab</th>
<th>Dialog Box Launcher: Page Setup dialog box</th>
</tr>
</thead>
</table>
| • Click on the **Page Layout** tab.  
  • In the **Sheet Options** group:  
    – Tick **Print** under **Gridlines** to print gridlines.  
    – Tick **Print** under **Headings** to print row and column headings. | • Select the **Sheet** tab in the **Page Setup** dialog box.  
  • Under **Print**  
    – Click on **Gridlines** to print gridlines.  
    – Click on **Row and column** headings to print the headings. |

**9.3 Print and Print preview**

**Computer activity 4.21 – Printing**

- Click on the **File** tab.  
- Select **Print** icon  
- This will open the following Print options and settings

- Print preview is automatically displayed on the right-hand side of the screen  
- To print, click on “Print” icon/button to print.
Computer activity 4.21 – Printing (continued)

- "Copies" - Set the number of copies you want to print.
- "Printer" - To which printer do you want to print your document? Leave the default selection.
- "Settings" - Under Settings, the following print settings appear:

Refer to the drop-down menus below when the arrows on the right-hand side of the settings are clicked.
• The main settings include the following:
  – What to print:
    ◊ Click on the first arrow next to the Print Active Sheets.
    ◊ Active sheet (print the sheet that is displayed)
    ◊ Entire workbook (print all the sheets in the file)
    ◊ Selection (print the range you have selected)
  – Pages
    ◊ Define the range of pages you want to print – either print everything or only certain pages (Pages: ? to ?).
    ◊ Leave the default selection.
  – Page orientation
    ◊ Select either Portrait or Landscape.

10. Summary
In this study unit we looked at the basics of using Microsoft Office Excel as a business application tool. We revised some of the basic principles of mathematics, signs/operators and explained the components of a spreadsheet. Workbook basics were also discussed, as well as operating and formatting workbooks, ending with printing and page layout, all integrated into various activities.

In the next study unit, you will be introduced to and shown how spreadsheets can be used as a business application tool, performing both simple and complex calculations to help you solve business and accounting problems. This will be done by showing and explaining to you how to create different formulas and use various functions – the real power of spreadsheets.
Self-assessment activity

After working through this study unit, you should be able to answer the questions below.

At the end of study unit 5, all the work covered in this study unit will be tested in comprehensive self-assessment activity questions because the study units in part 2 build on one another, equipping you to effectively use Microsoft Office Excel as a business application tool.

1) List the Microsoft Office Excel **order of operation** in sequence.
2) You are the owner of Music Life, a music store selling local music CDs to the public. Music Life is a registered VAT vendor. You would like to purchase 15 CDs of DJ Powa’s newly released album for your store from Pony Records. Pony Records is also a registered VAT vendor.

The cost price, including VAT, is R114 per CD. Music Life sells these CDs at R171 per CD, including VAT.

The VAT rate is 14%.

**Required**

a) Calculate the cost price excluding VAT for the purchase of all CDs.

b) Calculate the mark-up margin.

c) Calculate the gross profit (excluding VAT) for each CD sold.

---

**Feedback to self-assessment activity**

**Question 2:**

(a) Cost price excluding VAT for the purchase of all 15 CDs:

\[
\text{R114} \times \frac{1}{1.14} = \text{R100} \text{ (cost price excluding VAT per CD)}
\]

\[
\text{R100} \times 15 \text{ CDs} = \text{R1,500}
\]

(b) Mark-up margin:

\[
\text{R171} - \text{R114} = \text{R57} \text{ (gross profit/mark-up including VAT)}
\]

\[
\frac{\text{R57}}{\text{R114}} = 50\%
\]

(c) Gross profit (excluding VAT) for each CD sold:

\[
\text{R171} \times \frac{1}{1.14} = \text{R150} \text{ (sales price excluding VAT per CD)}
\]

\[
\text{R150} - \text{R100} = \text{R50}
\]
1 Introduction

In the previous study unit you were introduced to spreadsheets. We looked at what a spreadsheet is, the various components and layouts of a spreadsheet and some basics of workbooks, formatting, printing and page layout.

By using spreadsheets as business applications, we can perform either simple or complex calculations to solve business and accounting problems. To do this we can create different formulas and use various functions. These formulas and functions will be discussed in this study unit.
2 Working with formulas

A formula in Microsoft Office Excel always start with an = sign.

2.1 Common errors when using formulas and functions

Once an error shows up in a cell, you have to find the cause of the error and edit the worksheet in order to correct the error. Below are common error displays found in Microsoft Office Excel and the reasons for it:

#DIV/0!
This error occurs when the formula calls for division by a cell that either contains the value 0 or, as is more often the case, is empty. Division by zero is not possible according to mathematical principles.

#NAME?
This error occurs when Microsoft Office Excel does not recognise text in a formula.

#NULL!
This error occurs most often when you insert a space where you should have used a comma to separate cell references used as arguments for functions.

#NUM!
This error occurs when Microsoft Office Excel encounters a problem with a number in the formula, such as the wrong type of argument in a Microsoft Office Excel function or a calculation that produces a number too large or too small to be represented in the worksheet.

#REF!
This error occurs when Microsoft Office Excel encounters an invalid cell reference, such as when you delete a cell referred to in a formula or paste cells over cells referred to in a formula.

#VALUE!
This appears when you use the wrong type of argument in a function, the wrong type of operator or when you try to do a mathematical operation that refers to cells containing text entries.

#N/A!
This error occurs when a value is not available to a function or formula.
2.2 Entering formulas

(a) Adding, subtracting, dividing and multiplying values

**Computer activity 5.1**

- Open a new workbook/file.
- Rename worksheet “Sheet 1” as “Practice”.
- Click on cell A1 in worksheet “Practice”.
- Type the value **100** and **Enter**.
- Click on cell A2.
- Type the value **20** and **Enter**.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Add** the two values together in cell **A3**. After adding the two cells, the answer will be displayed in cell A3.

- Click on cell A3 (chosen for the formula).
- Type = sign from the keyboard to begin the formula.
- Type the first cell reference (cell A1) by using the arrow key or by using the mouse to click on the cell.
- Type the first operator ( + ).
- Type the next cell reference (cell A2) by using the arrow key or using the mouse to click on the cell.
- Press **Enter**.
- The answer that appears is **120**.

Repeat the above activity, but instead of adding the two values, now subtract them from each other in cell **A4**, multiply the two values in cell **A5** and divide the two values by each other in cell **A6**.

This can be achieved by merely changing the operator every time, but keeping the same format of operations – that is, using cell A1 as the first cell reference and cell A2 as the second cell reference. The answer should look like this:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>120</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>80</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>2000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
(b) Adding values in two separate worksheets

Computer activity 5.2

- Rename worksheet “Sheet2” as “Test”.
- Click on cell A1 in worksheet “Test”.
- Type the value 200 and Enter.
- Click on cell A2.
- Type the value 40 and Enter.
- Click on cell A3 in worksheet “Test” (chosen for the formula).
- Type = to begin the formula.
- Type the first cell reference (sheet Test cell A1) by using the arrow key.
- Type the first operator (+).
- Type the next cell reference (sheet Test cell A2) by using the arrow key.
- Type the second operator (+).
- Click on sheet tab “Practice”.
- Click on cell A1 in worksheet “Practice”.
- Type the third operator (+).
- Click on cell A2 in worksheet “Practice”.
- Press Enter.
- The answer that appears is 360.

The formula in cell A3 on sheet “Test” will be:

=A1+A2+Practice!A1+Practice!A2

Note that the sheet name precedes the cell reference if the cell is not on the current sheet (because every sheet has a cell A1, A2, A3, etc).

(c) Combining text and values (&)

Using “&” will reflect the contents of the cells/value/text combined beside each other – for example, =2000&100 will reflect as 2000100. Spaces and other symbols can be added by inserting them in the formula using quotes – for example, =2000&“-“&100 will reflect as 2000–100.
Computer activity 5.3

- Rename worksheet “Sheet3” as “Add”.
- Type the following data in the worksheet:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Nissan</td>
<td>Hardbody</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1985</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Toyota</td>
<td>Corolla</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Ford</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>81</td>
<td>Model</td>
<td></td>
</tr>
</tbody>
</table>

- In cell C1, enter =A1&B1, and in cell C2, enter =A2&B2.
  - Observe the results displayed in cell C1 (NissanHardbody) and in cell C2 (198512).
  - Note that using “&” in the formula in cell C2 did not sum the two values but displays the values beside each other.

- In cell C3, enter =A3&" "&B3, in cell C4, enter =A4&"-"&B4 and in cell C5, enter =19&A5&" "&B5.
  - Observe the results displayed in cell C3 (Toyota Corolla), in cell C4 (Ford-200) and in cell C5 (1981 Model)
  - Note that using “ ” inserted a space in the displayed answer (C3 & C5), while inserting “-” included a dash in the displayed answer (C4).

- Your “Add” sheet should now appear as follow:
2.3 Copying formulas

(a) Relative reference

Where the column and row reference of a cell reference in a formula changes when copied down and/or across, the cell address is referred to as being a relative reference.

A formula or a function can be copied by using the steps in section 7 in study unit 4 or by doing the following:

- Click on the cell containing the formula you want to copy.
- Position your mouse pointer on the right-hand bottom corner of the cell until the mouse turns to a black cross.
- Click and drag the formula down or across to the cells to which you want to copy the formula and release the mouse button.

-copy down

When a formula is copied down (over rows) in a spreadsheet, the cell’s row reference will increase by the number of rows that the formula was copied down, for example:

- A formula =A1*B1 which copied down one row, will change to =A2*B2 – that is, cell A1 + 1 row = cell A2 and cell B1 + 1 row = cell B2.
- A formula =A1*B1, which copied down three rows, will change to =A4*B4 – that is, cell A1 + 3 rows = cell A4 and cell B1 + 3 rows = cell B4.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

Number of rows copied down (3 rows)

Computer activity 5.4

- Enter the following data in a spreadsheet:

<table>
<thead>
<tr>
<th></th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Number of items</td>
<td>Price per item</td>
<td>Total price</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Shoes</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>T-shirts</td>
<td>4</td>
<td>15</td>
</tr>
<tr>
<td>4</td>
<td>Jackets</td>
<td>2</td>
<td>20</td>
</tr>
<tr>
<td>5</td>
<td>Jeans</td>
<td>5</td>
<td>18</td>
</tr>
</tbody>
</table>

- In cell D2, calculate the total price for shoes by entering the formula =B2*C2.
- Copy the formula in cell D2 to cells D3, D4 and D5.
What happened to the formula in cell D3? Is it still $=B2*C2$ or did it change?

- The row reference in the cell reference increased by the number of rows that the formula was copied down (i.e., 1). Cell $B2 + 1$ row = cell $B3$ and cell $C2 + 1$ row = cell $C3$. The formula therefore changed from $=B2*C2$ to $=B3*C3$.

What happened to the formula in cell D5? Is it still $=B2*C2$ or did it change?

- The row reference in the cell reference increased by the number of rows that the formula was copied down (i.e., 3 rows). Cell $B2 + 3$ rows = cell $B5$ and cell $C2 + 3$ rows = cell $C5$. The formula therefore changed from $=B2*C2$ to $=B5*C5$.

• The answer should appear as follows:

![Image of a spreadsheet with formulas]

- **Copy across**

When a formula is copied across (over columns) in a spreadsheet, the cell’s column reference will increase by the number of columns that the formula was copied across. For example:

- A formula $=A1+A2$ copied across one column, will change to $=B1+B2$ – that is, cell $A1 + 1$ column = cell $B1$ and cell $A2 + 1$ column = cell $B2$.
- A formula of $=A1+A2$ copied across three columns, will change to $=D1+D2$ – that is, cell $A1 + 3$ columns = cell $D1$ and cell $A2 + 3$ columns = cell $D2$. 

![Table showing copied across calculation]
Computer activity 5.5

- Enter the following data into a spreadsheet:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>March</td>
<td>April</td>
<td>May</td>
<td>June</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Shoes</td>
<td>500</td>
<td>1005</td>
<td>580</td>
<td>730</td>
</tr>
<tr>
<td>3</td>
<td>T-shirts</td>
<td>700</td>
<td>650</td>
<td>408</td>
<td>840</td>
</tr>
<tr>
<td>4</td>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- In cell B4, calculate the total for March by entering the formula =B2+B3.
- Copy the formula in cell B4 to cells C4, D4 and E4.

What happened with the formula in cell C4? Is it still =B2+B3 or did it change?

- The column reference in the cell reference increased by the number of columns that the formula was copied across (ie 1). Cell B2 + 1column = cell C2 and cell B3 + 1column = cell C3. The formula therefore changed from =B2+B3 to =C2+C3.

What happened with the formula in cell E4? Is it still =B2+B3 or did it change?

- The column reference in the cell reference increased by the number of columns that the formula was copied across (ie 3). Cell B2 + 3columns = cell E2 and cell B3 + 3columns = cell E3. The formula therefore changed from =B2+B3 to =E2+E3.

- The answer should appear as follows:
Computer activity 5.6

- Enter the following data in a spreadsheet:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Number sold</strong></td>
<td><strong>January</strong></td>
<td><strong>February</strong></td>
</tr>
<tr>
<td>2</td>
<td>Shoes</td>
<td>20</td>
<td>25</td>
</tr>
<tr>
<td>3</td>
<td>T-shirts</td>
<td>50</td>
<td>80</td>
</tr>
<tr>
<td>4</td>
<td>Jackets</td>
<td>35</td>
<td>32</td>
</tr>
<tr>
<td>5</td>
<td>Jeans</td>
<td>60</td>
<td>70</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td><strong>Selling price per item</strong></td>
<td><strong>January</strong></td>
<td><strong>February</strong></td>
</tr>
<tr>
<td>8</td>
<td>Shoes</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>9</td>
<td>T-shirts</td>
<td>50</td>
<td>55</td>
</tr>
<tr>
<td>10</td>
<td>Jackets</td>
<td>300</td>
<td>310</td>
</tr>
<tr>
<td>11</td>
<td>Jeans</td>
<td>150</td>
<td>100</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td><strong>Total sales per item</strong></td>
<td><strong>January</strong></td>
<td><strong>February</strong></td>
</tr>
<tr>
<td>14</td>
<td>Shoes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>T-shirts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Jackets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Jeans</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Calculate the total sales per item by multiplying the number sold by the selling price of the item.
- Calculate in cell B14 the total sales for shoes sold in January by entering the formula \( =B2 \times B8 \).
- Copy the formula in cell B14 to cells B15, B16 and B17.

What happened with the formula in cell B16? Is it still \( =B2 \times B8 \) or did it change?

- The row reference in the cell reference increased by the number of rows that the formula was copied down (ie 2). Cell \( B2 + 2 \text{ rows} = B4 \) and cell \( B8 + 2 \text{ rows} = B10 \). The formula therefore changed from \( =B2 \times B8 \) to \( =B4 \times B10 \).
• Copy the formula in cell B14 to cells C14 C15, C16 and C17.

What happened with the formula in cell C14? Is it still =B2*B8 or did it change?

– The column reference in the cell reference increased by the number of columns that the formula was copied across (ie 1). Cell B2+1column = cell C2 and cell B8 + 1column = cell C8. The formula therefore changed from =B2*B8 to =C2*C8.

What happened to the formula in cell C17? Is it still =B2*B8 or did it change?

– Not only did the column reference in the cell reference increase by the number of columns that the formula was copied across (ie 1), but the row reference also increased by the number of rows that the formula that was copied down (ie 3). The formula therefore changed from =B2*B8 to =C5*C11, that is:

  ◇ cell B2 + 1column + 3rows = C5
  ◇ cell B8 + 1column + 3rows = C11

• The answer should appear as follows:
(b) Absolute reference

In contrast to a relative reference (see section 2.3(a) in this study unit), the column and/or row reference in an absolute reference is “fixed” and does not change when a formula is copied down and/or across. Inserting a dollar sign ($) in front of the row or/and column reference will make the reference absolute. Inserting a $ in front of a column or a row will ensure that the column or row reference is absolute (“fixed”) and will not change when the formula is copied across or down. This is the same as using glue to permanently “glue” a cell reference. There are three types of absolute references, as explained below:

- **Absolute row reference.** Insert the $ in front of the row reference only (eg B$5). When copied, only the column reference (B) will change. Because the row reference (5) is fixed, it will not change.
- **Absolute column reference.** Insert the $ in front of the column reference only (eg $B5). When copied, only the row reference (5) will change. Because the column reference (B) is fixed, it will not change.
- **Absolute column AND row reference.** Insert the $ in front of both the column and row reference (eg $B$5). When copied, both the column reference (B) and the row reference (5) will not change because they are fixed.

The $ can be inserted by

- Changing the formula to include the $
- Highlighting the cell reference in the formula/function and pressing the F4 function key until the $ is displayed. Each time the F4 key is pressed, it will change where the $ is displayed – that is, in front of both the column and row reference, in front of the row reference only or in front of the column reference only.

**Absolute row reference (eg B$5)**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VAT rate</td>
<td>14%</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Sales excluding VAT</td>
<td>Sales including VAT</td>
</tr>
<tr>
<td>4</td>
<td>January</td>
<td>1500</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>February</td>
<td>1200</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>March</td>
<td>1300</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>April</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>May</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>June</td>
<td>1400</td>
<td></td>
</tr>
</tbody>
</table>

**Computer activity 5.7**

- Enter the following data in a spreadsheet:
• Calculate the sales amount per month, including VAT by using the VAT % provided. The formula will be entered once and copied to the rest of the cells. What formula would you enter in cell C4?

• In cell C4 type = (B4*B1)+B4 – that is, sales including VAT = (sales excluding VAT x VAT rate) + sales excluding VAT.

• Copy the formula in cell C4 to cell C5 and observe how the formula changes. As explained in section 2.3(a) (copy down) in this study unit, relative row references in a formula will increase by the number of rows that the formula is copied down – that is, the formula will change from = (B4*B1)+B4 to = (B5*B2)+B5.
  – However, we did not want cell reference B1 in the formula to change to B2 because the VAT % was entered in cell B1.
  – How do you think cell reference B1 should change to ensure (when it is copied down) that it still refers to cell B1 and will not change? The row reference should be made absolute (fixed) by inserting a $ sign in front of the row reference (B$1).

• Delete the formula copied to cell C5.

• In cell C4, change cell reference B1 to include the applicable absolute reference (i.e., = (B4*B$1)+B4).

• Now copy the new formula in cell C4 to range C5:C9 and observe how the formula changes.

What happened with the formula in cell C6? How did it change?
  – The row reference of the relative cell reference changed, as explained in section 2.3(a) (copy down) of this study unit (B4 to B6). However, the row reference in B$1 did not change because it was absolute/fixed. The formula therefore changed from = (B4*B$1)+B4 to = (B6*B$1)+B6.

• The answer should appear as follows:

Note: When the VAT rate was entered in the spreadsheet, it was 0.14, and the format of the cell changed to display a % format. The format of the numbers was changed to a number format with two decimals. See section 8.1(a) in study unit 4.
Enter the following data in a spreadsheet:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VAT rate</td>
<td>14%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>January</td>
<td>February</td>
<td>March</td>
<td>April</td>
<td>May</td>
<td>June</td>
<td>July</td>
</tr>
<tr>
<td>4</td>
<td>Sales excl VAT</td>
<td>1,500.00</td>
<td>1,200.00</td>
<td>1,300.00</td>
<td>500.00</td>
<td>800.00</td>
<td>1,400.00</td>
</tr>
<tr>
<td>5</td>
<td>Sales incl VAT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Calculate the sales amount per month, including VAT, by using the provided VAT %. The formula will be entered once and copied to the rest of the cells. What formula would you enter in cell B5?
  - In cell B5 type = (B4*B1)+B4
  - Copy the formula to cell C5 and observe the change in the formula. As explained in section 2.3(a) (copy across) in this study unit, relative column references in a formula will increase by the number of columns that the formula is copied across, that is, the formula will change from = (B4*B1)+B4 to = (C4*C1)+C4.
    - However, we did not want cell reference B1 in the formula, to change to C1 because the VAT % was only entered in cell B1.
    - How do you think cell reference B1 should change to ensure (when it is copied across) that it still refers to cell B1 and will not change? The column reference should be made absolute (fixed) by inserting a $ sign in front of the column reference ($B1).
  - Delete the formula you have copied to cell C5.
  - In cell B5, change cell reference B1 to include the applicable absolute reference (ie to = (B4*$B1)+B4).
  - Now copy the formula to range C5:H5 and observe how the formula changes.

What happened with the formula in cell E5? How did it change?

- The column reference of the relative cell references changed as explained in section 2.3(a) (copy across) in this study unit (B4 to E4). However, the column reference in $B1 did not change because it was absolute/fixed. The formula therefore changed from = (B4*$B1)+B4 to = (E4*$B1)+E4.
• The answer should appear as follows:

![Spreadsheet Image]

**Absolute column and row references (eg $B$5)**

**Computer activity 5.9**

• Enter the following data in a spreadsheet:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VAT rate</td>
<td>14%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sales excl VAT</td>
<td>January</td>
<td>February</td>
<td>March</td>
<td>April</td>
</tr>
<tr>
<td>4</td>
<td>Shoes</td>
<td>2,000.00</td>
<td>2,500.00</td>
<td>3,000.00</td>
<td>2,900.00</td>
</tr>
<tr>
<td>5</td>
<td>T-shirts</td>
<td>500.00</td>
<td>800.00</td>
<td>700.00</td>
<td>400.00</td>
</tr>
<tr>
<td>6</td>
<td>Jackets</td>
<td>3,500.00</td>
<td>3,200.00</td>
<td>3,800.00</td>
<td>4,000.00</td>
</tr>
<tr>
<td>7</td>
<td>Jeans</td>
<td>6,000.00</td>
<td>7,000.00</td>
<td>4,000.00</td>
<td>3,000.00</td>
</tr>
<tr>
<td>8</td>
<td>Hats</td>
<td>150.00</td>
<td>200.00</td>
<td>300.00</td>
<td>250.00</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sales incl VAT</td>
<td>January</td>
<td>February</td>
<td>March</td>
<td>April</td>
</tr>
<tr>
<td>12</td>
<td>Shoes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>T-shirts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Jackets</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Jeans</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Hats</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
• Calculate the sales amount per month, including VAT, by using the provided VAT %. The formula will be entered once and copied to the rest of the cells. What formula would you enter?

• In cell B12, type =(B4*B1)+B4.

• Copy the formula to cell D15 and observe how the formula changes. As explained in section 2.3(a) (copy across & down) in this study unit, relative column and row references in a formula will increase by the number of columns/rows copied across/down. The formula will change from =(B4*B1)+B4 to =(D7*D4)+D7.
  – However, we did not want cell reference B1 in the formula, to change to D4 because the VAT % was entered in cell B1.
  – How do you think cell reference B1 should change to ensure (when it is copied across and down) that it still refers to cell B1 and will not change? The column and the row reference should be made absolute (fixed) by inserting a $ sign in front of the column and row reference ($B$1).

• Delete the formula you copied to cell D15.

• In cell B12, change cells reference B1 to include the applicable absolute references (ie =(B4*$B$1)+B4).

• Now copy the formula to range B13:B16 and range C12:E16 and observe how the formula changes.

What happened with the formula in cell D15? How did it change?
  – The column and row references of the relative cell references changed as explained in 2.3(a) (copy across & down) in this study unit (B4 to D7). However, the column and row reference in $B$1 did not change because it was absolute/fixed. The formula therefore changed from =(B4*$B$1)+B4 to =(D7*$B$1)+D7.

• The answer should appear as follows:
3 Functions

A function is a short cut to make calculations easier and quicker. Functions should always be used if they are available – for example, adding 20 cells together by =A1+A2+A3…+A20 compared to =SUM(A1:A20).

3.1 Structure of a function

A function ALWAYS begins with an equal sign (=), followed by the function name, the opening parenthesis, the arguments for the function, separated by commas, and the closing parenthesis.

Arguments are the information needed by the function in order to calculate the function correctly.

We will now break down the following examples in the above-mentioned structure:

=SUM(cell1:cell2)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
</tr>
<tr>
<td>Function name</td>
<td>SUM</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
</tr>
<tr>
<td>The arguments for the function</td>
<td>cell1:cell2</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
</tr>
</tbody>
</table>
=PMT(rate,nper,pv,fv,type)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
</tr>
<tr>
<td>Function name</td>
<td>PMT</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
</tr>
<tr>
<td>The arguments for the function separated by commas</td>
<td>rate,nper,pv,fv,type</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
</tr>
</tbody>
</table>

=IF(Logical_test,value_if_true,value_if_false)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
</tr>
<tr>
<td>The arguments for the function separated by commas</td>
<td>Logical_test,value_if_true,value_if_false</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
</tr>
</tbody>
</table>

3.2 Reference operators: when to use : or ,

(a) Colon :

A colon ( : ) is used to select all the cells from and including the first cell reference to and including the last cell reference simultaneously. Range A1:A9 will therefore include all the cells from and including A1 to A9 (see the highlighted cells below).
(b) **Comma ,**

A comma (,) is used if you wish to select specified cells, and it is placed between each cell reference. A1,A4,A6 will therefore only include/select only cells A1, A4 and A6 (see the highlighted cells below).

\[
\begin{array}{c|c}
\text{A} & \text{ } \\
1 & 125 \\
2 & 77 \\
3 & 45 \\
4 & 89 \\
5 & 36 \\
6 & 25 \\
7 & 50 \\
8 & 95 \\
9 & 16 \\
\end{array}
\]

Only include the highlighted cells

\[
= \text{SUM}(A1,A4,A6)
\]

Answer: 239

**NB!!** A comma is also used to separate the arguments of a function – for example,

\[= \text{IF}(\text{condition},\text{value}_1,\text{value}_2).\]

(c) **Combining a colon : and a comma ,**

A comma (,) and a colon (:) can be combined. This is used when combining two different ranges. For example, A1:A3,A6:A8 will select/include cells A1, A2, A3, A6, A7 and A8 (see the highlighted cells below).

\[
\begin{array}{c|c}
\text{A} & \\
1 & 125 \\
2 & 77 \\
3 & 45 \\
4 & 89 \\
5 & 36 \\
6 & 25 \\
7 & 50 \\
8 & 95 \\
9 & 16 \\
\end{array}
\]

Include both the highlighted cell ranges

\[
= \text{SUM}(A1:A3,A6:A8)
\]

Answer: 417
3.3 Inserting a function

Excel has a large variety of commonly used functions to help perform a large variety of calculations in a number of different disciplines such as: Mathematical, Statistical, Financial, Engineering etc.

**Computer activity 5.10**

There are two options to access the functions database from Microsoft Office Excel

**Option 1**

- Click on the Formulas tab.
- Click on the fx Insert function icon.
- The “Insert Function” window will appear to select the desired function.
- At “Or select a category” drop-down menu choose All OR the desired discipline category (Example: Financial – if you wish to perform financial calculations).

**Option 2 – (shortcut option)**

- Click on fx – “Insert Function” icon.
- The “Insert Function” window as in option 1 will appear
- At “Or select a category” drop-down menu choose All OR the desired discipline category (Example: Financial – if you wish to perform financial calculations).
4 Commonly used functions
The following are some examples of applications commonly used functions in the financial environment:

(a) MATHEMATICAL FUNCTIONS

Bear in mind that cell1 (number1) refers to the first cell in the range and cell2 (number2) to the last cell in the range – that is, A1:A9 being all cells in the range A1 to A9; and cell11, cell12, cell13 refer to selected cells – that is, A1,A4,A6 being specific cells A1, A4 and A6. See section 3.2 in this study unit for an explanation of the difference between using a comma and a colon.

SUM
This function adds values in individual cells or cell ranges together.

=SUM(cell1:cell2)
Adds all the values in a specified range of cells

=SUM(cell11,cell12,cell13)
Adds all the values for specified cells

Computer activity 5.11

• Create a worksheet and enter the following data:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>T-shirts in stock per different type of T-shirt</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Type of sport T-shirt</td>
<td>Number of T-shirt</td>
</tr>
<tr>
<td>4</td>
<td>Soccer</td>
<td>125</td>
</tr>
<tr>
<td>5</td>
<td>Rugby</td>
<td>77</td>
</tr>
<tr>
<td>6</td>
<td>Swimming</td>
<td>65</td>
</tr>
<tr>
<td>7</td>
<td>Cricket</td>
<td>45</td>
</tr>
<tr>
<td>8</td>
<td>Tennis</td>
<td>89</td>
</tr>
<tr>
<td>9</td>
<td>Netball</td>
<td>36</td>
</tr>
<tr>
<td>10</td>
<td>Basketball</td>
<td>25</td>
</tr>
<tr>
<td>11</td>
<td>Hockey</td>
<td>50</td>
</tr>
<tr>
<td>12</td>
<td>Athletics</td>
<td>95</td>
</tr>
<tr>
<td>13</td>
<td>Table tennis</td>
<td>16</td>
</tr>
</tbody>
</table>

• In cell B14, calculate the total number of T-shirts for all the types of T-shirts.
• In cell B16, calculate the total number of T-shirts for the swimming, netball and hockey T-shirts only.
• In cell B18, calculate the total number of T-shirts for the rugby, swimming, cricket, hockey and athletic T-shirts only.
The answer should appear as follows:

**ROUND**

This function rounds the value in the specified cell to the specified number of digits.

=ROUND(cell1,number_of_digits)

**Cell1** refers to cell that will be rounded. **Number_of_digits** refers to the number of digits the answer should be rounded to.

**Computer activity 5.12**

- Use the data entered in activity 5.11.
- In column C, divide the number of T-shirts for soccer, swimming, basketball and table tennis by 3.
- Using the round function, in column D round the answer, calculated in column C, as follows:
  - round soccer T-shirts to 1 digit
  - round swimming T-shirts to 2 digits
  - round basketball T-shirts to 3 digits
  - round table tennis T-shirts to 4 digits
<table>
<thead>
<tr>
<th>Type of sport T-shirt</th>
<th>Number of T-shirt</th>
<th>Number of T-shirts divided by 3</th>
<th>Round</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soccer</td>
<td>125</td>
<td>41.666666667</td>
<td>41.66</td>
</tr>
<tr>
<td>Rugby</td>
<td>77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swimming</td>
<td>65</td>
<td>21.666666667</td>
<td>21.6</td>
</tr>
<tr>
<td>Cricket</td>
<td>45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tennis</td>
<td>89</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Netball</td>
<td>36</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basketball</td>
<td>25</td>
<td>8.333333333</td>
<td>8.333</td>
</tr>
<tr>
<td>Hockey</td>
<td>50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Athletics</td>
<td>95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table tennis</td>
<td>16</td>
<td>5.333333333</td>
<td>5.333</td>
</tr>
<tr>
<td><strong>Total number of all T-shirts</strong></td>
<td><strong>623</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total number of swimming, netball and hockey T-shirts</strong></td>
<td><strong>151</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total number of rugby, swimming, cricket, hockey and athletics t-shirts</strong></td>
<td><strong>332</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```
=ROUND(C13,4)
```
It is not always necessary to round the answer of a cell in a separate cell. The round function can be used with a formula in a cell: \( \text{=ROUND(formula,number_of_digits)} \)

- **Formula**

  **Formula** refers to the formula you want to calculate.

- **Number of digits**

  **Number_of_digits** refers to the number of digits the answer should be rounded to.

**Computer activity 5.13**

- Use the data entered in **activity 5.12**.
- Delete the formulas and functions entered in columns C and D.
- In column C, divide the number of T-shirts for **soccer, swimming, basketball** and **table tennis** by 3 and round the answer of the formula as follows:
  - round soccer T-shirts to 1 digit
  - round swimming T-shirts to 2 digits
  - round basketball T-shirts to 3 digits
  - round table tennis T-shirts to 4 digits

- The answer should appear as follows:
(b) STATISTICAL FUNCTIONS

Bear in mind that cell1 refers to the first cell in the range, cell2 to the last cell in the range and cell11, cell12, cell13 to selected cells. See section 3.2 in this study unit for an explanation of the difference between using a comma and a colon.

**AVERAGE**

This function calculates the average value for the specified cells or ranges.

=\text{AVERAGE}(\text{cell}1:\text{cell}2)

calculates the average of the values in a specified range of cells.

=\text{AVERAGE}(\text{cell}11,\text{cell}12,\text{cell}13)

calculates the average of the values for specified cells.

**Computer activity 5.14**

- Use the data entered in activity 5.11
- Delete the formulas in cells B14, B16, B18.
- In cell B14, calculate the average number of T-shirts for all the types of T-shirts.
- In cell B16, calculate the average of T-shirts for the swimming, netball and hockey T-shirts only.
- In cell B18, calculate the average of T-shirts for the rugby, swimming, cricket, hockey and athletic T-shirts only.
- The answer should appear as follows:
**MAXIMUM**

This function is used to identify the maximum value in a range of cells or in specified cells.

\[ = \text{MAX}(\text{cell1:cell2}) \]

determines the largest value in a specified range of cells.

\[ = \text{MAX}(\text{cell11,cell12,cell13}) \]

determines the largest value for specified cells.

---

### Computer activity 5.15

- Use the data entered in activity 5.11.
- Delete the formulas in cells B14, B16, B18.
- In cell B14, calculate the largest number of T-shirts available for all the types of T-shirts.
- In cell B16, calculate the highest number of T-shirts available for the swimming, netball and hockey T-shirts only.
- In cell B18, calculate the greatest number of T-shirts available for the rugby, swimming, cricket, hockey and athletic T-shirts only.
- The answer should appear as follows:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>T-shirts in stock per different type of T-shirt</td>
<td>Number of T-shirt</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>T-shirts in stock per different type of T-shirt</td>
<td>Number of T-shirt</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>28</td>
</tr>
</tbody>
</table>
**MINIMUM**

This function is used to identify the minimum value in a range of cells or in specified cells.

= MIN(cell1:cell2) determines the smallest value in a specified range of cells.

= MIN(cell11,cell12,cell13) determines the smallest value for specified cells.

---

**Computer activity 5.16**

- Use the data entered in activity 5.11.
- Delete the formulas in cells B14, B16, B18.
- In cell B14, calculate the smallest number of T-shirts available for all the types of T-shirts.
- In cell B16, calculate the lowest number of T-shirts available for the swimming, netball and hockey T-shirts only.
- In cell B18, calculate the least number of T-shirts available for the rugby, swimming, cricket, hockey and athletic T-shirts only.
- The answer should appear as follows:

<table>
<thead>
<tr>
<th>Activity 5.16</th>
<th>Activity 5.16</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 T-shirts in stock per different type of T-shirt</td>
<td>1 T-shirts in stock per different type of T-shirt</td>
</tr>
<tr>
<td>2 Type of sport T-shirt</td>
<td>Number of T-shirt</td>
</tr>
<tr>
<td>3 Soccer</td>
<td>125</td>
</tr>
<tr>
<td>4 Rugby</td>
<td>77</td>
</tr>
<tr>
<td>5 Swimming</td>
<td>65</td>
</tr>
<tr>
<td>6 Cricket</td>
<td>45</td>
</tr>
<tr>
<td>7 Tennis</td>
<td>89</td>
</tr>
<tr>
<td>8 Netball</td>
<td>36</td>
</tr>
<tr>
<td>9 Basketball</td>
<td>25</td>
</tr>
<tr>
<td>10 Hockey</td>
<td>50</td>
</tr>
<tr>
<td>11 Athletics</td>
<td>95</td>
</tr>
<tr>
<td>12 Table tennis</td>
<td>16</td>
</tr>
<tr>
<td>13 The smallest number of all T-shirts in stock</td>
<td>16</td>
</tr>
<tr>
<td>14 The smallest number of only swimming, netball and hockey T-shirts in stock</td>
<td>36</td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16 The smallest number of only rugby, swimming, cricket, hockey and athletics T-shirts in stock</td>
<td>45</td>
</tr>
</tbody>
</table>

---
(c) **FINANCIAL FUNCTIONS**

For all the functions mentioned below, the following definitions apply:

- **rate** = the interest rate used
- **nper** = the applicable period
- **pmt** = the payment/instalment amount
- **fv** = future value
- **pv** = present value
- **type** = 1 if the instalment is paid at the **beginning** of the month
- **type** = 0 if the instalment is paid at the **end** of the month

Always ensure that the payment period, interest rate period and the applicable period are all have same period/denominator. Remember, you should be comparing apples with apples, and not apples with oranges.

**Example**

If, in the case study, you are given the information in different periods, you must first convert it.

- Payment is an instalment **per month**, the interest rate is a % **per annum** and the period is in **years**.
- Because the payment period is in months, you will need to convert the current yearly interest rate to a monthly interest rate by dividing the yearly interest rate by 12.
- Because the payment period is in months, you will also need to convert the applicable period currently in years to a number of months by multiplying the period in years by 12.

Note that for activities 5.17 to 5.20, the interest rate should be entered in the spreadsheet as 0.14 and formatted to display as 14%. See section 8.1(a) in study unit 4.

**NOTE**

Using financial functions available (that is present value, future value and payment), interest rate will be based on the number of periods used in the function.

**CALCULATION OF PAYMENTS**

\[ \text{PMT}(\text{rate}, \text{nper}, \text{pv}, \text{fv}, \text{type}) \]

Calculates the payment for a loan based on constant payments and a constant interest rate.

**Computer activity 5.17**

- You want to buy a car for R50 000. Enter the present value in cell **B3**.
- The bank can finance your car purchase at constant interest rate of 14% per annum over 5 years. Enter the interest rate in cell **B4** and finance term (period) in cell **B5**
Use the =PMT function and calculate the monthly payment you need to make to the bank at the end of each month.

Enter the following formula in cell B7: =PMT(B4/12,B5*12,B3,0,0)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with =</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function (fx) name</td>
<td>PMT</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>rate</td>
<td>B4/12</td>
<td>The interest rate is an annual (yearly) rate and needs to be divided by 12 to make it a monthly rate because the payment value required is a monthly payment.</td>
</tr>
<tr>
<td>nper</td>
<td>B5*12</td>
<td>The period is a term in years and needs to be multiplied by 12 to make it a period in months because the payment value required is a monthly payment.</td>
</tr>
<tr>
<td>pv</td>
<td>B3</td>
<td>The present value of the loan amount. This is the amount you want to borrow from the bank to finance the vehicle.</td>
</tr>
<tr>
<td>fv</td>
<td>0</td>
<td>The future value of the loan. Since the loan will be fully paid by the end of the period, the future value of the loan is 0.</td>
</tr>
<tr>
<td>type</td>
<td>0</td>
<td>The instalment is paid at the end of each month (paid in arrears).</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

The answer should appear as follows:

Note: Because an instalment/payment is regarded as an outflow of cash, it is shown as a negative value.
Computer activity 5.18

- Use the same information as in activity 5.17
- Calculate the monthly amount payable to the bank if you pay the amount at the **beginning** of the month (ie you pay in advance).
  
  - Enter the following formula in cell B7: \( \text{PMT}(B4/12, B5*12, B3, 0, 1) \)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>PMT</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>rate</td>
<td>B4/12</td>
<td>The interest rate is an annual (yearly) rate and needs to be divided by 12 to make it a monthly rate.</td>
</tr>
<tr>
<td>nper</td>
<td>B5*12</td>
<td>The period is a term in years and should be multiplied by 12 to make it a period in months.</td>
</tr>
<tr>
<td>pv</td>
<td>B3</td>
<td>The present value of the loan amount. This is the amount you want to loan from the bank to finance the vehicle.</td>
</tr>
<tr>
<td>fv</td>
<td>0</td>
<td>The future value of the loan. Since the loan will be fully paid by the end of the period, the future value of the loan is R0.</td>
</tr>
<tr>
<td>type</td>
<td>1</td>
<td>The instalment is paid at the beginning of the month (paid in advance).</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

CALCULATION OF FUTURE VALUES

\( \text{FV(rate, nper, pmt, pv, type)} \)

Returns the future value of an investment based on constant payments and a constant interest rate.
**Computer activity 5.19**

- You want to save R500 at the end of each month for 5 years and the bank is prepared to give you a constant interest rate of 14% per annum. Enter the investment amount (R500) in cell B3, the investment rate (14%) in cell B4 and the period (5) in cell B5.

- Use the =FV function and calculate what the value of your savings will be after five years.

  - Enter the following formula in cell B7: =FV(B4/12,B5*12,B3,0,0)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>FV</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>rate</td>
<td>B4/12</td>
<td>The interest rate is an annual (yearly) rate and needs to be divided by 12 to make it a monthly rate as you save monthly.</td>
</tr>
<tr>
<td>nper</td>
<td>B5*12</td>
<td>The period is a term in years and should be multiplied by 12 to make it a period in months because you save monthly.</td>
</tr>
<tr>
<td>pmt</td>
<td>B3</td>
<td>The payment amount you want to save each month. Note that the amount is negative (-R500) because it is an outflow of cash to an investment.</td>
</tr>
<tr>
<td>pv</td>
<td>0</td>
<td>The present value of your investment. Since you have not saved anything yet, the current value (present value) of your investment is 0.</td>
</tr>
<tr>
<td>type</td>
<td>0</td>
<td>You save at the end of each month.</td>
</tr>
</tbody>
</table>

- The answer should appear as follows:

![Excel screenshot showing the future value of monthly savings](attachment:image.png)
CALCULATION OF PRESENT VALUES

=PV(rate,nper,pmt,fv,type)
returns the present value of an investment – the total amount that a series of total payments is worth today at a constant interest rate and over a constant period.

Computer activity 5.20

- At the end of each month, you have R500 that you can use to pay off a loan to the bank. The bank offers you a constant interest rate of 14% per annum over 60 months. Enter the payment in cell B3, the interest rate in cell B4 and the period in cell B5.
- Use the =PV function and calculate what amount you can borrow from the bank.
  - Enter the following formula in cell B7: =PV(B4/12,B5*12,B3,0,0)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with =</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>PV</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>()</td>
<td></td>
</tr>
<tr>
<td>rate</td>
<td>B4/12</td>
<td>The interest rate is an annual (yearly) rate and needs to be divided by 12 to make it a monthly rate.</td>
</tr>
<tr>
<td>nper</td>
<td>B5</td>
<td>The period is a term in months. Note that you do not need to adjust the period because it is already in months.</td>
</tr>
<tr>
<td>pmt</td>
<td>B3</td>
<td>The payment amount you can make each month. Note that the amount is negative (-R500) because it is an outflow of cash to an investment.</td>
</tr>
<tr>
<td>fv</td>
<td>0</td>
<td>The future value of the loan. Because the loan will be fully paid by the end of the period, the future value of the loan is R0.</td>
</tr>
<tr>
<td>type</td>
<td>0</td>
<td>The instalment is paid at the end of the month (paid in arrears).</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

- The answer should appear as follows:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Present value of payments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 Payment per month</td>
<td>-R 500.00</td>
<td></td>
</tr>
<tr>
<td>4 Interest rate per year</td>
<td>14%</td>
<td></td>
</tr>
<tr>
<td>5 Term in years</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>7 Present value</td>
<td>R 21,498.51</td>
<td></td>
</tr>
</tbody>
</table>
(d) LOGICAL FUCTIONS

=IF(logical_test,value_if_true,value_if_false)
returns one value if the specified logical test evaluates to be TRUE and another value if the specified logical test evaluates to be FALSE.

Logical_test:

A logical test is any value or expression that can be evaluated as either TRUE or FALSE. For example, A1<1000 is a logical test; if A is equal to 500, then the expression evaluates as TRUE, but if A is equal to 2000, then the expression will evaluate as FALSE. A logical test can evaluate against text (eg A1="yes"), a value (eg A1<1000), another cell (eg A1>=B2) or a formula (eg C5=(A2*B2) ).

A logical test usually consists of three parts:

1) a cell reference, say, A1
2) a comparison calculation operator, that is, less than (<); greater than or equal to (>=); less than or equal to (<=); not equal to (<>); and equal to(=)
3) a value, text, cell reference or formula against which to evaluate the cell reference in part (1) – for example, 10000, “YES”, B6 or (B5*B6). Note when using text, that it should be in quotes (“ ”) and that it is case sensitive (“ABC” and “abc” is, after all, not exactly the same).

Value_if_true:

Which value should be displayed in the cell if the logical test is evaluated as TRUE (the value that is returned if the logical_test is TRUE)?

The value can either be:

- **Text** (eg “Yes”, “Open”, etc). Note that text should always be in quotes (“ ”) and is case sensitive.
- **A value** (eg 1000.00 or 15090.23). Note that the value does not have any spaces, commas or currency and that a full stop (.) is used to indicate decimals.
- **Refer to a cell** reference within the worksheet (eg B5 or E18)
- **A calculation** (eg B5*C7 or B5+30 or A10*0.14)

Value_if_false:

Which value should be displayed in the cell if the logical test is evaluated as FALSE (the value that is returned if the logical_test is FALSE)?

The value can either be:

- **Text** (eg “close”, “new”, etc). Note that text should always be in quotes (“ ”) and is case sensitive.
- **A value** (eg 56789.23 or 9874563). Note that the value does not have any spaces, commas or currency and that a full stop (.) is used to indicate decimals.
- **Refer to a cell** reference (eg G3 or J50)
- **A calculation** (eg A5-B7 or D5/30 or C10*0.02)
You have invited a few friends and their children to a soccer match. The soccer tickets are R30 per adult and R15 per child. You also want to invite the persons 21 years and older to an after party. The cost of the after party is R100 per person.

You want to determine the following:

- the total cost and cost per person for the **soccer tickets** only
- who you wish to invite to the after party, indicated with “Invite”, and who you do not wish to invite, indicated with “Don’t invite”
- the total cost and total cost per person including the after party and the soccer tickets costs

**NOTE** THAT ALL FORMULAS WILL ONLY BE ENTERED IN THE FIRST CELL AND COPIED DOWN TO THE FOLLOWING CELLS.

**Please save this file as “Activity 5.21” because it will be used in a subsequent activity.**

Enter the following data in a spreadsheet:

<table>
<thead>
<tr>
<th>Name</th>
<th>Adult/Child</th>
<th>Age</th>
<th>Soccer ticket price</th>
<th>Invite to after party</th>
<th>Total cost soccer and after party</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peter</td>
<td>Adult</td>
<td>43</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sarah</td>
<td>Adult</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thabo</td>
<td>Child</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sandy</td>
<td>Child</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thomas</td>
<td>Child</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viwe</td>
<td>Adult</td>
<td>32</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abel</td>
<td>Child</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rikki</td>
<td>Child</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Martin</td>
<td>Adult</td>
<td>22</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Razia</td>
<td>Adult</td>
<td>19</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
- What will the formula in cell D9 be to determine the correct soccer ticket price? Remember that you will copy the formula to the rows below.

- Enter the following formula in cell D9 and copy to range D10:D18. See what happens. Does the formula give you the desired result for each of the cells?

\[ =\text{IF}(B9=\text{"Adult"},B\$4,B\$5) \]

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>B9=“Adult”</td>
<td>You want to evaluate if the person is an adult (as indicated in cell B9). Note the relative reference of cell B9. Also note that “Adult” is in quotes (“”) because you evaluate against text.</td>
</tr>
<tr>
<td>value_if_the</td>
<td>B$4</td>
<td>You want to return the adult ticket price (entered in cell B4) if the answer to your logical test is true, that is, the person is an adult. Note that the row reference in the cell reference is absolute ($4) because you do not want the row reference to increase when the formula is copied downwards.</td>
</tr>
<tr>
<td>logical test is true</td>
<td></td>
<td></td>
</tr>
<tr>
<td>value_if_the</td>
<td>B$5</td>
<td>You want to return the child ticket price (entered in cell B5) if the answer to your logical test is false, that is, the person is not an adult. Note that the row reference in the cell reference is absolute ($5) because you do not want the row reference to increase when the formula is copied downwards.</td>
</tr>
<tr>
<td>logical test is false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

- Delete the formula entered in range D9:D18.

- Enter the following formula in cell D9 and copy it to range D10:D18.

\[ =\text{IF}(B9=\text{"Child"},B\$5,B\$4) \]
<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>B9=&quot;Child&quot;</td>
<td>You want to evaluate if the person is a child (as indicated in cell B9). Note the relative reference of cell B9. Also note that &quot;Child&quot; is in quotes (&quot;&quot;&quot;) because you evaluate against text.</td>
</tr>
<tr>
<td>value_if_the logical_test_is_true</td>
<td>B$5</td>
<td>You want to return the child ticket price (entered in cell B5) if the answer to your logical test is true, that is, the person is a child. Note that the row reference in the cell reference is absolute ($5) because you do not want the row reference to increase when the formula is copied downwards.</td>
</tr>
<tr>
<td>value_if_the logical_test_is_false</td>
<td>B$4</td>
<td>You want to return the adult ticket price (entered in cell B4) if the answer to your logical test is false, that is, the person is not a child. Note that the row reference in the cell reference is absolute ($4) because you do not want the row reference to increase when the formula is copied downwards.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

- See what happens. Does the formula give you the desired result? Is the result different from the previous formula entered or is the result the same?

**Bear in mind** that there is usually more than one logical test that can apply in IF functions, and the true and false value will depend on your logical test.

- What will the formula in cell E9 be? Take into account that you will copy the formula to the rows below.
- Enter the formula below in cell E9 and copy it to range E10:E18. See what happens. Does the formula give you the desired result?
= IF(C9>=21,"Invite","Don’t invite")

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>C9&gt;=21</td>
<td>You want to evaluate if the person is 21 years and older as per the age indicated in cell C9. Note the relative reference of cell C9. Also, note that, in contrast to the previous IF formula, the 21 is not in quotes because you evaluate against a value and not text.</td>
</tr>
<tr>
<td>value_if_the logical_test_is_true</td>
<td>“Invite”</td>
<td>You want to return, “Invite”, if the answer to your logical test is true, that is, the person is 21 years and older. Note that “Invite” is in quotes (&quot;&quot;&quot;) because you want to return text.</td>
</tr>
<tr>
<td>value_if_the logical_test_is_false</td>
<td>“Don’t invite”</td>
<td>You want to return, “Don’t invite”, if the answer to your logical test is false, that is, the person is younger than 21. Note that “Don’t invite” is in quotes (&quot;&quot;&quot;) because you want to return text.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

- Delete the formula entered in range E9:E18.
- Enter the following formula in cell E9 and copy it to range E10:E18.

= IF(C9<21,"Don’t invite","Invite")

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
</tbody>
</table>
You want to evaluate whether the person is younger than 21 as per the age indicated in cell C9. Note the relative reference of cell C9. Also note that the 21 is not in quotes because you evaluate against a value and not text.

You want to return, “Don’t invite”, if the answer to your logical test is true that is, the person is younger than 21. Note that “Don’t invite” is in quotes (”) because you want to return text.

You want to return, “Invite”, if the answer to your logical test is false, that is, the person is 21 years and older. Note that “Invite” is in quotes (”) because you want to return text.

• See what happens. Does the formula give you the desired result? Is the result different from the previous formula entered or is it the same?

As explained previously, more than one logical test can usually apply in IF functions and the true and false value will depend on your logical test.

• What will the formula in cell F9 be? Take into account the fact that you will copy the formula to the rows below.

• Enter the formula below in cell F9 and copy it to range F10:F18. See what happens. Does the formula give you the desired result?

= IF(E9="Invite",D9+B$6,D9)

<table>
<thead>
<tr>
<th>Logical Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>logical_test</td>
<td>Begins with = sign</td>
</tr>
<tr>
<td>value_if_the_logical_test_is_true</td>
<td>Function name</td>
</tr>
<tr>
<td>value_if_the_logical_test_is_false</td>
<td>Opening parenthesis</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>logical_test</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>E9=&quot;Invite&quot;</td>
<td>You want to evaluate whether the person is invited to the after-party as calculated in cell E9. Note the relative reference of cell E9. Also note that “Invite” is in quotes (”) because you evaluate against text.</td>
</tr>
</tbody>
</table>
You want to return the **sum** of the ticket price (D9) and the after-party cost (B6) if the answer to your logical test is **true**, that is, the person is invited to the party. Note that the cell reference for D9 is relative, while the row reference in cell B$6 ($6) is absolute.

<table>
<thead>
<tr>
<th>value if the logical test is true</th>
<th>D9+B$6</th>
</tr>
</thead>
</table>

You want to return only the ticket price (D9) if the answer to your logical test is **false**, that is, the person is not invited to the party. Note the relative cell reference for D9.

<table>
<thead>
<tr>
<th>value if the logical test is false</th>
<th>D9</th>
</tr>
</thead>
</table>

Closing parenthesis

```
= IF(E9="Don't invite",D9,D9+B$6)
```

### Structure

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin with =</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td>You want to evaluate whether the person is not invited to the after party as calculated in cell E9. Note the relative reference of cell E9. Also note that “Don’t invite” is in quotes (”) because you evaluate against text.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>E9=&quot;Don't invite&quot;</td>
<td></td>
</tr>
<tr>
<td>value if the logical test is true</td>
<td>D9</td>
<td>You want to return only the ticket price (D9) if the answer to your logical test is <strong>true</strong>, that is, the person is not invited to the party. Note the relative cell reference for D9.</td>
</tr>
<tr>
<td>value if the logical test is false</td>
<td>D9+B$6</td>
<td>You want to return the <strong>sum</strong> of the ticket price (D9) and the after party cost (B6) if the answer to your logical test is <strong>false</strong>, that is, the person is invited to the party. Note that the cell reference for D9 is relative, while the row reference in cell B$6 ($6) is absolute.</td>
</tr>
</tbody>
</table>

- Delete the formula entered in range F9:F18.
- Enter the following formula in cell F9 and copy it to range F10:F18.

```
= IF(E9="Don't invite",D9,D9+B$6)
```
- Please save this file as “Activity 5.21” because it will be used in a subsequent activity.
- The results of activity 5.21

<table>
<thead>
<tr>
<th>Name</th>
<th>Adult/child</th>
<th>Age</th>
<th>Soccer Ticket price</th>
<th>Invite to after party</th>
<th>Total cost Soccer and After-party</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peter</td>
<td>Adult</td>
<td>43</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td>Sarah</td>
<td>Adult</td>
<td>40</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td>Thabo</td>
<td>Child</td>
<td>12</td>
<td>15</td>
<td>Don’t invite</td>
<td>15</td>
</tr>
<tr>
<td>Sandy</td>
<td>Child</td>
<td>10</td>
<td>15</td>
<td>Don’t invite</td>
<td>15</td>
</tr>
<tr>
<td>Thomas</td>
<td>Child</td>
<td>5</td>
<td>15</td>
<td>Don’t invite</td>
<td>15</td>
</tr>
<tr>
<td>Vive</td>
<td>Adult</td>
<td>32</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td>Abel</td>
<td>Child</td>
<td>8</td>
<td>15</td>
<td>Don’t invite</td>
<td>15</td>
</tr>
<tr>
<td>Riki</td>
<td>Child</td>
<td>9</td>
<td>15</td>
<td>Don’t invite</td>
<td>15</td>
</tr>
<tr>
<td>Martin</td>
<td>Adult</td>
<td>22</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td>Razia</td>
<td>Adult</td>
<td>19</td>
<td>30</td>
<td>Don’t invite</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>225</td>
</tr>
</tbody>
</table>

**NOTE:** MICROSOFT EXCEL WILL ALWAYS DISPLAY IN A CELL THE FINAL ANSWER(S)/VALUE(S) ON YOUR WORKSHEET PROVIDED THAT YOUR FORMULA IS CORRECT AND VALID, BUT SHOULD YOU WISH TO DISPLAY THE FORMULAS BEHIND YOUR FINAL ANSWERS (as per below) YOU NEED TO: Click on: Formulas tab/Show formulas (under Formula Auditing ribbon group).

To check a formula/function of each cell at a time, click on the cell containing the formula/function and press F2. This will indicate which cells are used in your formula/function because Excel then highlights the various cells used in colour.
**COUNTIF**

= COUNTIF(range, criteria)

This function counts the number of cells within a range that meet a single criteria as specified by you. For example, you can count all the cells with a certain number or word contained in it.

**Range:**
A continuous range of cells for which you want to count the data. The range will have a start cell reference and an end cell reference ie cell1:cell5.

**Criteria:**
A condition that must be met in order for the cell to be counted eg “Text A” or 500

In this study guide we will only explain using a =countif using basic criteria. The criteria will either be a fixed amount or specific text. Please refer to Excel Help if you want to use a more advanced condition such as a number that is greater or less than another number.

**Computer activity 15.22**

- Create a worksheet and enter the following data:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Model A</td>
<td>2002</td>
</tr>
<tr>
<td>4</td>
<td>Model A</td>
<td>2005</td>
</tr>
<tr>
<td>5</td>
<td>Model B</td>
<td>1999</td>
</tr>
<tr>
<td>6</td>
<td>Model C</td>
<td>2001</td>
</tr>
<tr>
<td>7</td>
<td>Model D</td>
<td>2006</td>
</tr>
<tr>
<td>8</td>
<td>Model A</td>
<td>2007</td>
</tr>
<tr>
<td>9</td>
<td>Model E</td>
<td>2014</td>
</tr>
<tr>
<td>10</td>
<td>Model D</td>
<td>2015</td>
</tr>
<tr>
<td>11</td>
<td>Model C</td>
<td>2007</td>
</tr>
<tr>
<td>12</td>
<td>Model A</td>
<td>2008</td>
</tr>
<tr>
<td>13</td>
<td>Model F</td>
<td>2010</td>
</tr>
<tr>
<td>14</td>
<td>Model D</td>
<td>2012</td>
</tr>
</tbody>
</table>

- In cell B17, calculate number of Model A vehicles in stock
- In cell B18, calculate number of Model D vehicle in stock
- In cell B19, calculate number of 2007 vehicle in stock
### Vehicle Database

<table>
<thead>
<tr>
<th>Model</th>
<th>Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model A</td>
<td>2002</td>
</tr>
<tr>
<td>Model A</td>
<td>2005</td>
</tr>
<tr>
<td>Model B</td>
<td>1999</td>
</tr>
<tr>
<td>Model C</td>
<td>2001</td>
</tr>
<tr>
<td>Model D</td>
<td>2006</td>
</tr>
<tr>
<td>Model A</td>
<td>2007</td>
</tr>
<tr>
<td>Model E</td>
<td>2014</td>
</tr>
<tr>
<td>Model D</td>
<td>2015</td>
</tr>
<tr>
<td>Model C</td>
<td>2007</td>
</tr>
<tr>
<td>Model A</td>
<td>2008</td>
</tr>
<tr>
<td>Model F</td>
<td>2010</td>
</tr>
<tr>
<td>Model D</td>
<td>2012</td>
</tr>
</tbody>
</table>

17. Number of Model A in stock: 4
18. Number of Model D in stock: 3
19. Number of 2007 model in stock: 2

17. Number of Model A in stock: =COUNTIF(A3:A14, "Model A")
18. Number of Model D in stock: =COUNTIF(A3:A14, "Model D")
(e) TEXT FUNCTIONS

Cell refers to the cell to which you want this function to apply.

Also note that a character is defined as **text, number, symbols** and spaces.

**LEFT FUNCTION**

= LEFT(cell,num_chars)

This function returns a specified number of characters (num_chars) from the start (left-hand side) of the text.

**Computer activity 5.23**

- Create a new worksheet.
- Enter the word FUNCTION in cell A3.
- In cell B3 enter the function =left(A3,3).
- The answer returned in cell B3 would be the first 3 characters of the word (ie FUN).

**Formula logic** = From the given word, start from left and return the first 3 characters of the given word.

**Computer activity 5.24**

- Use the same worksheet as in **activity 5.23**.
- Enter the characters “F*U NCT+I  ON” in cell A4.
- In cell B4 enter the function =left(A4,5).
- The answer returned in cell B4 will be the first 5 characters of the word (ie F*U N). Note that the space between the “U” and “N” is counted as a character.

**Formula logic** = From the given word, start from left and return the first 5 characters of the given word.
MID FUNCTION

\[ \text{MID(cell, start_num, num_chars)} \]

This function returns a specified number of characters from the middle of a text string given a starting position (start_num) and the length specified (num_chars).

**Computer activity 5.25**

- Use the same worksheet as in activity 5.23.
- In cell C3 enter the function =mid(A3,4,3).
- The answer returned in cell C3 will be “CTI”.

**Formula logic** = From the given word, start from the middle of the word (mid) but specifically from character 4 and from then, return the 3 characters of the given word.

**Computer activity 5.26**

- Use the same worksheet as in activity 5.23.
- In cell C4 enter the function =mid(A4,7,5).
- The answer returned in cell C4 would be “T+I O”. Note that the space between the “U” and “N” and the “I” and “O” is counted as a character.
RIGHT FUNCTION

=RIGHT(cell, num_chars)

This function returns a specified number of characters (num_chars) from the end (right-hand side) of the text.

**Computer activity 5.27**
- Use the same worksheet as in activity 5.23.
- In cell D3 enter the function =right(A3,3).
- The answer returned in cell D3 will be “ION”.

**Formula logic** = From the given word, start from right and return the 3 characters of the given word from the right.

**Computer activity 5.28**
- Use the same worksheet as in activity 5.23.
- In cell D4 enter the function =right(A4,5).
- The answer returned in cell D4 will be “+ION”. Note that the space between the “I” and “O” is counted as a character.

- The results of activities 5.23 to 5.28 should appear as follow:
(f) LOOKUP FUNCTIONS

= VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)

This function searches for a value in the leftmost (first) column of a range of cells, and returns a value in the same row from a column you specify.

Lookup_value

This is the value you want to search in the first column of the table_array (see table array below). Lookup_value can be a value, a cell reference or text. VLOOKUP returns the #N/A error value where the lookup_value is smaller than the smallest value in the first column of table_array.

Table_array

This range of cells (two or more columns) contains the data you want to look up. The lookup_value searches the values in the first column of table_array. The values in the first column of table_array can be text, numbers or values – upper-case and lower-case text are equivalent.

- If the range lookup is set as TRUE then the table_array must be sorted in ascending order based on the first column. See section 5.1 in this study unit on how to sort data.
- If range_lookup is set as FALSE, the table_array lookup value should be unique (primary key).
- The data in the first column of table_array should not contain leading spaces, trailing spaces, inconsistent use of quotation marks or non-printing characters because vlookup may return an incorrect or unexpected value.
- When searching for number or data values make sure the data in the first column of table_array is not stored as text but as values.

Col_index_num

This is the column number in table_array (refer to table_array above) from which the matching value should be returned. The number 1 will return the value in the first column of the table_array, while 2 will return the value in the second column of the table_array.

- VLOOKUP will return a #VALUE! error if the col_index_num is less than 1.
- VLOOKUP will return a #REF! error if the col_index_num is greater than the number of columns in table_array.

Range_lookup

This specifies whether you want VLOOKUP to find an exact or an approximate match.

- When set as TRUE, an exact or approximate match is returned – that is, if an exact match is not found, the next largest value that is less than lookup_value is returned.
- When set as FALSE, an exact match is found and the error value #N/A is returned if no match is found. If there is more than 1 value in the first table_array that matches the lookup_value, then the first value that is found is used.

Always use FALSE unless you have a good reason to do otherwise.
**VLOOKUP** means that Microsoft Office Excel will go vertically **down** a list until it finds the value it is looking for, then jump right to the appropriate column and return that information.

---

**Computer activity 5.29**

- Create a new worksheet.
- Enter the following data in the worksheet:

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assignment mark list</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Student nr</td>
<td>Name</td>
<td>Assignment mark</td>
</tr>
<tr>
<td>3</td>
<td>123456</td>
<td>Peter</td>
<td>80</td>
</tr>
<tr>
<td>4</td>
<td>234567</td>
<td>Sarah</td>
<td>65</td>
</tr>
<tr>
<td>5</td>
<td>345678</td>
<td>Thabo</td>
<td>34</td>
</tr>
<tr>
<td>6</td>
<td>456789</td>
<td>Sandy</td>
<td>56</td>
</tr>
<tr>
<td>7</td>
<td>567890</td>
<td>Thomas</td>
<td>48</td>
</tr>
<tr>
<td>8</td>
<td>678901</td>
<td>Viwe</td>
<td>78</td>
</tr>
<tr>
<td>9</td>
<td>789012</td>
<td>Abel</td>
<td>51</td>
</tr>
<tr>
<td>10</td>
<td>890123</td>
<td>Rikki</td>
<td>49</td>
</tr>
<tr>
<td>11</td>
<td>912345</td>
<td>Martin</td>
<td>63</td>
</tr>
</tbody>
</table>

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Exam mark list</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Student nr</td>
<td>Name</td>
</tr>
<tr>
<td>15</td>
<td>789012</td>
<td>Abel J</td>
</tr>
<tr>
<td>16</td>
<td>912345</td>
<td>Martin Q</td>
</tr>
<tr>
<td>17</td>
<td>123456</td>
<td>Peter R</td>
</tr>
<tr>
<td>18</td>
<td>890123</td>
<td>Rikki B</td>
</tr>
<tr>
<td>19</td>
<td>456789</td>
<td>Sandy D</td>
</tr>
<tr>
<td>20</td>
<td>234567</td>
<td>Sarah M</td>
</tr>
<tr>
<td>21</td>
<td>345678</td>
<td>Thabo H</td>
</tr>
<tr>
<td>22</td>
<td>567890</td>
<td>Thomas V</td>
</tr>
<tr>
<td>23</td>
<td>678901</td>
<td>Viwe C</td>
</tr>
</tbody>
</table>

- You want to create one list with both the exam marks and final marks beside each student’s name. You have decided to reflect the exam marks beside the assignment marks but you do not want to go and find each student’s exam mark manually and then type it beside the assignment marks. You also know that the student number is unique to each student and reflected in both sets of data. How can you do this?
• You can use the VLOOKUP. What formula would you enter?
• In cell D3 enter =VLOOKUP(A3,A$15:C$23,3,FALSE).

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>VLOOKUP</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Lookup_value</td>
<td>A3</td>
<td>The value you want to look up in the exam mark list (table_array) is the student number, which is reflected in cell A3 in the assignment mark list.</td>
</tr>
<tr>
<td>Table_array</td>
<td>A$15:C$23</td>
<td>You will find the data for the exam marks in this range of cells. Note that the student number is in the first column (A) of the data range because the value you are looking for should always be in the first column. Also note that the row references are absolute because you do not want the data range reference to change when you copy the formula.</td>
</tr>
<tr>
<td>Col_index_num</td>
<td>3</td>
<td>The values you are looking for, the exam marks are in column C, the third (3) column of the table_array.</td>
</tr>
<tr>
<td>Range_lookup</td>
<td>FALSE</td>
<td>It is set as FALSE because you want to find the exact match for the student number.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

- Copy the formula in cell D3 to range D4:D11.
- Manually check to see if the formula gave the correct exam mark to the correct student.
  - Why was the student name not used as the lookup_value? The reason is that there may be more than one student with the same name and because the student name in the two lists are not EXACTLY the same.
  - Why was absolute references used for the table_array, but not for the lookup_value?
  - Why was range_lookup specified?
The results should appear as follow:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment mark list</td>
<td>Student nr</td>
<td>Name</td>
<td>Assignment mark</td>
</tr>
<tr>
<td>1</td>
<td>123456</td>
<td>Peter</td>
<td>80</td>
</tr>
<tr>
<td>2</td>
<td>234567</td>
<td>Sarah</td>
<td>65</td>
</tr>
<tr>
<td>3</td>
<td>345678</td>
<td>Thabo</td>
<td>34</td>
</tr>
<tr>
<td>4</td>
<td>456789</td>
<td>Sandy</td>
<td>56</td>
</tr>
<tr>
<td>5</td>
<td>567890</td>
<td>Thomas</td>
<td>48</td>
</tr>
<tr>
<td>6</td>
<td>678901</td>
<td>Viwe</td>
<td>78</td>
</tr>
<tr>
<td>7</td>
<td>789012</td>
<td>Abel</td>
<td>51</td>
</tr>
<tr>
<td>8</td>
<td>890123</td>
<td>Rikki</td>
<td>49</td>
</tr>
<tr>
<td>9</td>
<td>912345</td>
<td>Martin</td>
<td>63</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exam mark list</th>
<th>Student nr</th>
<th>Name</th>
<th>Exam marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>789012</td>
<td>Abel J</td>
<td>64</td>
</tr>
<tr>
<td>16</td>
<td>912345</td>
<td>Martin Q</td>
<td>57</td>
</tr>
<tr>
<td>17</td>
<td>123456</td>
<td>Peter R</td>
<td>45</td>
</tr>
<tr>
<td>18</td>
<td>890123</td>
<td>Rikki B</td>
<td>49</td>
</tr>
<tr>
<td>19</td>
<td>456789</td>
<td>Sandy D</td>
<td>53</td>
</tr>
<tr>
<td>20</td>
<td>234567</td>
<td>Sarah M</td>
<td>62</td>
</tr>
<tr>
<td>21</td>
<td>345678</td>
<td>Thabo H</td>
<td>72</td>
</tr>
<tr>
<td>22</td>
<td>567890</td>
<td>Thomas V</td>
<td>55</td>
</tr>
<tr>
<td>23</td>
<td>678901</td>
<td>Viwe C</td>
<td>46</td>
</tr>
</tbody>
</table>

**Lookup_value**
The value you want to find in the table_array (exam mark list) 1st column

**Table_array**
Range where you can find the data

**Col_index_num:**
- 1: Assignment mark
- 2: Exam marks
- 3: Assignment mark

**Col_index_num:**
- 1: Exam marks
- 2: Assignment mark
- 3: Exam marks

D3 = VLOOKUP(A3,A$15:C$23,3,FALSE)
**Computer activity 5.30**

- Create a new worksheet.
- You have calculated the taxable income for a number of friends and now want to determine their applicable “Fixed tax amount” and “Tax rate”.
- You have created the following spreadsheet with each person's taxable income as well as the tax table. Enter the following data in the worksheet:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Taxable income</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>Taxable income</td>
<td>Fixed tax amount</td>
<td>Tax rate</td>
</tr>
<tr>
<td>3</td>
<td>Peter</td>
<td>358,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sarah</td>
<td>279,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Thabo</td>
<td>155,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Sandy</td>
<td>86,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Thomas</td>
<td>198,600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Viwe</td>
<td>412,300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Abel</td>
<td>567,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Rikki</td>
<td>654,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Martin</td>
<td>220,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>Tax table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Taxable income</td>
<td>Fixed tax amount</td>
<td>Tax rate above lower limit-1</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Lower bracket</td>
<td>Upper bracket</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>150,000</td>
<td>0</td>
<td>18%</td>
</tr>
<tr>
<td>17</td>
<td>150,001</td>
<td>235,000</td>
<td>27,000</td>
<td>25%</td>
</tr>
<tr>
<td>18</td>
<td>235,001</td>
<td>325,000</td>
<td>48,250</td>
<td>30%</td>
</tr>
<tr>
<td>19</td>
<td>325,001</td>
<td>455,000</td>
<td>75,250</td>
<td>35%</td>
</tr>
<tr>
<td>20</td>
<td>455,001</td>
<td>580,000</td>
<td>120,750</td>
<td>38%</td>
</tr>
<tr>
<td>21</td>
<td>580,001</td>
<td>-</td>
<td>168,250</td>
<td>40%</td>
</tr>
</tbody>
</table>
• You do not want to look up each person’s fixed tax amount and tax rate individually but want to use a Microsoft Office Excel formula. Which formula would you enter in cell C3? You would copy this formula to the rows below.

In cell C3 enter =VLOOKUP(B3,A$16:D$21,3,TRUE).

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>VLOOKUP</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Lookup_value</td>
<td>B3</td>
<td>The value you want to look up in the tax table (table_array) is the taxable income, which is reflected in cell B3.</td>
</tr>
<tr>
<td>Table_array</td>
<td>A$16:D$21</td>
<td>You want to look for the values in the tax table which can be found in this range of cells. Note that the value for which the lookup_value is looking should be in the first column of the data range (column A in this example). Also note that the row references are absolute because the cell references should not change when you copy the formula downwards.</td>
</tr>
<tr>
<td>Col_index_num</td>
<td>3</td>
<td>When you find the row with the data you are looking for, this will indicate to the function which column's data you want to be returned. The fixed tax amount is in column C, the third column of the table_array.</td>
</tr>
<tr>
<td>Range_lookup</td>
<td>TRUE</td>
<td>It is set as TRUE because you want to find the next largest value that is less than the lookup value – that is, you want to find the lower bracket of the tax group.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>
- In cell D3 enter =VLOOKUP(B3,A$16:D$21,4,TRUE).

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>VLOOKUP</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>lookup_value</td>
<td>B3</td>
<td>The value you want to look up in the tax table (table_array) is the taxable income, which is reflected in cell B3.</td>
</tr>
<tr>
<td>Table_array</td>
<td>A$16:D$21</td>
<td>You want to look for the values in the tax table that can be found in this range of cells. Note the value for which the lookup_value is looking to match against should be in the first column (column A in this example) of the data range. Also note that the row references are absolute because the cell references should not change when you copy the formula downwards.</td>
</tr>
<tr>
<td>Col_index_num</td>
<td>4</td>
<td>This tells the function which column's data you want to be returned that is included in the row containing the data you are looking for. The tax rates are in column D, the fourth column of the table_array.</td>
</tr>
<tr>
<td>Range_lookup</td>
<td>TRUE</td>
<td>It is set as TRUE because you want to find the next largest value that is less than the lookup value – that is, you want to find the lower bracket of the tax group in which the taxable amount belongs.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

- Copy the formula in C3 to range C4:C11 and copy the formula in D3 to range D4:D11.
- The results should appear as follows:
### Taxable income

<table>
<thead>
<tr>
<th>Name</th>
<th>Taxable income</th>
<th>Fixed tax amount</th>
<th>Tax rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peter</td>
<td>359,000</td>
<td>75,250</td>
<td>35%</td>
</tr>
<tr>
<td>Sarah</td>
<td>279,000</td>
<td>48,250</td>
<td>30%</td>
</tr>
<tr>
<td>Thabo</td>
<td>155,000</td>
<td>27,000</td>
<td>25%</td>
</tr>
<tr>
<td>Sandy</td>
<td>86,000</td>
<td>0</td>
<td>18%</td>
</tr>
<tr>
<td>Thomas</td>
<td>198,600</td>
<td>27,000</td>
<td>25%</td>
</tr>
<tr>
<td>Vive</td>
<td>412,300</td>
<td>75,250</td>
<td>35%</td>
</tr>
<tr>
<td>Abel</td>
<td>567,000</td>
<td>120,750</td>
<td>38%</td>
</tr>
<tr>
<td>Rikki</td>
<td>654,000</td>
<td>168,250</td>
<td>40%</td>
</tr>
<tr>
<td>Martin</td>
<td>220,000</td>
<td>27,000</td>
<td>25%</td>
</tr>
</tbody>
</table>

### Tax table

<table>
<thead>
<tr>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Tax rate above lower limit</th>
<th>Col_index num: 1</th>
<th>Col_index num: 2</th>
<th>Col_index num: 3</th>
<th>Col_index num: 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>150,000</td>
<td>0</td>
<td>18%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>150,001</td>
<td>235,000</td>
<td>27,000</td>
<td>25%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>235,001</td>
<td>325,000</td>
<td>48,250</td>
<td>30%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>325,001</td>
<td>455,000</td>
<td>75,250</td>
<td>35%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>455,001</td>
<td>580,000</td>
<td>120,750</td>
<td>38%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>580,001</td>
<td>-</td>
<td>168,250</td>
<td>40%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Labeled parts

- **Lookup_value**: The value you want to find in the table_array (tax table) 1st column.
- **The values (always in the 1st column)**, which the lookup function will look at, to see where the amount is which is just smaller than the lookup value.
- **Table_array Range where you can find the data**
- **Col_index num:** 1, 2, 3, 4
5 WORKING WITH DATA

5.1 Sorting data

Sorting data is a great tool to present your information neatly and logically or to analyse data. You can use it to put a list of names in alphabetical order, arrange amounts from highest to lowest or from biggest to smallest or arrange dates from earliest to latest. You can either sort the data in ascending order (going up/lowest to the highest) or descending order (going down/highest to lowest). You can also sort the data based on sorting criteria for more than one column.

Make sure you select the whole range you want to sort and not only the column on which you want to base the sort. The data in the other columns beside the particular column will not follow the sort if you only select the column on which you want to base the sort.

**Computer activity 5.31**

- Use the completed spreadsheet in *activity 5.21*
- We first want to sort the adult and child indicator per column B so that all the children are reflected first. At the same time, we also want to sort the ages for each group (column C) from youngest to oldest.
- Select range A8:F18.
- Click on the Data tab on the Ribbon.
- In the Sort & Filter ribbon group, click on the Sort icon.
- This will open the following Sort dialog box:

  ![Sort dialog box]

  - Ensure that the My data has headers box has been ticked (otherwise the headers will be sorted inside the data).
• Click on the arrow in the **Sort by** dialog box and select **Adult/child** from the drop-down menu.
• Click on the arrow in the **Sort on** dialog box and select **Values** from the drop-down menu.
• Click on the arrow in the **Order** dialog box and select **Z to A** from the drop-down menu.

**Should you wish to further sort your data based on further criteria.**

• Click on **Add Level** to add another sort criteria (you can add as many as you need).
• Click on the arrow in the **Then by** dialog box and select **Age** from the drop-down menu.
• Click on the arrow in the **Sort on** dialog box (in the **Then by** row) and select **Values** from the drop-down menu.
• Click on the arrow in the **Order** dialog box (in the **Then by** row) and select **Smallest to Largest** from the drop-down menu.

• Your complete selection will appear as follows:

![Sort dialog box](image)

• Click **OK** to apply the selected sorting criteria to your data
The result of the sort will appear as follows:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soccer match and after party</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price per person</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Soccer ticket - Adult</td>
<td>R 30.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Soccer ticket - Child</td>
<td>R 15.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>After party</td>
<td>R 100.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Adult/child</td>
<td>Age</td>
<td>Soccer Ticket price</td>
<td>Invite to after party</td>
<td>Total cost Soccer and After-party</td>
</tr>
<tr>
<td>Thomas</td>
<td>Child</td>
<td>5</td>
<td>15</td>
<td>Don't invite</td>
<td>15</td>
</tr>
<tr>
<td>Abel</td>
<td>Child</td>
<td>8</td>
<td>15</td>
<td>Don't invite</td>
<td>15</td>
</tr>
<tr>
<td>Rikki</td>
<td>Child</td>
<td>9</td>
<td>15</td>
<td>Don't invite</td>
<td>15</td>
</tr>
<tr>
<td>Sandy</td>
<td>Child</td>
<td>10</td>
<td>15</td>
<td>Don't invite</td>
<td>15</td>
</tr>
<tr>
<td>Thabo</td>
<td>Child</td>
<td>12</td>
<td>15</td>
<td>Don't invite</td>
<td>15</td>
</tr>
<tr>
<td>Razia</td>
<td>Adult</td>
<td>19</td>
<td>30</td>
<td>Invite</td>
<td>30</td>
</tr>
<tr>
<td>Martin</td>
<td>Adult</td>
<td>22</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td>Vive</td>
<td>Adult</td>
<td>32</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td>Sarah</td>
<td>Adult</td>
<td>40</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td>Peter</td>
<td>Adult</td>
<td>43</td>
<td>30</td>
<td>Invite</td>
<td>130</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>225</td>
<td></td>
<td>625</td>
</tr>
</tbody>
</table>

5.2 Filter data

Filtering data allows you to display only the rows that meet your specified criteria and to hide the rows you do not want displayed. You can also filter by more than one column, but remember that filters are additive, which means each additional filter is based on the current filter, and further reduces the subset of data. The filter will only apply to the selected data range. You can copy, find, edit, format, chart and print the subset of filtered data without rearranging or moving it. You can only filter by a list values, a format or criteria. However, each of these filters is mutually exclusive. You can, for example, filter by font colour or by a list of numbers, but not both.

**Computer activity 5.32**

- Use the completed spreadsheet of activity 5.21.
- Select range A8:F18.
- Click on the Data tab.
- In the Sort & Filter group, click on the Filter icon.
- This will create drop-down arrows next to each column heading.
- Click on the drop-down arrow next to “Invite to after party”.
- In the drop-down menu only select “Don’t invite”.
- Click on OK.
• Only the rows with “Don’t invite” in that column are displayed and they will appear as follows:

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Thabo</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sandy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Thomas</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Abel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Ruki</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Razia</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• Did you notice the following:
  – The filter icon is displayed on the drop-down arrow next to “Invite to after party”. This indicates that a filter is applied on that column.
  – The row reference displayed seems to be missing rows, that is, only rows 1 to 8, 11 to 13 and 15 to 18 are displayed. The applied filter did not delete rows 9, 10 and 14 but only hid them from view.

• We now only want to display all the persons who were not invited but who are younger than 10. To do this we will apply an additional filter.
  • Click on the drop-down arrow next to “Age” and select Number Filters.
  • In the drop-down menu select Less Than….
  • This will open the Custom AutoFilter dialog box.
  • Click on the box to the right of is less than and either type 10 or select 10 from the drop-down menu.
  • Click OK to action the filter.
• Only the rows with “Don’t invite” in column E and where the person’s age (column C) is less than 10 are displayed and the rest of the rows are hidden. The spreadsheet will appear as follows:

<table>
<thead>
<tr>
<th></th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Soccer match and after party</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Price per person</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Soccer ticket - Adult</td>
<td>R 30.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Soccer ticket - Child</td>
<td>R 15.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>After party</td>
<td>R 100.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Name</td>
<td>Adult/child</td>
<td>Age</td>
<td>Invite to after party</td>
<td>Total cost Soccer and After party</td>
</tr>
<tr>
<td>13</td>
<td>Thomas</td>
<td>Child</td>
<td>5</td>
<td>Don’t invite</td>
<td>16</td>
</tr>
<tr>
<td>15</td>
<td>Abel</td>
<td>Child</td>
<td>8</td>
<td>Don’t invite</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>Rikki</td>
<td>Child</td>
<td>9</td>
<td>Don’t invite</td>
<td>15</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• Did you notice the following?
  – The filter icon is displayed on the drop-down arrow next to “Invite to after party” and “Age”. The filter icon indicates that a filter has been applied on that column.
  – The row reference displayed seems to be missing rows – that is, rows 1–8, 13, 15, 16, but not the other rows, are displayed. The applied filters did not delete the other rows but only hid them.

• To remove a filter from a particular column, click on the applicable column’s drop-down arrow and tick next to [Select All]. You can also change the filter by clicking on the applicable column’s drop-down arrow and selecting the new filter you want to apply.

• To remove all filters in total from the data range follow the following steps:
  – Select the data range that was filtered.
  – Click on the Data tab.
  – In the Sort & Filter group, click on the Filter icon to deselect the filter option.
6 WORKING WITH CHARTS

Charts are visual/graphical representations of data and are useful in helping to understand and interpret the data presented. Charts sometimes make it easier to identify trends in data.

Bear in mind that the people looking at a chart do not have the underlying data in front of them, so it is vital to ensure that the following are always included in a chart:

- **A chart title.** The title of your chart needs to be descriptive and indicate what your chart is all about.
- **Primary Horizontal axis title.** This is a short description of the categories on the horizontal axis.
- **Primary Vertical axis title.** This is a short description of the values on the vertical axis.
- **Legend.** This indicates what colour represents which particular data series.

6.1 Creating a graph and a chart

To create a chart, follow the steps below.

**Computer activity 5.33 – Creating a Graph**

- Create the following data in a new Workbook file on Sheet1:
  - “Total sales R (Actual)” is calculated as the applicable number of “Items sold (Actual)” * R150.
  - “Total sales R (Budget)” is calculated as the applicable number of “Items sold (Budget)” * R100.
- Save the Workbook file as “GRAPH”.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SA Textbooks Pty Ltd</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Items sold (Actual)</td>
<td>Items sold (Budget)</td>
<td>Total sales R (Actual)</td>
<td>Total sales R (Budget)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Jan</td>
<td>1567</td>
<td>1500</td>
<td>235,050</td>
<td>150,000</td>
</tr>
<tr>
<td>5</td>
<td>Feb</td>
<td>975</td>
<td>1000</td>
<td>146,250</td>
<td>100,000</td>
</tr>
<tr>
<td>6</td>
<td>Mar</td>
<td>445</td>
<td>560</td>
<td>66,750</td>
<td>56,000</td>
</tr>
<tr>
<td>7</td>
<td>Apr</td>
<td>1249</td>
<td>1300</td>
<td>187,350</td>
<td>130,000</td>
</tr>
<tr>
<td>8</td>
<td>May</td>
<td>368</td>
<td>300</td>
<td>55,200</td>
<td>30,000</td>
</tr>
<tr>
<td>9</td>
<td>Jun</td>
<td>1345</td>
<td>1100</td>
<td>201,750</td>
<td>110,000</td>
</tr>
</tbody>
</table>
Excel is very particular when a data range is selected. The range SHOULD be selected correctly the first time. For example, in this activity, do not move your mouse pointer over column D and then back to column C.

- Select range A3:E10
- While the above-mentioned range is selected:
  - Click on the Insert tab.
  - In the Charts ribbon group, click on the dialog box launcher (the arrow at the bottom left corner) to launch the “Insert Chart” window.
  - In the “All Charts” tab, select the third option “Column” – Here you have a number of options to choose from. (Hovering with your mouse pointer over the different chart icons will make the description of the icon appear).
  - Within the “Column” options, select the first option “Clustered Column”, again you have a number of options available to you (see the top of the “Insert Chart” screen).
  - The “Insert Chart” window, gives you a preview of what your final chart will look like.
  - Select the first potion under Clustered Column and then click on OK to apply the selected options. (If you click on Cancel the creating of the chart will be cancelled).
You will notice that the graph inserted into your worksheet is a basic chart with only a chart title and legend, without any axis titles. You are going to update the graph to be more user-friendly.

Click anywhere on the graph. You will notice that a new tab is now available on the ribbon: Chart Tools. The Chart Tools will add two more tabs to the ribbon: “Design” and “Format”.

Under the Design mode, a number of functions can be performed to refine your chart according to your preferences.

On the “Charts Layouts” ribbon group, click on the drop-down arrow on the “Add Chart Element” icon.

An element box will open, with options such as Axis, Axis Titles, Chart Title etc.

Click on Chart Title, select the “Above Chart” option

This will open a text box in the chart area above the chart with the text “Chart Title”.

Click in the text box and delete “Chart Title”. Type in “Textbooks sold per month”.

In the textbox, highlight “Textbooks sold per month”.

155
Click on the Home tab and change the font of the chart title to Arial, font size 16, Bold and Italic.

- You can change your primary horizontal and vertical axis titles by clicking on “Add Chart Element”/“Axes” or you can double click anywhere on the axis; the “Format Axis”-window will open on the right hand side.
- On the “Charts Layouts” ribbon group, click on the drop down arrow on the “Add Chart Element” icon.
- Select “Axis Titles” and then “Primary Horizontal”
- This will open a text box in the chart area, below the chart, with the text “Axis title”.
- Click in the box and delete and delete “Axis title”. Type in “Months”.
- On the “Charts Layouts” ribbon group, click on the drop down arrow on the “Add Chart Element” icon.
- Select “Axis Titles” and then “Primary Vertical”
- This will open a text box in the chart area, on the left hand side of the chart, with the text “Axis title”.
- Click in the box and delete and delete “Axis title”. Type in “Number”.
- Should you wish to move your chart/graph to a different location, you can do so by: Click on “Move Chart” icon on the “Location” ribbon group on the “Design” tab on the “Chart tools” tab, then select the new location as “New Sheet” and change the name from “Chart1” to “Number”.
- Click on “OK”.

Did you notice that the graph was moved to a new worksheet called “Number”?

- Save the workbook file as “GRAPH”.
- The graph you created should appear as follows:
Computer activity 5.34 – Creating a chart

- Use the worksheet created in activity 5.33 (ie the file called “GRAPH”).
- Select ranges A3:A9 and D3:E9 simultaneously by using the control key.
  - This is done by selecting range A3:A9.
  - While the above-mentioned range is selected, press the “CTRL” (control) key on the keyboard.
  - While the “CTRL” (control) key is pressed down, used the mouse to select range D3:E9.
- While the above-mentioned range is selected, click on the Insert tab on the Ribbon.
  - In the Charts ribbon group, click on the dialog box launcher (the arrow in the bottom right corner) to open the “Insert Chart” window.
  - In the “All Charts” tab, select the fourth option “Line” – Here you have a number of options to choose from. (Hovering with your mouse pointer over the different chart icons will make the description of the icon appear).
  - Within the “Line” options, select the first option “Line”, again you have a number or options available to you (see the top of the “Insert Chart” screen).
  - The “Insert Chart” window, gives you a preview of what your final chart will look like.
  - Select the first potion under Line and then click on OK to apply the selected options. (If you click on Cancel the creating of the chart will be cancelled).
You will notice that the graph inserted into your worksheet is a basic chart with only a chart title and legend, without any axis titles. You are going to update the graph to be more user-friendly.

- On the “Charts Layouts” ribbon group, click on the drop-down arrow on the “Add Chart Element” icon.
- An element box will open, with options such as Axis, Axis Titles, Chart Title etc.
- Click on Chart Title, select the “Above Chart” option
- This will open a text box in the chart area above the chart with the text “Chart Title”.
- Click in the text box and delete “Chart Title”. Type in “Total sales per month”.
- On the “Charts Layouts” ribbon group, click on the drop down arrow on the “Add Chart Element” icon.
- Select “Axis Titles” and then “Primary Horizontal”
- This will open a text box in the chart area, below the chart, with the text “Axis title”.
- Click in the box and delete and delete “Axis title”. Type in “Month”.
- On the “Charts Layouts” ribbon group, click on the drop down arrow on the “Add Chart Element” icon.
- Select “Axis Titles” and then “Primary Vertical”
- This will open a text box in the chart area, on the left hand side of the chart, with the text “Axis title”.
- Click in the box and delete and delete “Axis title”. Type in “Rand”.
- On the “Charts Layouts” ribbon group, click on the drop-down arrow on the “Add Chart Element” icon.
- Select “Legend” and then “Right”.
- Click on the “Move Chart” icon on the “Location” ribbon on the “Design” tab on the “Chart tools” tab, then select the new location as “Object in” and select “Sheet2” from the drop down menu (click on the arrow to activate the menu).
- Click on “OK”.

Did you notice that the graph was moved to Sheet 2?

- Save the workbook file “GRAPH”.
- The graph you created should appear as follows:
6.2 Updating data in a chart

(a) Updating source data

You can update the range of data the chart is reading after it was created. For example, you would use this to add an additional month’s information as it becomes available.

Computer activity 5.35

- Click on the graph created in activity 5.33.
- Click on the Design tab on the Ribbon.
- In the Data ribbon group, click on the Select data icon.
- This will open the Select Data Source Data dialog box.

- Note that your current data selection (range A3:C7) has dotted lines around it.
- Also note the current Chart data range: =Sheet1!$A$3:$C$7.
- Update the data range to include May and June’s data by
  o clicking on the table with the data and re-selecting the data range (ie A3:C9) to include the data range of the two months (note that your new data selection has dotted lines around it)
  OR
  o changing the information in the Chart data range: box from =Sheet1!$A$3:$C$7 to =Sheet1!$A$3:$C$9

- Click on OK to apply the updated range.
• The updated graph will appear as follows:

(b) Changing the chart type

Microsoft Office Excel provides many different type of charts, including 3D charts. You can change the type of chart after you

Computer activity 5.36

- Click on the chart created in activity 5.33 or activity 5.35.
- Click on the Design tab on the Chart Tools tab.
- In the Type group, click on the Change Chart Type icon.
- This will open the Change Chart Type dialog box.
- Experiment by choosing different types of charts.
- Click on OK to action the change.

(c) Changing the chart layout and format

You can customise your chart to give it your own individual look. You can, for example, apply specific shape styles and format the shapes and text of chart elements.

Computer activity 5.37

- Click on the chart created in activity 5.34, activity 5.35 or activity 5.36.
- Click on the “Design” tab on the “Chart Tools” tab.
- Click on the “Quick Layouts” icon on the “Chart Layouts” group.
- Experiment by selecting different formats from the “Quick Layouts” tab.
- Click on OK to action the changes.
7 WORKING WITH PIVOT TABLES

“A pivot table is a special Excel tool that allows you to summarize and explore data interactively. It allows you to extract and summarize significant information from a large population of data. It is one of the most used Excel tools in practice.

It improves efficiency as large amount of data can be summarized and analyzed at a fraction of the time.

Computer activity 5.38 – Millenium Clothing (Pty) Ltd “MC”

MC is a clothing company that both manufactures and sells a wide variety of clothing items to the South African market. Under the new Employment Equity legislation, MC was identified as a critical organization within a critical industry (Textile) and it is thus required to increase women participation within their senior and executive management ranks to at least 45% and also ensure that its workforce is at least 80% permanent workers. The identification of the textile industry as a critical sector was at the back of its pivotal importance to the improvement of the country’s economic growth and the youth employment prospects.

As a critical organization, MC is eligible to receive a R2.5m grant from the government on a monthly basis, provided that the 45% women participation and the 80% permanent workers requirements are met and maintained. Mr. Andrew Potgieter (the CEO) is unsure about the organization’s current employment equity levels and is therefore unable to motivate for the R2.5m grant. Mr. Potgieter has thus asked you to help analyse the organization’s headcount and then provide a report on its employment equity levels.

After having a number of discussions with the CEO and subsequently performing a work-through exercise, you are of the opinion that the Microsoft Office Excel's pivot tables will offer an added-value solution to Mr. Potgieter’s request.
Your walk-through exercise provided the following three key information:

- In total MC currently employs 20 permanent employees in various divisions and 50 contract workers in the factory (operations).
- MC has following 5 departmental divisions:
  - Marketing
  - Finance
  - Operations
  - Sales
  - Human Resource (HR)
  - Executive
- MC’s job grading is as follows:
  - EX = Executive Management
  - JM = Junior Management
  - MM = Middle Management
  - SM = Senior Management
  - GA = Grade A
  - GB = Grade B
Open a new excel worksheet, name it “MC Pivot” and enter the below data

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>Surname</td>
<td>Gender</td>
<td>Grade</td>
<td>Division</td>
<td>Type</td>
<td>Count</td>
</tr>
<tr>
<td>3</td>
<td>Tumelo</td>
<td>Kekana</td>
<td>Male</td>
<td>EX</td>
<td>Executive</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>Chantelle</td>
<td>Da Silva</td>
<td>Female</td>
<td>MM</td>
<td>Marketing</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>Craig</td>
<td>Cronje</td>
<td>Male</td>
<td>GA</td>
<td>Operations</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>Peter</td>
<td>Small</td>
<td>Male</td>
<td>EX</td>
<td>Executive</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>John</td>
<td>Plant</td>
<td>Male</td>
<td>EX</td>
<td>Executive</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>Mohammed</td>
<td>Naicker</td>
<td>Male</td>
<td>JM</td>
<td>Operations</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>9</td>
<td>Lerato</td>
<td>Zwane</td>
<td>Female</td>
<td>JM</td>
<td>Finance</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>Timothy</td>
<td>Kambule</td>
<td>Male</td>
<td>GA</td>
<td>Operations</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>11</td>
<td>Grace</td>
<td>Mothwa</td>
<td>Female</td>
<td>GB</td>
<td>Finance</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>Bellinda</td>
<td>Pretorius</td>
<td>Female</td>
<td>SM</td>
<td>HR</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>13</td>
<td>Hector</td>
<td>Arendse</td>
<td>Male</td>
<td>JM</td>
<td>Operations</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>Lesley</td>
<td>Front</td>
<td>Female</td>
<td>SM</td>
<td>Sales</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>Daisy</td>
<td>Kruger</td>
<td>Female</td>
<td>EX</td>
<td>Executive</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>16</td>
<td>James</td>
<td>King</td>
<td>Male</td>
<td>MM</td>
<td>Production</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>17</td>
<td>Kamogelo</td>
<td>Ngobeni</td>
<td>Female</td>
<td>JM</td>
<td>Finance</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>18</td>
<td>Kim</td>
<td>Govender</td>
<td>Female</td>
<td>SM</td>
<td>Finance</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>19</td>
<td>Andrew</td>
<td>Potgieter</td>
<td>Male</td>
<td>EX</td>
<td>Executive</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>20</td>
<td>Sello</td>
<td>Lobese</td>
<td>Male</td>
<td>GB</td>
<td>Operations</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>21</td>
<td>Grace</td>
<td>Prichard</td>
<td>Female</td>
<td>JM</td>
<td>HR</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>22</td>
<td>Nancy</td>
<td>Lebelo</td>
<td>Female</td>
<td>GB</td>
<td>Operations</td>
<td>Permanent</td>
<td>1</td>
</tr>
<tr>
<td>23</td>
<td>General Workers</td>
<td>General Workers</td>
<td>Male</td>
<td>GB</td>
<td>Operations</td>
<td>Contract</td>
<td>32</td>
</tr>
<tr>
<td>24</td>
<td>General Workers</td>
<td>General Workers</td>
<td>Female</td>
<td>GB</td>
<td>Operations</td>
<td>Contract</td>
<td>18</td>
</tr>
</tbody>
</table>

PLEASE NOTE: For a pivot table to work, **all the columns** from which pivot table will be created from need to have headings, see range A2:G2.

- Creating a pivot table on “**Gender**” and “**Grade**”
  
  1. In the **MC Pivot** worksheet, place your cursor on cell K2, OR any other cell you prefer to put the pivot, as long as is not in the data range A1:G24.
  2. Click on “**Insert**” tab on the ribbon.
  3. On the **Tables** ribbon group, click on “**Pivot Table**” icon
  4. The **Create PivotTable** window will then appear.
  5. Click on the **Table/Range**: window and with your mouse, select the data range as A2:G24
  6. Click on “**Existing Worksheet**” – this option give you an opportunity to specify the desired location for the pivot table.
  7. **Location** window is based on the cell selected above in step (1) above, should you wish to change the location of the pivot, it can be done here.
  8. Click on **OK**, to apply all the selected settings.
9. Click on OK, to apply all the selected settings.

10. The “PivotTable Fields” window will appear as follows:

![PivotTable Fields Window]

11. The “PivotTable Fields” window is used to create the structure of the pivot table, for this example the pivot structure is created as follows:

- Click and drag the “Gender” icon in “Choose fields to add to report” and drop it on the “Columns” window.
- Click and drag the “Grade” icon in “Choose fields to add to report” and drop it on the “Rows” window
- Click and drag the “Count” icon in “Choose fields to add to report” and drop it on the “Values” window

12. The created Pivot table will appear as follows: Take note the value format of the pivot table automatically default to “Sum” of variables within the scenario, in this example is the “Sum of Count”. 

![Created Pivot Table]

164
Based on the requirements of this activity to display the results in % format, the below additional activities will still need to be performed.

13. Click on cell K13, and repeat the steps 2 to 9 to create another pivot table.
14. In the "PivotTable Fields" widow, locate the "Values" icon and click on drop-down arrow next to "Sum of Count".
15. The "Value Field Settings" window will appear, click on the "Show Values As" tab.
16. On the "Show value as" select the "% of Grand Total" option – Here a number of options are available depending on the desired report format.
17. Click on OK to apply the selected settings.

18. The second pivot table will appear as follows.

From the pivot, it can be gathered that MC’s female workforce is 40% of the Total workforce, with only 5.7% (1.4% + 4.3%) in EX and SM structures. Does the women representation meet the EE requirements to qualify for the R2.5m grant?
19. Based on the same information and the learnings you have acquired, attempt to create the two formats of the “employment type” (contract vs. permanent) pivots.

20. The two pivots should appear as follows:

<table>
<thead>
<tr>
<th>Row Labels</th>
<th>Column Labels</th>
<th>Permanent</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>EX</td>
<td>Contract</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>GA</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>GB</td>
<td>50</td>
<td>3</td>
<td>53</td>
</tr>
<tr>
<td>JM</td>
<td>5</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>MM</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>SM</td>
<td>3</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td>50</td>
<td>20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Row Labels</th>
<th>Column Labels</th>
<th>Permanent</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>EX</td>
<td>0.0%</td>
<td>7.1%</td>
<td>7.1%</td>
</tr>
<tr>
<td>GA</td>
<td>0.0%</td>
<td>2.9%</td>
<td>2.9%</td>
</tr>
<tr>
<td>GB</td>
<td>71.4%</td>
<td>4.3%</td>
<td>75.7%</td>
</tr>
<tr>
<td>JM</td>
<td>0.0%</td>
<td>7.1%</td>
<td>7.1%</td>
</tr>
<tr>
<td>MM</td>
<td>0.0%</td>
<td>2.9%</td>
<td>2.9%</td>
</tr>
<tr>
<td>SM</td>
<td>0.0%</td>
<td>4.3%</td>
<td>4.3%</td>
</tr>
<tr>
<td>Grand Total</td>
<td>71.4%</td>
<td>28.6%</td>
<td>100.0%</td>
</tr>
</tbody>
</table>

From the above pivot table, is can be gathered that contract workforce constitute 71.4% of MC’s total workforce. Does this findings meet the additional requirement for the R2.5m government grant?

8 SPREADSHEETS: THE BIGGER PICTURE

We have included this final section to help you see the bigger picture. Now that you have worked through this study unit and have mastered the basic formulas and functions included in the AIN2601 syllabus, it is time for you to apply this knowledge to simulated real-life scenarios. We have taken the time to compile three assessment questions to demonstrate how you would apply your newly gained knowledge in an examination situation.

We would like to use this opportunity to stress the importance of examination technique. If you combine your subject knowledge with the correct examination technique, you will pass the Microsoft Office Excel portion of the examination with flying colours. Please note that it’s not a matter of “IF” an examination will have a Microsoft Office Excel question, the examination will definitely have a Microsoft Office Excel question.
Remember that we actually try to guide you in the right direction in the question. Always read the provided spreadsheet from TOP to BOTTOM and LEFT to RIGHT as well as the given case study information. Keep that in mind. You will find the necessary information to answer the questions.

- The concepts “Formulas” and “Functions” are similar, and the terms are sometimes used interchangeably. You will always see this sentence in your Microsoft Office Excel questions in the examination:

  “NOTE!!!: Where it is indicated that your formula will be copied to other cells, your formula should take absolute and relative addresses into account, but only where necessary!”

  - This reminds you that you need to consider whether the formula will be copied down or across the spreadsheet, which will influence the absolute and relative cell references to be included in the formula/function. However, refer to the last part of the sentence again: “...but only where necessary!” Invest the time in gaining a sound understanding of absolute and relative references. It is incorrect to use absolute references unnecessarily. You will not receive a mark for an absolute reference that has been used unnecessarily.

  - As far as copying down (over rows) and across (over columns) is concerned, we will never tell you whether the question require you to copy down or across, but the clue will be in looking at the cell range to which we want you to copy the formula to. If the rows change, for example, C11:C14, then you are copying DOWN and the row reference should include an absolute reference if necessary. If the columns change, for example, C11:K11, then you are copying ACROSS and the column reference should include an absolute reference if necessary.

- This hint is based on your own personal preference: If you become flustered when trying to do basic calculations in Microsoft Office Excel, do the mathematical calculation first and then substitute the amounts with the correct cell references. However, indicate your final answer clearly with the appropriate formula and correct cell references.

- Make sure you indicate your final answer clearly. Do not give more than answer because we will only mark your first answer. Your final answer will be marked if you have clearly indicated the formula to be your final answer.

- You must learn all formula structures by heart except for PV, FV, PMT and VLOOKUP. When you start writing your paper, first write down all structures so you can refer back to them once you start with the Microsoft Office Excel questions. This should prevent you from becoming flustered when you are pressed for time.
Frequent mistakes in Microsoft Office Excel questions

When marking a Microsoft Office Excel question, student will be penalised for a variety of errors for not adhering to rules or inconsistent application of rules. Bear in mind that we will only deduct marks until you have zero for a formula – you will therefore never receive a negative mark for that specific formula. Below are the related common/frequent mistakes, please review and ensure that you understand why these formats are incorrect.

a) Not starting the formula with =

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=sum(B5:B19)</td>
<td>sum(B5:B19)</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=if(C3&gt;B4,500,1000)</td>
<td>if(C3&gt;B4,500,1000)</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>

b) Using [ ] instead of ( ) in the formula structure.

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=sum(B5:B19)</td>
<td>=sum[B5:B19]</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=if(C3&gt;B4,500,1000)</td>
<td>=if[C3&gt;B4,500,1000]</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>

c) Incorrect use of parentheses ( ).

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=sum(B5:B19)</td>
<td>=sum(B5:B19)</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=if(C3&gt;B4,500,1000)</td>
<td>=(ifC3&gt;B4,500,1000)</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=sum(B5:B19)</td>
<td>=sumB5:B19)</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>

d) Using ; instead of : to indicate a range (see section 3.2 in this study unit)

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=sum(B5:B19)</td>
<td>=sum(B5:B19)</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>

e) Inconsistent use of ; instead of , to separate arguments (see section 3.2 in this study unit)

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=mid(A4,7,5)</td>
<td>=mid(A4;7,5)</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=if(C3&gt;B4,500,1000)</td>
<td>=if(C3&gt;B4,500;1000)</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>
f) **Using function “SUM” in a formula where it is unnecessary**

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=B5+B10</td>
<td>=sum(B5+B10)</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=B10*B4</td>
<td>=sum(B10*B4)</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=B5/B10</td>
<td>=sum(B5/B10)</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>


g) **Not using “ ” when using text in a formula**

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=if(C3=&quot;yes&quot;,&quot;open&quot;,&quot;close&quot;)</td>
<td>=if(c3=yes,&quot;open&quot;,&quot;close&quot;)</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>=if(C3=&quot;yes&quot;,&quot;open&quot;,&quot;close&quot;)</td>
<td>=if(c3=&quot;yes&quot;,open,&quot;close&quot;)</td>
<td>2 marks deducted</td>
</tr>
<tr>
<td>=if(C3=&quot;yes&quot;,&quot;open&quot;,&quot;close&quot;)</td>
<td>=if(c3=yes,open,&quot;close&quot;)</td>
<td>3 marks deducted</td>
</tr>
</tbody>
</table>


h) **Using mathematical signs instead of Microsoft Office Excel signs**

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>x</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>/</td>
<td>+</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>


i) **Using a formula when a Function (fx) is available**

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=sum(B5:B10)</td>
<td>=B5+B6+B7+B8+B9+B10</td>
<td>0 marks awarded</td>
</tr>
<tr>
<td>=average(B5:B10)</td>
<td>=(B5+B6+B7+B8+B9+B10)/6</td>
<td>0 marks awarded</td>
</tr>
</tbody>
</table>


j) **Incorrect writing of values/amounts in a formula/function**

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0,1</td>
<td>0 marks awarded</td>
</tr>
<tr>
<td>100000</td>
<td>100 000 or R100000 or 100,000</td>
<td>0 marks awarded</td>
</tr>
</tbody>
</table>


k) **Adding unnecessary/additional arguments the formula/function**

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>=right(A4,7)</td>
<td>=right(A4,7,5)</td>
<td>1 mark deducted</td>
</tr>
</tbody>
</table>

The formula has two arguments.
Frequent mistakes in Microsoft Office Excel questions - continued

1) Incorrect writing of values/amounts in a formula/function

<table>
<thead>
<tr>
<th>Correct format</th>
<th>Incorrect format</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>5%</td>
<td>5/100 or 5/100*100</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>0.05</td>
<td>5/100*100</td>
<td></td>
</tr>
<tr>
<td>14%</td>
<td>14/100 or 14/100*100</td>
<td>1 mark deducted</td>
</tr>
<tr>
<td>0.14</td>
<td>14/100*100</td>
<td></td>
</tr>
</tbody>
</table>

When you use a cell displaying a % format in any of your formulas/functions, **DO NOT** multiply or divide the value by 100. Multiplying by 100 when expressing percentages is incorrect because the end result will be 100 times more than it should be. Dividing by 100 when expressing percentages is also incorrect because the end result will be 100 times less than it should be.

A percentage is a fraction where 1 equals the whole or 100%. Multiplying by 100% at the end of a formula is correct because 100% is effectively 1 (1.00), where 1 times any value = the original value you multiplied the 1 by.

Also refer to the above examples of the 5% and 14% being expressed as 0.05 and 0.14 respectively.

**Note: No student will receive less than 0 for a particular formula.**

9 SUMMARY

By using spreadsheets as business applications, you can perform either simple or complex calculations. We showed you how Microsoft Office Excel can help you solve business and accounting problems you may encounter when using different formulas and various functions.

In the next study unit we focus on spreadsheet security risks and controls.
During the holidays you work for an organisation named “Dreams Made Possible” (DMP). This organisation provides study loans to students at African University. Most of the calculations are currently performed manually on paper. Your supervisor knows that you have spreadsheet skills and has therefore requested you to create a spreadsheet that can automatically perform the loan calculations.

Your supervisor supplies you with the following information:

- African University provides DMP with a student’s student number and the number of modules he or she has passed or failed.
- The University provides a student’s results for modules taken all in one field (see range B8:B12). The format of that field is number of modules passed (P): number of modules failed (F). The total number of modules taken by a student to date is the sum of the modules passed and failed. For example 3(P):4(F) will indicate that a student has passed three modules, has failed four modules and has taken seven modules in total (3 passed + 4 failed = 7 in total).
- A student’s module pass rate is calculated as the number of modules passed divided by the total number of modules taken to date.
- Students with a pass rate of less than 50% can borrow money at an annual interest rate of 20%, while students with a pass rate of greater than or equal to 50% can borrow money at an annual interest rate of 15%. The applicable interest rates were entered into cell B2 and cell B3 respectively.
- All student loans must be repaid, in full, over five years.
- All loan repayment instalments are paid at the end of the month.

You know that there is a formula in Microsoft Excel that can calculate a loan instalment repayment amount. You have used the help function to obtain the format of the applicable formula:

\[ = \text{PMT}(\text{rate}, \text{nper}, \text{pv}, \text{fv}, \text{type}). \]
Based on the information you have gathered, you managed to create the below spreadsheet

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Module pass rate</td>
<td>Interest rate per annum</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0% – 49%</td>
<td>20%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>50% – 100%</td>
<td>15%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Repayment term (years)</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Student number</td>
<td>Modules Pass:Fail</td>
<td>Number of modules passed</td>
<td>Number of modules failed</td>
<td>Module pass rate</td>
<td>Applicable interest rate</td>
<td>Loan amount</td>
</tr>
<tr>
<td>8</td>
<td>4123456</td>
<td>2(P):6(F)</td>
<td>2</td>
<td>6</td>
<td>25%</td>
<td>20%</td>
<td>R 7,000</td>
</tr>
<tr>
<td>9</td>
<td>4789012</td>
<td>6(P):2(F)</td>
<td>6</td>
<td>2</td>
<td>75%</td>
<td>15%</td>
<td>R 3,000</td>
</tr>
<tr>
<td>10</td>
<td>3345678</td>
<td>2(P):0(F)</td>
<td>2</td>
<td>0</td>
<td>100%</td>
<td>15%</td>
<td>R 6,000</td>
</tr>
<tr>
<td>11</td>
<td>4567890</td>
<td>5(P):4(F)</td>
<td>5</td>
<td>4</td>
<td>56%</td>
<td>15%</td>
<td>R 4,000</td>
</tr>
<tr>
<td>12</td>
<td>3678903</td>
<td>3(P):5(F)</td>
<td>3</td>
<td>5</td>
<td>38%</td>
<td>20%</td>
<td>R 6,000</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Total</td>
<td>R 26,000</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Average</td>
<td>-R 130.74</td>
</tr>
</tbody>
</table>

**QUESTION 1**

**REQUIRED**

Note: Where it is indicated that your formula will be copied to other cells, your formula should take absolute references into account where necessary!

(a) Which spreadsheet formula was entered in cell C8 to extract the number of modules passed by student 4123456 from the information provided in cell B8? You may assume, for the purpose of your formula, that the number of modules passed or failed will not exceed nine (9). **Note: Your formula will be copied to cells C9:C12.**

(b) Which spreadsheet formula was entered in cell D8 to extract the number of modules failed by student 4123456 from the information provided in cell B8? You may assume, for the purposes of your formula, that the number of modules passed or failed will not exceed nine (9). **Note: Your formula will be copied to cells D9:D12.**

(c) Which spreadsheet formula was entered in cell E8 to calculate the module pass rate for student 4123456? The formula must round the module pass rate to two (2) decimal digits. **Note: Your formula will be copied to cells E9:E12.**
QUESTION 1 - continued

(d) Which spreadsheet formula was entered in cell F8 to determine the applicable interest rate per student based on the student’s module pass rate? Since DMP may change this rate in future, it would be best to refer to the applicable cells, instead of inserting the actual % in the formula. Refer back to the case study information.  
Note: Your formula will be copied to cells F9:F12.

(e) Which spreadsheet formula was entered in cell H8 to calculate the monthly repayment/instalment amount? Refer back to the case study information. Note: Your formula will be copied to cells H9:H12.

(f) Which spreadsheet formula was entered in cell G14 to calculate the total amount loaned to students?

(g) Which spreadsheet formula was entered in cell H15 to determine the average repayment/instalment amount of all students?

QUESTION 2

Shiny Wheels (SW) is a newly formed car dealership that specialises in selling both new cars (NC) and second hand cars (SH). The company has only two branches, one in Pretoria (Inland) and one in Port Elizabeth (Coastal). Currently, SW’s sales policy is to strive for a minimum mark-up percentage of 12.5% and 27.0% on new car sales and second-hand car sales respectively. The mark-up % will be reviewed on an annual basis to determine if any changes are needed in line with increases in operational cost.

Being a new player in an extremely competitive industry has presented a challenge for SW’s sales team. In effort to boost sales numbers, Precious Thaba-kgolo (the sole owner of the dealership) decided to introduce an incentive scheme for her sales team, where the sales consultant will be paid a cash commission for each vehicle sold. The sales commission will be calculated on a scaling rate based on the selling price of the vehicle excluding VAT. In her business feasibility plan, Precious was able to identify that the inland team will be able to sell a greater number of vehicles at each point in time as compared to the coastal team, so to compensate for this inherent business characteristic, the coastal commission rates will be 1% more than the inland commission rates for each of the scaling rate.

SW only sells three kinds of vehicles: Model A, B and C from each of the two branches.

You as the financial manager of SW, have been tasked with the preparation of the two Commission Workings files from with the sales consultants commissions will be calculated.
## QUESTION 2 - continued

With little help from your assistant Financial Manager, you managed to create the following spreadsheet.

![Spreadsheet Image]

Additional information:

1. **Value added Tax (VAT)** rate is 14% (refer to cell B2) where applicable.

2. **Inland Commission rates table** (refer to range A4:C12) reflects the commission rates used for calculating the inland branch commission on vehicle sales. The commission rates are based on a vehicle’s selling price excluding VAT. For example, a vehicle sold for R200 000 will attract a commission rate of 5.5% as it falls within the R180 000 to R219 999 bracket.

3. **Coastal Commission rates table** (refer to range E4:G12) reflects the commission rates used for calculating the coastal branch commission on vehicle sales. The commission rates are based on a vehicle’s selling price excluding VAT. For example, a vehicle sold for R160 000 will attract a commission rate of 4.5% as it falls within the R140 000 to R179 999 bracket.

4. **Mark-up percentages table** (refer to range A14:C16) reflect the mark-up percentage (made on the sales of vehicles at 12.5% for new cars (NC) sales and 27.0% for second hand cars (SH) sales irrespective of the selling branch.

5. **Consultant Code** (refer to cells B19 and B27) is a unique 12-characters alpha-numeric code allocated to each sales consultant with the main purpose of ensuring that the correct commission based on the vehicle sold is calculated and paid to the correct sales consultant.

### Additional information:

1. **Value added Tax (VAT)** rate is 14% (refer to cell B2) where applicable.

2. **Inland Commission rates table** (refer to range A4:C12) reflects the commission rates used for calculating the inland branch commission on vehicle sales. The commission rates are based on a vehicle’s selling price excluding VAT. For example, a vehicle sold for R200 000 will attract a commission rate of 5.5% as it falls within the R180 000 to R219 999 bracket.

3. **Coastal Commission rates table** (refer to range E4:G12) reflects the commission rates used for calculating the coastal branch commission on vehicle sales. The commission rates are based on a vehicle’s selling price excluding VAT. For example, a vehicle sold for R160 000 will attract a commission rate of 4.5% as it falls within the R140 000 to R179 999 bracket.

4. **Mark-up percentages table** (refer to range A14:C16) reflect the mark-up percentage (made on the sales of vehicles at 12.5% for new cars (NC) sales and 27.0% for second hand cars (SH) sales irrespective of the selling branch.

5. **Consultant Code** (refer to cells B19 and B27) is a unique 12-characters alpha-numeric code allocated to each sales consultant with the main purpose of ensuring that the correct commission based on the vehicle sold is calculated and paid to the correct sales consultant.
The Consultant Code structure is as follows:

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>5</td>
<td>S</td>
<td>H</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>I</td>
<td>L</td>
</tr>
</tbody>
</table>

- character 1: **Consultant gender code** - relates to the gender prefix of the sale consultant where F is female and M is male.
- character 2 to 5: **Year employed** – relates to the year in which the sales consultant was employed by SW
- character 6 to 7: **Consultant specialty code** – relates to the sales consultant specialty, where SH is second hand sales consultant and (NC) is new car sales consultant.
- character 8 to 10: **Employee number** – relates to the sales consultant employee number.
- character 11 to 12: **Location code** - relates to the branch location of the sales consultant, where IL is the inland branch and CL is the coastal branch.

6. **Mark-up %** (refer to cell E19 and E27) is based on the consultant specialty code as either SH or NC. Since the mark-up might change in future to cover for future increase in operational cost, it would be best to refer to the mark-up percentages table (refer to point 4).

7. **Vehicle Model Sold** (refer to cell F19 and F27) relates to model of the vehicle sold as either Module A, Module B or Module C.

8. **Cost Price Incl VAT** (refer to cell G19 and G27) is the cost including VAT incurred by SW when the vehicle was initially bought by the branch.

9. **Selling Price Incl VAT** (refer to cells H19 and H27) is calculated by applying the applicable mark-up percentage (refer to point 4) to the cost price including VAT (refer to point 7) of the vehicle sold.

10. **Selling Price Excl VAT** (refer to cells I19 and I27) is calculated by applying the VAT rate (refer to point 1) to the selling price including VAT (refer to point 8).

11. **Com.Rate** (refer to cells J19 and J27) relates to the commission rates retrieved from either the Inland Commission rates table (refer to point 2) or Coastal Commission rates table (refer to point 3).

12. **Com.Amount** (refer to cells K19 and K27) relates to the commission amount calculated by applying the applicable commission rate to the selling price excluding VAT (refer to point 8).
QUESTION 2 - continued

REQUIRED:

Note: Where it is indicated that your formula will be copied to other cells, your formula should take absolute references into account where necessary!

(a) Which spreadsheet formula was entered in cell B20 to extract the consultant gender code “F” for sales consultant “F2015SH002IL” from the consultant code provided in cell A20?
   Note: Your formula will be copied to cells B21:B24 as well as B28:B32.

(b) Which spreadsheet formula was entered in cell C20 to extract the consultant specialty code character “SH” for sales consultant “F2015SH002IL” from the consultant code provided in cell A20?
   Note: Your formula will be copied to cells C21:C24 as well as C28:C32.

(c) Which spreadsheet formula was entered in cell D20 to extract the location code characters “IL” for sales consultant “F2015SH002IL” from the consultant code provided in cell A20?
   Note: Your formula will be copied to cells D21:D24 as well as D28:D32.

(d) Which spreadsheet formula was entered in cell E20 to determine the applicable mark-up percentage of 27.00% for sales consultant “F2015SH002IL”?
   Note: Your formula will be copied to cells E21:E24 as well as E28:E32.

(e) Which spreadsheet formula was entered in cell H20 to calculate the selling price including VAT for sale of vehicle model C by sales consultant “F2015SH002IL”?
   Note: Your formula will be copied to cells H21:H24 as well as H28:H32.

(f) Which spreadsheet formula was entered in cell I20 to calculate the selling price excluding VAT for sale of vehicle model C by sales consultant “F2015SH002IL”?
   Note: Your formula will be copied to cells I21:I24 as well as I28:I32.

(g) Which spreadsheet formula was entered in cell J20 to determine the commission rate from the “Inland commission rates table” for vehicle model C sold by sales consultant “F2015SH002IL”?
   Note: Your formula will be copied to cells J21:J24.

(h) Which spreadsheet formula was entered in cell J28 to determine the commission rate from the “Coastal commission rates table” for sales consultant “M2016NC009CL” on the sale of vehicle model B?
   Note: Your formula will be copied to cells J29:J32.

(i) Which spreadsheet formula was entered in cell K20 calculate the commission amount for sales consultant “F2015SH002IL” on the sale of vehicle model C?
   The formula must round the commission amount to two (2) decimal digits.
   Note: Your formula will be copied to cells K21:K24 as well as K28:K32

(i) Which spreadsheet formula was entered in cell K25 to calculate total commission amount for Inland branch?
QUESTION 2 - continued

(k) Which spreadsheet formula was entered in cell F37 to count the number of sales consultants responsible for second hand (SH) vehicles sales in the Inland branch?

(l) Which spreadsheet formula was entered in cell F39 to count the total number of all sales consultants employed by the Coastal branch?

(m) Which spreadsheet formula was entered in cell K37 to determine the lowest commission amount paid by the Inland branch?

(n) Which spreadsheet formula was entered in cell K38 to determine the highest commission amount paid by the Coastal branch?

(o) Which spreadsheet formula was entered in cell K39 to determine the average commission amount paid by both the Inland and Coastal branches?
Joseph, one of your colleagues at Top Music, heard of the excellent job you did in creating the weekly statistics using a spreadsheet and has therefore requested your help. An investment company has suggested a savings product for all employees of your branch. Joseph wants to show his co-workers what the possible amount is that they could receive at retirement if they start saving and investing now.

Joseph provides you with the following information and spreadsheet formulas:

• The staff member’s identity number is given, which Joseph obtained with the person’s approval. The first two (2) characters of an identity number indicate the year in which the staff member was born.
• The staff member’s monthly available income is indicated.
• All staff members were born before the year 2000.
• The normal retirement age is 65 years.
• The current investment return rate is 10% per annum.
• Each individual staff member’s investment term in years is equal to the difference between the normal retirement age and his or her current age.
• The investment company suggested that staff members who are 50 years and older should save 10% of their monthly available income and that staff members younger than 50 years should save 5% of their monthly available income.
• Monthly payments to the investment company will be made at the end of each month.

=FV(rate,nper,pmt,pv,type)
=PV(rate,nper,pmt,fv,type)

You have created the spreadsheet on the next page.

Required

Use the information supplied to answer the following questions relating to the spreadsheet that has been provided:

Note: Where it is indicated that your formula will be copied to other cells, your formula should take absolute references into account where necessary!

(a) Which spreadsheet formula was entered in cell B8 to include a 19 at the beginning of the two-digit birth year in cell B7, thereby changing the birth year for Bipin from a two-digit year in cell B7 to a four-digit year? Note: Your formula will be copied to cells C8:F8.

(b) Which spreadsheet formula was entered in cell B11 to calculate Bipin’s monthly savings amount based on the suggestions made by the investment company? The monthly savings amount must be a negative amount because it is an outflow of cash from the staff member to the investment company. Refer back to the information provided. Note: Your formula will be copied to cells C11:F11.

(c) Which spreadsheet formula was entered in cell B12 to calculate the investment term in years for Bipin? Refer back to the information supplied. Note: Your formula will be copied to cells C12:F12.

(d) Which spreadsheet formula was entered in cell B13 to calculate the expected value of Bipin’s total savings at the end of the investment term? Note: your formula will be copied to cells C13:F13.
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current year</td>
<td>2010</td>
<td>2010</td>
<td>2010</td>
<td>2010</td>
<td>2010</td>
</tr>
<tr>
<td>2</td>
<td>Retirement age</td>
<td>65</td>
<td>65</td>
<td>65</td>
<td>65</td>
<td>65</td>
</tr>
<tr>
<td>3</td>
<td>Investment return rate</td>
<td>10%</td>
<td>10%</td>
<td>10%</td>
<td>10%</td>
<td>10%</td>
</tr>
<tr>
<td>4</td>
<td>Identity number</td>
<td>9101011234</td>
<td>9111111234</td>
<td>9222222234</td>
<td>9333333234</td>
<td>9444444234</td>
</tr>
<tr>
<td>5</td>
<td>Year of birth (YY)</td>
<td>91</td>
<td>91</td>
<td>91</td>
<td>91</td>
<td>91</td>
</tr>
<tr>
<td>7</td>
<td>Current age</td>
<td>19</td>
<td>19</td>
<td>19</td>
<td>19</td>
<td>19</td>
</tr>
<tr>
<td>8</td>
<td>Monthly available income</td>
<td>R 2,000</td>
<td>R 3,000</td>
<td>R 4,000</td>
<td>R 5,000</td>
<td>R 6,000</td>
</tr>
<tr>
<td>9</td>
<td>Monthly savings</td>
<td>-R 100</td>
<td>-R 150</td>
<td>-R 200</td>
<td>-R 250</td>
<td>-R 300</td>
</tr>
<tr>
<td>10</td>
<td>Investment term in years</td>
<td>46</td>
<td>46</td>
<td>46</td>
<td>46</td>
<td>46</td>
</tr>
<tr>
<td>11</td>
<td>Expected value of savings at the end of the investment term</td>
<td>R 1,159,272.22</td>
<td>R 948,611.94</td>
<td>R 286,782.97</td>
<td>R 411,425.60</td>
<td>R 376,349.10</td>
</tr>
<tr>
<td>12</td>
<td>Expected value of financing that could be obtained from SupaDebt</td>
<td>R 5,113,82</td>
<td>R 7,670,73</td>
<td>R 12,784,54</td>
<td>R 37,933,44</td>
<td>R 40,910,54</td>
</tr>
</tbody>
</table>
QUESTION 1  (step-by-step illustrated solution)

Note: Where it is indicated that your formula will be copied to other cells, your formula should take absolute and relative addresses into account, but only where necessary!

(a) Which spreadsheet formula was entered in cell C8 to extract the number of modules passed by student 4123456 from the information provided in cell B8? You may assume, for the purpose of your formula, that the number of modules passed or failed will not exceed nine (9). Note: Your formula will be copied to cells C9:C12.

Step 1: Identify the formula to be used: LEFT

Step 2: Formula structure: =LEFT(cell,num_chars)

Step 3: Write down your answer: =LEFT(B8,1)

Step 4: Will the formula be copied? Yes, the formula will be copied to cell C9:C12. The column stayed the same (ie C), and the rows changed from 9:12 which means you are copying DOWN. Did you identify any cell references that should contain an absolute reference? NO – the cell reference, B8, needs to change to B9, B10, and so forth, as you copy the formula down.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td>You need to insert a formula into cell C8, based on information extracted from cell B8. The second bullet point in the case study gave information on the structure of B8, from which the number of modules passed is to be extracted. For example, 3(P):4(F) will indicate that a student has passed three modules, has failed four modules and has taken seven modules in total (3 passed + 4 failed = 7 in total). The information pertaining to the number of modules passed is on the left-hand side of cell B8, and we therefore need to use the “left” function because it returns a specified number of characters (num_chars) from the start (left-hand side) of the text. It was essential to read the information supplied and the spreadsheet layout provided to be able to answer this question because it gave all the clues on how to answer the question.</td>
</tr>
<tr>
<td>Function name</td>
<td>LEFT</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>cell</td>
<td>B8</td>
<td>This argument indicates to Microsoft Office Excel from which cell information will be extracted, in this instance, from cell B8, as stated in the question.</td>
</tr>
</tbody>
</table>
From the content of cell B8 (ie 2(P):6(F)), which character/s do you need to be returned in cell C8? You need the number of modules passed only, which will be 2, NOT 2(P). You need to physically count the number of characters to let Microsoft Office Excel know how many characters from cell B8 should be returned in cell C8. A character means every time you have touched the keyboard, which means a space also counts as one character since you have touched the space bar. In this instance it is the number of modules passed only, the 2, and that is only one character.

<table>
<thead>
<tr>
<th>num_chars</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character position/number</td>
<td>1 2 3 4 5 6 7 8 9</td>
</tr>
<tr>
<td>Starts here</td>
<td>2 (P) : 6 (F)</td>
</tr>
</tbody>
</table>

Closing parenthesis )

Do not forget!

(b) Which spreadsheet formula was entered in cell D8 to extract the number of modules failed by student 4123456 from the information provided in cell B8? You may assume, for the purposes of your formula, that the number of modules passed or failed will not exceed nine (9). Note: Your formula will be copied to cells D9:D12.

**Step 1:** Identify the formula to be used: MID

**Step 2:** Formula structure: =MID(cell,start_num,num_chars)

**Step 3:** Write down your answer: =MID(B8,6,1)

**Step 4:** Will the formula be copied? Yes, the formula will be copied to cells D9:D12 which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references where you want to include an absolute reference? NO: The cell reference B8 should change as you copy the formula down.
<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td>Why did you decide to use the “mid” function instead of “left” or “right”? The question wanted you to extract the number of modules failed from cell B8. From the content in cell B8 (ie 2(P):6(F)), you only need to extract 6 and NOT 6(P). That explains why you cannot use the “left” or “right” function, because 6 is in the middle of the text string. You have therefore opted to use the “mid” function because it returns a specified number of characters from the middle of a text string given a starting position (start_num) and the length specified (num_chars).</td>
</tr>
<tr>
<td>Function name</td>
<td>MID</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>cell</td>
<td>B8</td>
<td>This argument indicates to Microsoft Office Excel from where information will be extracted, and in this instance, it will be from cell B8, as stated in the question.</td>
</tr>
<tr>
<td>start_num</td>
<td>6</td>
<td>This is where the main difference between the “mid” function and the “left” and “right” functions lies. With “left” and “right”, Microsoft Office Excel already knows where to start “counting” in order to return the specified number of characters, but in the case of using the “mid” function, you will need to tell Microsoft Office Excel where to start counting – in other words, where the “middle” is (ie where to start counting). Bear in mind that this does not necessarily mean the actual mathematical middle, it simply means somewhere in the middle.</td>
</tr>
<tr>
<td>num_chars</td>
<td>1</td>
<td>From the content of cell B8 (ie 2(P):6(F)), which character(s) do you need to be returned in cell D8? The number of modules failed only, which will be 6, NOT 6(F). You need to physically count the number of characters to let Microsoft Office Excel know how many characters from cell B8 should be returned in cell D8. In this instance, it is the number of modules failed only, the 6, which is only one character.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td>Do not forget!</td>
</tr>
</tbody>
</table>
IN ADDITION TO THE ORIGINAL QUESTIONS REQUIRED

Let us pretend that the question wanted the text “6(F)” to be returned in cell D8. You should be able to copy the formula to cell range D9:D12. What formula would you have used?

**Step 1:** Identify the formula to be used: RIGHT

**Step 2:** Formula structure: =RIGHT(cell,num_chars)

**Step 3:** Write down your answer: =RIGHT(B8,4)

**Step 4:** Will the formula be copied? Yes, the formula will be copied to cell D9:D12. The column stayed the same – that is, D and the rows changed from 9:12, which means you are copying down. Did you identify any cell references that should have contained an absolute reference? NO – the cell reference, B8, needs to change to B9, B10, etc, as you copy the formula down.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>RIGHT</td>
<td>You need to insert a formula into cell D8, based on information extracted from cell B8. The question wanted the formula to return 6(F) from the text 2(P):6(F) in cell B8. You therefore need to indicate to Microsoft Office Excel to start “counting” from the right.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>cell</td>
<td>B8</td>
<td>This argument indicates to Microsoft Office Excel from where information will be extracted, in this instance, from cell B8, as stated in the question.</td>
</tr>
<tr>
<td>num_chars</td>
<td>4</td>
<td>From the content of cell B8 (ie 2(P):6(F)), which character(s) do you want to be returned in cell D8? The modules failed, 6(F). You need to physically count the number of characters to let Excel know how many characters from cell B8 should be returned in cell D8. The number of modules failed, which will be 6(F), the four characters from the right.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td>Do not forget!</td>
</tr>
</tbody>
</table>

![Character position/number diagram](https://via.placeholder.com/150)

Specified number of characters

num_of_chars

Character position/number

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>(</td>
<td>P</td>
<td>)</td>
<td>:</td>
</tr>
</tbody>
</table>

6 ( F )

Starts here
(c) Which spreadsheet formula was entered in cell E8 to calculate the module pass rate for student 4123456? The formula must round the module pass rate to two (2) decimal digits. Note: Your formula will be copied to cells E9:E12.

Step 1: Identify the formula to be used: ROUND

Step 2: Formula structure: =ROUND(formula,number_of_digits)

Step 3: Write down your answer: =ROUND(C8/(C8+D8),2)

Step 4: Will the formula be copied? Yes, the formula will be copied to cell E9:E12. The column stayed the same – that is, E and the rows changed from 9:12, which means you are copying DOWN. Did you identify any cell references that should have contained an absolute reference? NO – the cell reference, C8 and D8, needs to change to C9 and D9, C10 and D10, etc, as you copy the formula down.

Let us now go through the process of arriving at the above answer:

Read the case study information carefully again – the clue is right there.

“A student’s module pass rate is calculated as the number of modules passed divided by the total number of modules taken to date.”

Remember we are now looking at the information for student number 4123456. As per cell C8, he passed two modules and, as per cell D8, he failed six modules.

Now we are ready to start with the maths!

= number of modules passed/total number of modules taken to date
= 2/(2+6) (Pay special attention to the use of brackets, which influences the order of operation.)

The order of operation is the sequence of computation a formula follows to arrive at an answer. Microsoft Office Excel uses the same order of operations as mathematics and will therefore perform computations in the following sequence:

• First: computations/calculations in parentheses/brackets, no matter where they are in the formula
• Second: computations with exponents
• Third: computations involving multiplication (*) and division (/) from left to right
• Fourth: computations involving addition and subtraction from left to right

Let us now look at the spreadsheet again. Are there perhaps cells containing some of these numbers that are used in the calculation above?

Yes! Now substitute the numbers with the cell references.

= 2/(2+6) thus becomes
= C8/(C8+D8)
Great! You are almost there. There is a second requirement in the question:

“The formula must **round** the module pass rate to **two decimal digits.**”

It is not always necessary to round the answer of a cell in a separate cell. The **round** function can be used with a formula in a cell: 

\[
\text{=ROUND(formula, number_of_digits)}
\]

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>ROUND</td>
<td>The question requires the following: “<strong>The formula must round the module pass rate to two (2) decimal digits.</strong>”</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Formula</td>
<td>C8/(C8+D8)</td>
<td>As calculated to obtain the module pass rate for the student – <strong>remember the order of operation rules!</strong></td>
</tr>
<tr>
<td>number_of_digits</td>
<td>2</td>
<td>The question specifies that the number should be rounded to two decimal digits.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td>Don’t forget!</td>
</tr>
</tbody>
</table>

(d) Which spreadsheet formula was entered in cell F8 to determine the applicable interest rate per student based on the student’s module pass rate? Because DMP may change this rate in future it would be best to refer to the applicable cells instead of inserting the actual % in the formula. Refer back to the case study information. **Note: Your formula will be copied to cells F9:F12.**

**Step 1:** **Identify the formula to be used:** IF. How did we know this? Refer back to the case study information: “Students with a pass rate of **less than** 50% can borrow money at an annual interest rate of 20%, while students with a pass rate of **greater than or equal to** 50% can borrow money at an annual interest rate of 15%.” Remember that the IF function is used when one needs to decide between two alternatives depending on a specific condition. In this instance, the information gave two alternatives, that is, students with a pass rate of **less than** 50% borrowing at an interest rate of 20% **OR** students with a pass rate of **greater than or equal to** 50% borrowing at an interest rate of 15%. The interest rate is determined by their **pass rate.** This is the clue that the IF function needs to be used.

**Step 2:** **Formula structure:** = IF(Logical_test,value_if_true,value_if_false)

**Step 3:** **Write down your answer:** As you can see below, there is more than one correct answer, which we will discuss in detail in the table below. The logical test determines which outcome will be the true statement and which outcome will be the false statement.

**OPTION 1:**

\[
\text{=IF(E8<0.5,B$2,B$3)}
\]

**OPTION 2:**

\[
\text{=IF(E8>=0.5,B$3,B$2)}
\]

**Step 4:** **Will the formula be copied?** Yes, the formula will be copied to cells F9:F12, which means you are copying DOWN because the column did not change – only the rows. Did you identify any cell references where you want to include an absolute reference? **YES: B$3 and B$2. A clue has been included in the information:** “The applicable interest rates were entered in cell B2 and cell B3 respectively.” And in the question:
“Because DMP may change this rate in future it would be best to refer to the applicable cells instead of inserting the actual % in the formula.”

**OPTION 1**

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td>The case study provides two alternatives. The IF function is used in the case where one needs to decide between two alternatives depending on a specific condition. See step 1 above.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>E8&lt;0.5 OR</td>
<td>You want to evaluate whether the student’s pass rate is below 50%. Note that expressing 50% as either 50% or 0.5 would have been accepted as the correct answer, but 50/100 would have been incorrect.</td>
</tr>
<tr>
<td></td>
<td>E8&lt;50%</td>
<td></td>
</tr>
<tr>
<td>value_if_the logical test is true</td>
<td>B$2</td>
<td>You want the interest rate of 20% to be returned. The interest rate is in cell B2. An absolute reference needs to be included because you want this cell reference to stay fixed as you copy it DOWN – that explains why the row is an absolute reference. $B2 is incorrect.</td>
</tr>
<tr>
<td>value_if_the logical test is false</td>
<td>B$3</td>
<td>You want the interest rate of 15% to be returned. The interest rate is in cell B3. An absolute reference needs to be included because you want this cell reference to stay fixed as you copy it DOWN – that explains why the row is an absolute reference. $B3 is incorrect.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

**OPTION 2**

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td>The case study provides two alternatives. The IF function is used in the case where one needs to decide between two alternatives depending on a specific condition. See step 1 above.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>E8&gt;=0.5 OR</td>
<td>You want to evaluate whether the student’s pass rate is equal to or higher than 50%. Note that expressing 50% as either 50% or 0.5 would have been accepted as the correct answer, but 50/100 would have been incorrect.</td>
</tr>
<tr>
<td></td>
<td>E8&gt;=50%</td>
<td></td>
</tr>
</tbody>
</table>
value_if_the_logical_test_is_true | B$3 | You want the interest rate of 15% to be returned. The interest rate is in cell B3. An absolute reference needs to be included because you want this cell reference to stay fixed as you copy it DOWN – that explains why the row is an absolute reference. $B3 is incorrect.

value_if_the_logical_test_is_false | B$2 | You want the interest rate of 20% to be returned. The interest rate is in cell B2. An absolute reference needs to be included because you want this cell reference to stay fixed as you copy it DOWN – that explains why the row is an absolute reference. $B2 is incorrect.

Closing parenthesis )

(e) Which spreadsheet formula was entered in cell H8 to calculate the monthly repayment/instalment amount? Refer back to the case study information.

Note: Your formula will be copied to cells H9:H12.

Step 1: Identify formula to be used: PMT. Why? Refer back to the question: “Which spreadsheet formula was entered in cell H8 to calculate the monthly repayment/instalment amount?”

Step 2: Formula structure: =PMT(rate,nper,pv,fv,type)

Step 3: Write down your answer: =PMT(F8/12,B$5*12,G8,0,0)

Step 4: Will the formula be copied? Yes, the formula will be copied to cells H9:H12, which means you are copying DOWN as the column did not change – only the rows changed. Did you identify any cell references in which you want to include an absolute reference? YES, B$5, because it contains the repayment period and will stay fixed when the formula is copied.

=PM(F8/12,B$5*12,G8,0,0)

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>PMT</td>
<td>The question requires that “the formula must calculate the monthly repayment/instalment amount” which is a payment.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>rate</td>
<td>F8/12</td>
<td>The interest rate is annual (yearly) and needs to be divided by 12 to change it to a monthly rate, because the question requires “the monthly repayment/instalment amount” to be calculated. The annual interest rate must be changed to the same period as the required interest rate – hence from a yearly to a monthly rate.</td>
</tr>
<tr>
<td>nper</td>
<td>B$5*12</td>
<td>The period is a term in years and should be multiplied by 12 to change the period to months.</td>
</tr>
<tr>
<td>pv</td>
<td>G8</td>
<td>The present value of the loan amount. This is the amount you want to loan from the bank in order to finance the loan.</td>
</tr>
</tbody>
</table>
The future value of the loan. Because the loan will be fully paid by the end of the period, as indicated in the case study, the future value of the loan is R0.

The instalment is paid at the end of the month (paid in arrears).

(f) Which spreadsheet formula was entered in cell G14 to calculate the total amount loaned to students?

**Step 1:** Identify the formula to be used: **SUM**

**Step 2:** Formula structure: =sum(cell1:cell2)

**Step 3:** Write down your answer: =SUM(G8:G13)

**Step 4:** Will the formula be copied? No – therefore no absolute references need to be included in the formula.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>SUM</td>
<td>This function is used to save time by not having to add all the individual cells. Note that even though you will obtain the correct answer by adding together all the cells, that is, =G8+G9+G10+G11+G12+G13, you will not earn any marks because this is not the best option when you have a large number of cells to add.</td>
</tr>
<tr>
<td>(cell1:cell2)</td>
<td>G8:G13</td>
<td>The range of cells to which the specific function/formula is applied. In this case, the function adds all the values in the specified range of cells. Be careful not to include text (eg the column heading in the cell range).</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td>Do not forget!</td>
</tr>
</tbody>
</table>

(g) Which spreadsheet formula was entered in cell H15 to determine the average repayment/instalment amount of all students?

**Step 1:** Identify the formula to be used: **AVERAGE**

**Step 2:** Formula structure: =average(cell1:cell2)

**Step 3:** Write down your answer: =AVERAGE(H8:H12)

**Step 4:** Will the formula be copied? No – therefore no absolute references need to be included in the formula.
<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>AVERAGE</td>
<td><strong>AVERAGE</strong> calculates the average of the values in a specified <strong>range of cells</strong>. This function is used to save time by not having to add all the individual cells and dividing the answer by the total number of cells added. Note that even though you will obtain the correct answer by adding all the cells and dividing the answer by the total number of cells added, that is, ((G8+G9+G10+G11+G12+G13)/6), you will not earn any marks because this is not the best option when you have a large number of cells to add.</td>
</tr>
<tr>
<td>(cell1:cell2)</td>
<td>H8:H12</td>
<td>The <strong>range of cells</strong> to which the specific function/formula is applied. In this instance, the function calculates the average of the values in the specified range of cells.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td>Do not forget!</td>
</tr>
</tbody>
</table>

**QUESTION 2** (step-by-step illustrated solution)

Note: Where it is indicated that your formula will be copied to other cells, your formula should take absolute references into account where necessary!

(a) Which spreadsheet formula was entered in cell B20 to extract the consultant gender code “F” for sales consultant “F2015SH002IL” from the consultant code provided in cell A20? 

**Note:** Your formula will be copied to cells B21:B24 as well as B28:B32

**Step 1:** Identify the formula to be used: **LEFT**

**Step 2:** Formula structure: =LEFT(cell,num_chars)

**Step 3:** Write down your answer: =LEFT(A20,1)

**Step 4:** Will the formula be copied? Yes, the formula will be copied to cells B21:B24 as well as B28:B32, which means you are copying **DOWN** because the column did not change, only the rows. Did you identify any cell references in which you want to include an absolute reference? **NO:** The cell reference A20 should change as you copy the formula down.
### Structure

<table>
<thead>
<tr>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Always start your answer with the = sign.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function name</th>
<th>LEFT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation</td>
<td>You need to extract the gender code “F” from the consultant code “F2015SH002IL in cell A20”. The character “F” is the first character of the consultant code when reading the code from the LEFT hence the “LEFT” function was used. Are you able to reason why the functions “RIGHT” or “MID” are not the correct one to use?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Opening parenthesis</th>
<th>(</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell</td>
<td>A20</td>
</tr>
<tr>
<td>num_chars</td>
<td>1</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>)</td>
</tr>
</tbody>
</table>

#### Opening parenthesis

This argument indicates to Microsoft Office Excel from where information will be extracted, and in this instance, it will be from cell A20, as stated in the question.

Consultant Gender Code is represented by one (1) character only, which is “F”, therefore from the contents of cell A20 we only need one (1) character from the LEFT of the consultant code.

#### Closing parenthesis

Do not forget to always close the parenthesis.

---

(b) Which spreadsheet formula was entered in cell C20 to extract the consultant specialty code character “SH” for sales consultant “F2015SH002IL” from the consultant code provided in cell A20?

**Note:** Your formula will be copied to cells C21:C24 as well as C28:C32.

**Step 1:** Identify the formula to be used: MID

**Step 2:** Formula structure: =MID(cell,start_num,num_chars)

**Step 3:** Write down your answer: =MID(A20,6,2)

**Step 4:** Will the formula be copied? Yes, the formula will be copied to cells C21:C24 as well as C28:C32, which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references in which you want to include an absolute reference?

NO: The cell reference A20 should change as you copy the formula down.
<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td>Always start your answer with the = sign.</td>
</tr>
<tr>
<td>Function name</td>
<td>MID</td>
<td>The question asked you to give a formula used to extract characters “SH” from the consultant code “F2015SH002IL” in A20. The characters “SH” are located within the consultant code, and therefore the function “MID” is the correct one to use. Are you able to reason why the functions “RIGHT” or “LEFT” are not the correct one to use?</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>cell</td>
<td>A20</td>
<td>This argument indicates to Microsoft Office Excel from where information will be extracted, and in this instance, it will be from cell A20, as stated in the question.</td>
</tr>
<tr>
<td>start_num</td>
<td>6</td>
<td>This is where the main difference between the “mid” function and the “left” and “right” functions lies. With “left” and “right”, Microsoft Office Excel already knows where to start “counting” in order to return the specified number of characters, but in the case of using the “mid” function, you will need to tell Microsoft Office Excel where to start counting – in other words, where the middle is (ie where to start counting). Bear in mind that this does not necessarily mean the actual mathematical middle, it simply means somewhere in the middle. And in this instance, the middle is character 6, meaning excel will start counting from character 6.</td>
</tr>
<tr>
<td>num_chars</td>
<td>2</td>
<td>From cell A20, we require the formula to return two characters, which is “S” and “H” starting from character 6 above. Hence the number “2”. This argument of the formula is dependent on the number of characters you want the formula to bring back, had C20 being “SH0” then the “num_chars” value would have been 3.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td>Do not forget!</td>
</tr>
</tbody>
</table>

(c) Which spreadsheet formula was entered in cell D20 to extract the location code characters “IL” for sales consultant “F2015SH002IL” from the consultant code provided in cell A20?

**Note:** Your formula will be copied to cells D21:D24 as well as D28:D32.

**Step 1:** Identify the formula to be used: **RIGHT**

**Step 2:** Formula structure: **=RIGHT(cell,num_chars)**

**Step 3:** Write down your answer: **=RIGHT(A20,2)**
Step 4: Will the formula be copied? Yes, the formula will be copied to cells D21:D24 as well as D28:D32, which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references in which you want to include an absolute reference? NO: The cell reference A20 should change as you copy the formula down.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td>Always start your answer with the = sign.</td>
</tr>
<tr>
<td>Function name</td>
<td>RIGHT</td>
<td>You need to extract the location code “IL” from the consultant code “F2015SH002IL”. The location code “IL” has two characters from the RIGHT of the consultant code hence the function “RIGHT” was used. Are you able to reason why the functions “LEFT” or “MID” are not the correct one to use?</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td>This argument indicates to Microsoft Office Excel from which cell will the information be extracted, and in this instance, it will be from cell A20, as stated in the question.</td>
</tr>
<tr>
<td>cell</td>
<td>A20</td>
<td>Location Code is represented by two (2) characters, which are “I” and “L”, therefore from the contents of cell A20 we need two (2) characters from the RIGHT of the “consultant code”</td>
</tr>
<tr>
<td>num_chars</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td>Do not forget to always close the parenthesis.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>5</td>
<td>S</td>
<td>H</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>I</td>
<td>L</td>
</tr>
</tbody>
</table>

Consultant Gender code | Year employed | Consultant Specialty Code | Employee number | Location code

(d) Which spreadsheet formula was entered in cell E20 to determine the applicable mark-up percentage of 27.00% for sales consultant “F2015SH002IL”?

**Note:** Your formula will be copied to cells E21:E24 as well as E28:E32.

**Step 1:** Identify the formula to be used: IF. How did we know this? Refer back to the case study information. The mark-up % is either 12.50% or 27%00 depending on the type of the car being sold, that is new car (NC) or second hand car (SH). Remember that the IF function is used when one needs to decide between two alternatives depending on a specific condition. In this instance, the information gave two alternatives, that is, 12.50% or 27.00% and this is the clue that the IF function needs to be used.

**Step 2:** Formula structure: = IF(Logical_test, value_if_true, value_if_false)

**Step 3:** Write down your answer: As you can see below, there is more than one
correct answer, more often than not, the IF function has more than one correct answer, please work through all the options and ensure that you are comfortable with each one of them.

**OPTION 1**: =IF(C20="NC",C$15,C$16) or

**OPTION 2**: =IF(C20="SH",C$16,C$15)

Are you able to pick up the difference between this “IF” function and the one in Question 1? Hint = Text vs. Non-text

**Step 4:** Will the formula be copied? Yes, the formula will be copied to cells E21:E24 as well as E28:E32 which means you are copying DOWN because the column (E) did not change – only the rows. Did you identify any cell references where you want to include an absolute reference? **YES: C$15 and C$16.** A clue has been included in the information and in the question as well.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td>The case study provides two alternatives. The IF function is used in the case where one needs to decide between two alternatives depending on a specific condition. See step 1 above.</td>
</tr>
<tr>
<td>Function name</td>
<td>IF</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>logical_test</td>
<td>C20=&quot;NC&quot; OR C20=&quot;SH&quot;</td>
<td>You want to evaluate whether the car sold by sales consultant “F2015SH002IL” is a new car (NC) or second hand car (SH).</td>
</tr>
<tr>
<td>value_if_the logical test is true</td>
<td>C$15</td>
<td>You want the mark-up % of 12.50% to be returned, if the sold car is a &quot;NC&quot;. The % rate is in cell C15. An absolute reference needs to be included because you want this cell reference to stay fixed as you copy it DOWN – that explains why the row is an absolute reference. <strong>$C15 is incorrect</strong>. But this cell reference can also be $C$15.</td>
</tr>
<tr>
<td>value_if_the logical test is false</td>
<td>C$16</td>
<td>You want the mark-up % of 27.00% to be returned, if the sold car is a “SH”. The % rate is in cell C16. An absolute reference needs to be included because you want this cell reference to stay fixed as you copy it DOWN – that explains why the row is an absolute reference. <strong>$C16 is incorrect</strong>. But this cell reference can also be $C$16.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

(e) Which spreadsheet formula was entered in cell H20 to calculate the selling
price including VAT for sale of vehicle model C by sales consultant “F2015SH002IL”?

Note: Your formula will be copied to cells H21:H24 as well as H28:H32

Step 1: Identify the formula to be used: NOT a Function (fx) but a Mark-up % calculation.

Step 2: Formula structure: =No formal structure as its not a fx

Step 3: Write down your answer: =G20*(1+E20)

Please refer to point 9 of additional information, you were told that the “selling price including VAT” is calculated by applying the applicable mark-up % (E20) to the cost price including VAT (G20).

Step 4: Will the formula be copied? Yes, the formula will be copied to cells H21:H24 as well as H28:H32, which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references in which you want to include an absolute reference? NO: The cell references G20 and E20 should change as you copy the formula down.

(f) Which spreadsheet formula was entered in cell I20 to calculate the selling price excluding VAT for sale of vehicle model C by sales consultant “F2015SH002IL”?

Note: Your formula will be copied to cells I21:I24 as well as I28:I32.

Step 1: Identify the formula to be used: NOT a Function (fx) but a Mathematical calculation.

Step 2: Formula structure: =No formal structure as it is not a fx

Step 3: Write down your answer: =H20/(1+B$2)

Please refer to point 10 of additional information, you were told how the “selling price excluding VAT” is calculated by applying the VAT rate (B2) to the selling price including VAT (H20).

Step 4: Will the formula be copied? Yes, the formula will be copied to cells I21:I24 as well as I28:I32, which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references in which you want to include an absolute reference? YES: The cell references B2 (VAT rate) should not change as you copy DOWN and hence absolute reference is put at B$2 to “fix” row 2.

(g) Which spreadsheet formula was entered in cell J20 to determine the commission rate from the “Inland commission rates table” for vehicle model C sold by sales consultant “F2015SH002IL”?

Note: Your formula will be copied to cells J21:J24.

Step 1: Identify the formula to be used: VLOOKUP

Step 2: Formula structure:
=VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)

**Step 3:** Write down your answer: =VLOOKUP(I20,A$4:C$12,3,TRUE)

**Step 4:** Will the formula be copied? Yes, the formula will be copied to cells J21:J24, which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references/range in which you want to include an absolute reference? Yes: The range A4:C12 should not change as you copy the formula down.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>VLOOKUP</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Lookup_value</td>
<td>I20</td>
<td>The value you want to look up in the &quot;Inland commission rates table&quot; (table_array) is R147 830 which is reflected in cell I20.</td>
</tr>
<tr>
<td>Table_array</td>
<td>A$4:C$12</td>
<td>The table array you want to lookup from is in range A4:C12. Note that the row references are absolute because the cell references should not change when you copy the formula downwards.</td>
</tr>
<tr>
<td>Col_index_num</td>
<td>3</td>
<td>This argument instructs Excel to bring back character(s) in column three(3) of the specified table_array after finding the character you are looking-up. Please take note that the column index number will not always be three(3), it will depend on question specific, this number can be 2, 3, 4, 5 and etc.</td>
</tr>
</tbody>
</table>
It is set as **TRUE** because you are not finding the exact value in the table_array, but want to find the range within which the lookup value (reflected in cell I20) is located. Had the question been set-up in a way that you had to lookup the exact value, your argument will be **FALSE** instead of **TRUE**.

(h) Which spreadsheet formula was entered in cell J28 to determine the commission rate from the “**Coastal commission rates table**” for sales consultant “M2016NC009CL” on the sale of vehicle model B?

**Note:** Your formula will be copied to cells J29:J32.

**Step 1:** Identify the formula to be used: **VLOOKUP**

**Step 2:** **Formula structure:**

=VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)

**Step 3:** Write down your answer: =VLOOKUP(I28,E$4:G$12,3,TRUE)

**Step 4:** Will the formula be copied? Yes, the formula will be copied to cells J29:J32, which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references/range in which you want to include an absolute reference? Yes: The range is E4:G12 should not change as you copy the formula down.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>VLOOKUP</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Lookup_value</td>
<td>I28</td>
<td>The value you want to look up in the “<strong>Coastal commission rates table</strong>” (table_array) is R150 592 which is reflected in cell I28.</td>
</tr>
<tr>
<td>Table_array</td>
<td>E$4:G$12</td>
<td>The table array you want to lookup from is in range E4:G12. Note that the row references are absolute because the cell references should not change when you copy the formula downwards.</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Col_index_num</td>
<td>3</td>
<td>This argument instruct Excel to bring back character(s) in column three(3) of the specified table_array after finding the character you are looking-up. Please take note that the column index number will not always be three(3), it will depend on question specific, this number can be 2, 3, 4, 5 and etc.</td>
</tr>
<tr>
<td>Range_lookup</td>
<td>TRUE</td>
<td>It is set as TRUE because you are not finding the exact value in the table_array, but want to find the range within which the lookup value (as reflected in cell I28) is located. Had the question been set-up in a way that you had to lookup the exact value, your argument will be FALSE</td>
</tr>
</tbody>
</table>

(i) Which spreadsheet formula was entered in cell K20 calculate the commission amount for sales consultant “F2015SH002IL” on the sale of vehicle model C?

The formula must **round** the commission amount to two (2) decimal digits.

**Note:** Your formula will be copied to cells K21:K24 as well as K28:K32

**Step 1:** Identify the formula to be used: **ROUND** + a mathematical calculation/formula

**Step 2:** Formula structure: =ROUND(formula,number_of_digits)

**Step 3:** Write down your answer: = ROUND((J20*I20),2)

Take note that the question ask you to round to two(2) decimal places, hence the “number_of_digits” value is “2”
Step 4: Will the formula be copied? Yes, the formula will be copied to cells K21:K24 as well as K28:K32, which means you are copying DOWN because the column did not change, only the rows. Did you identify any cell references in which you want to include an absolute reference? NO: All the cell references should change when formula is copied down.

(j) Which spreadsheet formula was entered in cell K25 to calculate total commission amount for Inland branch?

Step 1: Identify the formula to be used: **SUM**

Step 2: Formula structure: =SUM(cell1:cell2)

Step 3: Write down your answer: =SUM(K20:K24)

Step 4: Will the formula be copied? No. Did you identify any cell references/range in which you want to include an absolute reference? No: This is not applicable as the formula will not be copied.

(k) Which spreadsheet formula was entered in cell F37 to count the number of sales consultants responsible for second hand (SH) vehicles sales in the Inland branch?

Step 1: Identify the formula to be used: **COUNTIF**

Step 2: Formula structure: =COUNTIF(range,criteria)

Step 3: Write down your answer: =COUNTIF(C20:C24,"SH")

Step 4: Will the formula be copied? No. Did you identify any cell references/range in which you want to include an absolute reference? No: The formula will not be copied to any cell/range and therefore it’s not necessary to include any absolute reference.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>COUNTIF</td>
<td></td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Range</td>
<td>C20:C24</td>
<td>The second hand sales consultants from the Inland branch are listed in row C20 to C24, hence the range is C20:C24</td>
</tr>
</tbody>
</table>
(l) Which spreadsheet formula was entered in cell F39 to count the total number of all sales consultants employed by the Coastal branch?

**Step 1:** Identify the formula to be used: **COUNTIF**

**Step 2:** Formula structure: \=COUNTIF(range,criteria)

**Step 3:** Write down your answer: \=COUNTIF(D28:D32,"CL")

**Step 4:** Will the formula be copied? No. Did you identify any cell references/range in which you want to include an absolute reference? No: The formula will not be copied to any cell/range and therefore it’s not necessary to include any absolute reference.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>COUNTIF</td>
<td>Counts the number of items/characters etc within a specified range of cells.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Range</td>
<td>D28:D32</td>
<td>All the Coastal branch sales consultants are listed in row D28 to D32, hence the range is D28:D32.</td>
</tr>
</tbody>
</table>
This argument reflects the criteria you wish to apply to your counting in the formula, in this instance you were asked to count the total number of sales consultants in the Coastal branch (CL), hence the criteria is CL. Please note that CL is placed in inverted commas because it is TEXT used in a formula/function.

(m) Which spreadsheet formula was entered in cell K37 to determine the lowest commission amount paid by the Inland branch?

**Step 1:** Identify the formula to be used: **MIN**

**Step 2:** Formula structure: =MIN(cell1:cell2)

**Step 3:** Write down your answer: =MIN(K20:K24)

**Step 4:** Will the formula be copied? No – therefore no absolute references need to be included in the formula.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>MIN</td>
<td>Determines the smallest value in a specified range of cells.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Cell1:cell2</td>
<td>K20:K24</td>
<td>This is the range of cells to which the specific function/formula is applied. In this instance, the function determines the smallest value in a specified range of cells.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

(n) Which spreadsheet formula was entered in cell K38 to determine the highest commission amount paid by the Coastal branch?

**Step 1:** Identify the formula to be used: **MAX**

**Step 2:** Formula structure: =MAX(cell1:cell2)

**Step 3:** Write down your answer: =MAX(K28:K32)
Step 4: Will the formula be copied? No – therefore no absolute references need to be included in the formula.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>MAX</td>
<td>Determines the highest value in a specified range of cells.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>Cell1:cell2</td>
<td>K28:K32</td>
<td>This is the range of cells to which the specific function/formula is applied. In this instance, the function determines the highest value in a specified range of cells.</td>
</tr>
<tr>
<td>Closing parenthesis</td>
<td>)</td>
<td></td>
</tr>
</tbody>
</table>

(o) Which spreadsheet formula was entered in cell K39 to determine the **average** commission amount paid by **both the Inland and Coastal branches**?

**Step 1:** Identify the formula to be used: **AVERAGE**

**Step 2:** Formula structure: **=AVERAGE(cell1:cell2)**

**Step 3:** Write down your answer: **= AVERAGE(K20:K24,K28:K32)**

**Step 4:** Will the formula be copied? No – therefore no absolute references need to be included in the formula.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>AVERAGE</td>
<td>Determines the smallest value in a specified range of cells.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
</tbody>
</table>
| Cell1:cell2 | K20:K24,K28:K32 | AVERAGE calculates the average of the values in a specified range of cells. This function is used to save time by not having to add all the individual cells and then dividing by the total number of cells added (long-way method). Note that even though you will obtain the correct answer by the "long-way method":

$=\frac{(K18+K19+K20+K21+K22+K26+K27+K28+K29+K30)}{10}$ – You will not earn any marks because this is not the best option when you have a large number of cells to average. Please note that the same logic also apply to functions such as SUM, MIN, MAX, COUNTIF and other similar fx |
**QUESTION 3** (step-by-step illustrated solution)

Note: Where it is indicated that your formula will be copied to other cells, your formula must take absolute and relative addresses into account, but only where necessary!

(a) Which spreadsheet formula was entered in cell B8 to include a 19 at the beginning of the two-digit birth year in cell B7, thereby changing the birth year for Bipin from a two-digit year in cell B7 to a four-digit year?  
**Note: your formula will be copied to cells C8:F8.**

Step 1: Identify formula to be used: &

Step 2: Formula structure. Using “&” will reflect the contents of the cells/value/text combined beside each other.

Step 3: Write down your answer: =19&B7

Step 4: Will the formula be copied? Yes the formula will be copied to cell C8:F8. The row stayed the same, that is, 8, and the columns changed from C:F which means you are copying to the RIGHT. Did you identify any cell references which should contain an absolute reference? NO – the cell reference, B7, needs to change to C7, D7, etc, as you copy the formula to the right.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Formula</td>
<td>19&amp;B7</td>
<td>Using “&amp;” will reflect the contents of the cells/value/text combined beside each other.</td>
</tr>
</tbody>
</table>

**IN ADDITION TO WHAT WAS REQUIRED IN THE ORIGINAL QUESTIONS**

Let us pretend that the question wanted cell B8 to be displayed as “Bipin-1991”. You should be able to copy the formula to cell range C8:F8. How would the formula change?

Step 1: Identify the formula to be used: &

Step 2: Formula structure: Using “&” will reflect the contents of the cells/value/text combined beside each other.

Step 3: Write down your answer: =B5&“-“&19&B7

Step 4: Will the formula be copied? Yes the formula will be copied to cell C8:F8. The row stayed the same, that is, 8, and the columns changed from C:F which means you are copying to the RIGHT. Did you identify any cell references which should contain an absolute reference? NO – the cell reference, B7, needs to change to C7, D7, etc, as you copy the formula to the right.

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Formula</td>
<td>B5&amp;“-“&amp;19&amp;B7</td>
<td>Using “&amp;” will reflect the contents of the cells/value/text combined beside each other.</td>
</tr>
</tbody>
</table>
(b) Which spreadsheet formula was entered in cell B11 to calculate Bipin’s monthly savings amount, based on the suggestions made by the investment company? The monthly savings amount must be a negative amount because it is an outflow of cash from the staff member to the investment company. Refer back to the given information Note: Your formula will be copied to cells C11:F11.

Step 1: Identify the formula to be used. IF. How did we know this? Refer back to the case study information: “The investment company suggested that staff members who are 50 years and older should save 10% of their monthly available income and that staff members younger than 50 years should save 5% of their monthly available income.” Remember that the IF function is used when one needs to decide between two alternatives depending on a specific condition. In this instance, the case study information gave two alternatives, namely that staff members who are 50 years and older should save 10% of their monthly available income OR staff members younger than 50 years should save 5% of their monthly available income. This is the clue that the IF function should be used.

Step 2: Formula structure: = IF(Logical_test,value_if_true,value_if_false)

Step 3: Write down your answer. As you can see below there is more than one correct answer. We will discuss this in detail in the table below. The logical test determines which outcome would be the true statement and which outcome would be the false statement.

OPTION 1: =-IF(B9<50,B10*0.05,B10*0.1) or =-IF(B9<50,B10*5%,B10*10%)

OPTION 2: =-IF(B9>=50,B10*0.1,B10*0.05) or =-IF(B9>=50,B10*10%,B10*5%)

Note the negative sign at the beginning of the formula. This is what was required in the question: “The monthly savings amount must be a negative amount because it is an outflow of cash from the staff member to the investment company.”

Step 4: Will the formula be copied? Yes, the formula will be copied to cells C11:F11, which means you are copying to the right because the row did not change, only the columns. Did you identify any cell references where you wanted to include an absolute reference? NO – the cell reference, B11, needs to change to C11, D11, etc, as you copy the formula to the right.
### OPTION 1

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Begins with = sign | =          | The case study provides two alternatives. The IF function is used in the case where one needs to decide between two alternatives depending on a specific condition. See step 1 above.  
As per what was required, the monthly savings amount must be a **negative amount** because it is an outflow of cash from the staff member to the investment company – hence the negative sign at the beginning of the formula. |
| Function name   | -IF         |                                                                                                                                              |
| Logical test    | B9<50       | You need to determine whether the staff member's age calculated in cell B9 is below 50 years.                                                |
| Value if the logical test is true | B10*0.05 or B10*5% | You want to calculate the monthly savings as 5% of the monthly available income as indicated in cell B10 for all staff members younger than the age of 50.  
Note that both ways of expressing 5% would have been accepted as the correct answer. However, 5/100 is incorrect. |
| Value if the logical test is false | B10*0.1 or B10*10% | You want to calculate the monthly savings as 10% of the monthly available income as indicated in cell B10 for all staff members who are not younger than the age of 50.  
Note that both ways of expressing 10% would have been accepted as the correct answer. However, 10/100 is incorrect. |
| Closing parenthesis | )         |                                                                                                                                              |

### OPTION 2

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Begins with = sign | =          | The case study provides two alternatives. The IF function is used in the instance where one needs to decide between two alternatives depending on a specific condition. See step 1 above.  
As per what was required, the monthly savings amount must be a **negative amount** because it is an outflow of cash from the staff member to the investment company – hence the negative sign at the beginning of the formula. |
| Function name   | -IF         |                                                                                                                                              |
| Logical test    | B9>=50      | You want to determine whether the staff member’s age as calculated in cell B9 is 50 years and older.                                           |
| Value if the logical test is true | B10*0.1 or B10*10% | You want to calculate the monthly savings as 10% of the monthly available income as indicated in cell B10 for all staff members at the age of 50 years and older.  
Note that both ways of expressing 10% would have been accepted as the correct answer. However, 10/100 is incorrect. |
value_if the logical
test is false | B10*0.05 or B10*5% | You want to calculate the monthly savings as 5% of the monthly available income for all staff members who are not at the age of 50 years and older.
Closing parenthesis | ) |

**OTHER CORRECT FORMULAS THAT COULD ALSO BE USED**

**OPTION 1**

=IF(B9<50,B10*-0.05,B10*-0.1) or =IF(B9<50,B10*-5%,B10*-10%)

Or

=IF(B9<50,-B10*0.05,-B10*0.1) or =IF(B9<50,-B10*5%,-B10*10%)

**OPTION 2**

=IF(B9>=50,B10*-0.1,B10*-0.05) or =IF(B9>=50,B10*-10%,B10*-5%)

Or

=IF(B9>=50,-B10*0.1,-B10*0.05) or =IF(B9>=50,-B10*10%,-B10*5%)

**Changing the sign of an amount/negative amounts**

Note where you can place the minus sign to create a negative amount when using a formula. Any one of the amounts, cell references or percentages can be changed to a negative to provide a negative answer.

To change the sign of an amount from a positive to a negative or from a negative to a positive, the amount can be multiplied by -1: for example +50 * -1 = -50 and -100 * -1 = +100.

(c) Which spreadsheet formula was entered in cell B12 to calculate the investment term in years for Bipin? Refer back to the given information

Note: Your formula will be copied to cells C12:F12.

(2)

**Step 1:** Identify the formula to be used: We will need to create a formula to calculate the investment term in years.

**Step 2:** Formula structure:

Let us go through the process of arriving at the formula:

Read the information carefully – the clue is right there.

“Joseph wants to show his co-workers what the possible amount is what they might receive at retirement if they start saving and investing now.”

and

“Normal retirement age is 65 years.”

As per the information provided in the case study, the normal retirement age is 65. The question requires the calculation of the investment term in years if Bipin starts saving and investing now up to his retirement.
Formula

= the investment term in years for Bipin
= retirement age – current age
= 65–19

Let us have a look at the spreadsheet again. Are there perhaps cells containing some of these numbers used in the calculation above?

Yes there are! Now substitute the numbers with the cell references.

= $B2-B9

Step 3: Write down your final answer: = $B2-B9

Step 4: Will the formula be copied? Yes, the formula will be copied to cells C12:F12, which means you are copying to the RIGHT because the row did not change, only the columns. Did you identify any cell references where you want to include an absolute reference? YES. $B2 because this contains the retirement age and will stay fixed when the formula is copied.

B$2 is incorrect.

(d) Which spreadsheet formula was entered in cell B13 to calculate the expected value of Bipin’s total savings at the end of his investment term? Note: Your formula will be copied to cells C13:F13.

Step 1: Identify the formula to be used: FV. Why? Refer back to the question and what was required: “Which spreadsheet formula was entered in cell B13 to calculate the expected value of Bipin’s total savings at the end of his investment term?

FV returns the future value of an investment based on constant payments and a constant interest rate.

Step 2: Formula structure: = FV(rate,nper,pmt,pv,type)

Step 3: Write down your answer: = FV($B3/12,B12*12,B11,0,0)

Step 4: Will the formula be copied? Yes, the formula will be copied to cells C13:F13, which means you are copying to the RIGHT because the row did not change; only the columns. Did you identify any cell references where you want to include an absolute reference? YES, $B3, because this contains the investment return rate and will stay fixed when the formula is copied.

= FV($B3/12,B12*12,B11,0,0)
The question requires you "to calculate the expected value of Bipin's total savings at the end of his investment term".

The interest rate is an annual (yearly) rate and needs to be divided by 12 to change it to a monthly rate because the savings payments are made monthly.

The period is a term in years and should be multiplied by 12 to change it to a period in months because you save monthly.

The payment amount you want to save each month. Note that the amount is negative (ie –R100) because it is an outflow of cash to an investment.

The present value of your investment. Because you have not yet saved anything, the current value (present value) of your investment is 0.

You save at the end of each month.

Which spreadsheet formula was entered in cell B14 to calculate the expected value of financing that Bipin can obtain from SupaDebt? Note: Your formula will be copied to cells C14:F14.

Step 1: Identify the formula to be used. PV. Why? Refer back to the question: "Which spreadsheet formula was entered in cell B14 to calculate the expected value of financing that Bipin can obtain from SupaDebt?" PV returns the present value of an investment/series of payments, that is, the total amount a series of total payments is worth today at a constant interest rate and over a constant period.

Step 2: Formula structure: =PV(rate,nper,pmt,fv,type)

Step 3: Write down your answer:

=PV(0.07/4,5*4,B11*3,0,1) or =PV(7%/4,5*4,B11*3,0,1)

The required and additional case study information states that the instalments are payable quarterly, at the beginning of each period.
Step 4: Will the formula be copied? Yes. The formula will be copied to cells C14:F14, which means you are copying to the RIGHT because the row did not change; only the columns. Did you identify any cell references where you want to include an absolute reference? NO. The cell reference, B14, needs to change to C14, D14, etc, as you copy the formula to the right.

\[ = \text{PV}(0.07/4,5*4,\text{B11}*3,0,1) \text{ or } =\text{PV}(7\%/4,5*4,\text{B11}*3,0,1) \]

<table>
<thead>
<tr>
<th>Structure</th>
<th>The formula</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with = sign</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Function name</td>
<td>PV</td>
<td>The question requires you “to calculate the expected value of financing that Bipin can obtain from SupaDebt”.</td>
</tr>
<tr>
<td>Opening parenthesis</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>rate</td>
<td>0.07/4 or 7%/4</td>
<td>The interest rate is expressed as an annual rate of 7% in the required part of the question. This annual rate needs to be changed to a quarterly rate, namely the same period as the instalment period. Remember, you need to compare apples with apples. Because there are four (4) quarters in a year, the annual rate needs to be divided by 4 to change the annual rate to a quarterly rate.</td>
</tr>
<tr>
<td>nper</td>
<td>5*4</td>
<td>The finance term is five (5) years per what was required in the question. Nper is the total number of payments that will be made for the whole of the finance term. Since there are four (4) quarters in a year, the finance term of five (5) years needs to be multiplied by 4 to calculate to the total number of payments to be made for the five-year finance term.</td>
</tr>
<tr>
<td>pmt</td>
<td>B11*3</td>
<td>The instalments (payments) are payable quarterly. As per the case study information, the total monthly savings amount is, as the name indicates, MONTHLY. We need to calculate the payment amount per quarter, not per month because the payments are payable quarterly. There are four (4) quarters in a year, and a quarter comprises three (3) months each. Thus the quarterly payments need to be calculated by multiplying the monthly payment (monthly savings amount) by 3 to calculate the quarterly payment amount. Note that the amount is negative because it is an outflow of cash to an investment.</td>
</tr>
<tr>
<td>fv</td>
<td>0</td>
<td>The future value of the loan. Since the loan will be fully paid by the end of the period, the future value of the loan is R0.</td>
</tr>
<tr>
<td>type</td>
<td>1</td>
<td>The instalment is payable at the beginning of each period (payable in advance).</td>
</tr>
</tbody>
</table>
In this study unit we will focus specifically on spreadsheet security, risks and controls.

1 Introduction

In the previous study unit we showed you what a powerful tool Microsoft Office Excel can be when it is used to perform calculations, present reports and charts and analyse data.

Spreadsheets have become an essential tool for numerous entities, many of whom cannot function without the use of spreadsheets. This is why spreadsheet security and control have become so important to ensure that spreadsheets, which organisations rely on, are not compromised, leading to incorrect calculations, reports, charts and data analysis, which in turn could lead to incorrect management decisions.

In this study unit we will focus specifically on spreadsheet security, risks and controls.
Spreadsheet risks

Many things can go wrong with spreadsheets. Unauthorised modifications or data input may occur, resulting in incorrect output, be it intentional or unintentional. There is also the possibility of errors contained in the formulas and functions used to perform calculations in spreadsheets.

Thus to assess the risk potential for certain spreadsheets, the following factors have to be considered:

- **Complexity.** Spreadsheets containing complex calculations and functions, including the use of macros with multiple sources of input, present a greater potential risk owing to the complex calculations.

- **Frequency of use and updating.** Spreadsheets that are frequently used or updated pose a greater potential risk owing to the potential for incorrect input or updating of information or modification of calculations.

- **Number of users using a spreadsheet.** Spreadsheets that are used by more users have a greater potential risk, especially if these users can enter data or change formulas and functions.

- **Time in use.** This relates to spreadsheets that are used for a long time (a year or longer). The potential risk increases because the initial data entered may be incorrect, potentially leading to subsequent data being negatively affected in future months.

Hence unauthorised modifications or data entry, or spreadsheets containing errors either because of incorrect data being entered or incorrect formulas or functions being used in calculations will lead to errors, with management making incorrect decisions.

Owing to the structural design of spreadsheets, a minor change in a formula or value or in any of their input cells may affect their overall output, where manual errors may also go undetected.

Because the user only sees the results on the face of the spreadsheet or printed report, these errors could easily go unnoticed.

Typical errors include

- accidental copy-paste
- omission of a negative sign
- erroneous range selection
- incorrect data input
- unintentional deletion of a character, cell, range, column or row
- sorting of only a portion of the data range

Another common error is the possibility of the user working on the wrong spreadsheet version.

The potential consequences of one or more of the above errors occurring or security being breached with unauthorised modifications to spreadsheets could result in:

- financial loss or bankruptcy of an organisation
- incorrect costing or budgeting
- public embarrassment, adverse news coverage or loss of reputation
- loss of investor confidence
- loss of share value
- loss of financial control
- career damage
- lawsuits
Spreadsheet controls

With the potential risks of a breach in security or the occurrence of an error in spreadsheets, management will need to implement controls to minimise the risks identified.

There are various ways of controlling spreadsheets. One is to make regular back-ups of spreadsheets and to audit working versions of spreadsheets from time to time to check any changes made to ensure that the spreadsheet still works as it was intended to.

Spreadsheet use also poses inherent risks. These risks can be lessened by reducing the number of spreadsheets in use. The use of tested and audited templates for frequently recreated spreadsheets can also decrease risks.

The following controls (including security controls) may be implemented for spreadsheets:

- **Change control.** Spreadsheet changes including changes in formulas and functions need written approval, review and acceptance in order to maintain data integrity.
- **Access control.** General IT controls should protect spreadsheets from unauthorised outside access.
  - **Low-risk spreadsheets** residing on a user’s computer system require password protection.
  - **High-risk spreadsheets** need to be stored on a server that has a secure file directory. Access rights to these folders need to be restricted to the authorised users.
- **General security controls.** General security controls relating to file access controls that may be implemented are as follows:
  - a password required for opening or reading workbooks
  - a password required to make changes to the workbook structure
  - a password required for changing the content in a sheet or cell

A password may encrypt the specific workbook, the structure or the cells in a spreadsheet. Note, however, that commercial hackers may use various programs available on the internet to obtain the password for a file – hence password protection alone may not be sufficient.

The following steps should also be followed and communicated to the users of spreadsheets that are password protected to ensure that their passwords stay safe and that this is regarded as good practice for password protection:

- Do not share the password with anyone.
- Do not write the password down and place it where people can find it.
- Do not use an obvious password (e.g. birthdays or names) that someone could easily guess.
- Use a combination of letters and numbers.
- Include uppercase and lowercase letters, numbers and symbols in the password.
- Use numbers to represent letters, for instance, 3 for your E and 1 for i.
- Passwords should be eight or more characters in length.
- Change passwords regularly if needed.

- **Input control.** Spreadsheet input data needs to be verified to the original source data for accuracy. Another person also needs to trace inputs back to original source data.
- **Logical inspection.** An independent person other than the spreadsheet user should test the formulas and functions for correctness. Only one logical inspection per spreadsheet is required if the other controls are working effectively.
Another facet of logical inspection is the inclusion of fixed values in formulas. A formula should never contain a fixed (“hard-coded”) value. Even “permanently” fixed components (e.g., tax rate) can change in the context of business operations. To prevent these types of mistakes you could separate the input components from the formulas by having a data input section/sheet in which you can easily identify the various inputs and assumptions on the face of the spreadsheet and update these without the need to change the detailed formulas/functions. The use of control balances may also prove helpful to ensure the soundness of formulas or input on spreadsheets.

In so doing, the use of formulas and functions becomes much more flexible, with a decrease in potential errors caused by the inclusion of an incorrect fixed value.

(a) Display formulas

You may be auditing formulas and you need to see all the formulas on the worksheet. You can use the following procedures to control the hiding or displaying of formulas:

There are two ways to switch between displaying formulas and their values on a worksheet:

- Using an icon/command:
  – Click on the Formulas tab on the Ribbon.
  – In the Formula Auditing group, click on the Show Formulas icon.

OR

- Using the keyboard:
  – Press CTRL and ~ (the grave accent) simultaneously

4 Microsoft Office Excel security controls

Microsoft Office Excel provides various levels of security and protection, allowing you to control who can access and change the file’s data. To protect a workbook containing data you can do the following:

- **Optimal security.** Protect your entire workbook file with a password allowing only authorised users to view or modify the data.

- **Additional protection of specific data.** Protect certain worksheet or workbook elements, with or without a password. This will help to prevent users from accidentally or intentionally changing, moving or deleting data, formulas or functions.

In the next activities we will demonstrate how to do both.
.4.1 Using passwords to help secure an entire workbook

You can secure an **entire workbook**
- by restricting who can open and use the workbook data
- by requiring a password to view or to save changes to the workbook

For optimal password security, always assign a password to open and view the file. In section 4.2 you will learn how to give only certain users permission to modify data or workbook elements.

Before you start the next practical section, start/open the Microsoft Office Excel Program.

(a) **To encrypt your workbook and set a password to open it**

**Computer activity 6.1 – Password protecting the whole Workbook**

- In an open spreadsheet, click the **File** tab.
- Click on **Info**.
- This will open the **Info** menu options.
- Click on the arrow below **Protect Workbook**. The following options appear:
- Select **Encrypt with Password**, the **Encrypt Document** dialog box appears.

- Type in the password, and click on **OK**
  - Take note that you choose a password you will be able to remember later on
  - Take the guidelines for good practice for password protection in section 3 into consideration

- In the **Confirm Password** dialog box, in the **Reenter** password box, type the password again, and then click **OK**.

- To save the password, save the file.

- After typing the password, the “Protect Workbook” option colour filling changes from white to light-brown as per above with a message: “**A password is required to open this workbook**”
• Close the workbook, and open it again.
• Before opening, the workbook should first prompt you to put in a password, see below:

4.2 Protecting a specific worksheet or workbook elements

When you share a workbook with other users in order to work together on the data, you may want to protect data in specific worksheets or workbook elements to prevent it from being changed/edited by other users. Passwords may be used to enable users to enter so that they can modify specific workbook and worksheet elements that are protected.

The difference between a workbook and a worksheet can be explained as follows:

• A workbook is the actual Microsoft Office Excel file that stores all the entered data and information. Workbooks contain worksheets.
• A worksheet, also known as a spreadsheet, is the combination of cells that contain data, which the user can enter and manipulate.

NOTE

Workbook element and worksheet element protection is not workbook-level password security (as per 4.1 above). Element protection cannot protect a workbook from users with malicious intent.

4.2.1. Protecting worksheet elements

When you protect a worksheet, all cells on the worksheet are locked by default, and users cannot make any changes to a locked cell. For example, they cannot insert, modify, delete or format data in a locked cell. However, you can specify which elements users will be allowed to change when you protect the worksheet.
To protect worksheet elements

### Computer activity 6.2

**a) To protect a worksheet**

- Select the worksheet you want to protect.
- On the **Review** tab, in the **Changes** group, click **Protect Sheet**.

As noted above, all cells on the worksheet are locked by default.

- In the **Password to unprotect sheet** box, type a password for the sheet, click **OK** and then retype the password to confirm it.
- To unlock a protected worksheet, click on “**Review**” tab then **Unprotect Sheet**
- Then type in password to unprotect the sheet
(b) To unprotect an individual cell(s) within an already protected a worksheet

Perform these procedures if you want to allow users to be able to change/amend specific cell(s) within a locked/protected worksheet. If locked, you need to unlock the whole protected sheet per (a) above.

- Select/highlight the cell(s) you want to unlock and allow changes/amendment to be done to those.
- Select cell B5
- Right click and select the "Format Cells" option.
- Click on “Protection” tab, then unselect (clear) the “Locked” check box
- Click on OK.
- Then lock/protect the whole worksheet again as outlined in (a) above.
- The whole worksheet is now locked except for the cell you have highlighted above (B5).

![Image of Format Cells dialog box]

(c) To hide formulas in a protected worksheet:

Perform these procedures if you do not want users to view/see certain formulas within a locked/protected worksheet.

- If locked, first unlock/unprotect the whole protected sheet as per (a) above.
- Select/highlight the cell(s) with the formulas you want to hide for viewing.
- Select cell AB45
- Right click and select “Format Cells” option
- Click on “Protection” tab and select the “Hidden” check box
- Click on OK.
- Lock/protect the whole worksheet again as outlined in (a) above.
- All the formulas in the worksheet are now visible except for the cell you have highlighted above (AB45).
(d) To unlock any graphic objects inserted in worksheet (such as pictures, clip art, shapes or Smart Art Graphic)

Perform these procedures if you wish to lock any image/object inserted in the worksheet.

- If locked, first unlock/unprotect the worksheet as per (a) above.
- Hold down the CTRL key (on the keyboard) and then click on the object you wish to lock/unlock
- A “Format” tab will then appear on the Ribbon.
- Click on the Format tab
- In the Size group, click the Dialog Box Launcher
- The “Format Shape” window will open to the right of your screen.

- On the Properties drop-down menu, clear the Locked check box.
NOTE

The password is optional. If you do not supply a password, any user can unprotect the sheet and change the protected elements. Make sure that you choose a password that is easy to remember, because if you lose the password, you cannot gain access to the protected elements on the worksheet.

4.2.2. Protecting the WORKBOOK

Computer activity 6.3

(a) To protect/lock the workbook

- On the Review tab, in the Changes group, click Protect Workbook.
- A “Protect Structure and Windows” window will open.
- To protect the structure of a workbook, select the Structure check box.
- To keep the workbook windows in the same size and position every time the workbook is opened, select the Windows check box.
- To prevent other users from removing workbook protection, in the Password (optional) box, type a password, click OK.
- Click OK.

Retype the password to confirm it.

(b) To remove protection from a worksheet

Computer activity 6.3

- On the Review tab, in the Changes group, click the greyed-out “Protect Workbook”
- Type in the password in the “Unprotect Workbook” window.
- Click OK.
4.3 Protecting confidential data in a workbook

Hiding, locking and protecting workbook and worksheet elements are not intended to secure or protect any confidential information you keep in a workbook. This will only help obscure data or formulas that might confuse other users and prevent them from viewing or making changes to that data.

Excel does not encrypt data that is hidden or locked in a workbook. To help keep confidential data confidential, you may want to limit access to workbooks containing such information by storing them in a location that is available only to authorised users.

5 Summary

In this study unit we discussed and described spreadsheet risks and controls. We specifically discussed factors to consider when assessing the potential risk of spreadsheets, including the consequences of errors contained in spreadsheets. We looked at controls that can be implemented to minimise the risks identified. Lastly, we focused on certain security and privacy controls that are included in Microsoft Office Excel that you can use to protect your data, formulas and functions.
Self-assessment activity

After working through this study unit, you should be able to answer the following:

Jane is an accountant at a multinational organisation. She is responsible for all the monthly salary calculations. The financial manager, John, to whom Jane directly reports, has previously emphasised the importance of keeping the company's salary information confidential. He insisted that Jane password protect the salary spreadsheets, of which only he and Jane know the passwords.

For every month's salary calculation spreadsheet that Jane uses, she scribbles the passwords on a piece of paper and then sticks it on the front of her wall calendar at the applicable month. She uses the name of her pet parrot, Polly, together with the applicable month as the password for the monthly salary spreadsheets.

(a) (i) Advise Jane on what good password practice is and what she should refrain from doing with reference to the case study above.
(ii) Advise Jane on whether she should use a password to secure the entire workbook or password to secure the specific worksheet. Briefly explain why.

(b) List and explain the factors to consider when assessing the potential risks of a spreadsheet.

Feedback on self-assessment activity

Regarding question a.ii., Jane should use a password to protect the entire workbook containing the salary spreadsheets because the information contained is confidential and of a sensitive nature. By password protecting the workbook, the entire workbook will be secured by restricting who can open and view the workbook data.

Using a password to only protect the worksheets will not be adequate because users can still open and view the confidential salary information. Using a worksheet password will only prevent the unauthorised user from editing workbook data and saving changes to the file.